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1. Introduction

PL/SQL Developer is an Integrated Development Environment (IDE) for developing stored program
units in an Oracle Database. Using PL/SQL Developer you can conveniently create the server-part of
your client/server applications.

As a worst-case scenario, up to now you might have been working like this:

e You use a text editor to write program units (procedures, triggers, etc.).

e You use Oracle SQL*Plus to compile the source files.

. If there is a compilation error, you have to find out where it is located in the source file, correct it,
switch back to SQL*Plus to recompile it, only to find the next error.

e You use SQL*Plus or the client-part of your application to test the program unit.

. In case of a runtime error, again you have a hard time locating the cause of the problem and
correcting it.

e You use the Explain Plan utility or tkprof to optimize your SQL statements.

e  Toview or modify other objects and data in your database, you use SQL*Plus or yet another tool.

These tasks - editing, compiling, correcting, testing, debugging, optimizing and querying - can all be

performed without leaving PL/SQL Developer's IDE. Furthermore, PL/SQL Developer provides several

other tools that can be helpful during everyday PL/SQL development.
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Editing
PL/SQL Developer, like any other serious development environment, assumes that you store your

source files on disk. Other tools just let you edit sources in the database, but this does not allow for any
version control or deployment scheme. The source files can be run through SQL*Plus, so you can
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deploy them on any platform without using PL/SQL Developer. You can edit many files at once
through a standard multiple document interface.

The editor offers a wide range of assistance to the programmer. There is context sensitive help on SQL
statements and PL/SQL statements. We've all been there: you start typing substr, but have forgotten the
exact meaning of the parameters. Now you can simply hit F1 and you're taken to the appropriate topic
in the SQL Reference Manual. Tables, views and program units can be described for you in a roll-up
window from within the editor in the same way. A Code Assistant is integrated into the editor that
automatically displays information of database objects as you type their name, allowing you to browse
and pick elements from this description. For large package or type bodies, the program editor provides a
tree view with the code contents for easy navigation, highlights code structures and variable references,
allows you to fold/unfold code sections, and provides hyperlink navigation. The Query Builder allows
you to graphically create select statements. PL/SQL Developer’s extensible templates make it easy to
insert standard SQL and PL/SQL code into your programs. Al editors use the appropriate SQL, PL/SQL
and SQL*Plus syntax highlighting to make your code more readable.

Compiling & correcting

From within the editor you can compile a source file. In case of a compilation error you are
automatically taken to the appropriate source line. All compilation errors are reported in a list at the
bottom of the editor. This list can include hints for code that may indicate common programming errors
or violations of user-defined naming conventions.

Because you can compile a source file without saving it, you can safely explore many alternatives of
solving a problem. The editor keeps track of the fact that you have changed the file without saving or
compiling it.

Testing & debugging

To test your program unit, you can write a test script. The body of the test script contains a PL/SQL
block in which you can program the test-code. Any variables that you want to use in the PL/SQL block
can be declared, assigned a value for input, and viewed after execution.

When you execute a test script, a runtime error might occur. In this case, PL/SQL Developer allows you
to view the sources of the error stack. Each source line of the error stack that was involved in the
runtime error is highlighted, so you can easily backtrack to the cause of the problem.

If you are using Oracle 7.3.4 or later you can use PL/SQL Developer’s integrated debugger. You can
step through your code, set breakpoints, view/set variables, view the call stack, and so on.

On Oracle8i and later you can additionally use the dbms_trace feature to log selected events of a
program run. This can help you analyze the program flow and exceptions.

Output from calls to the dbms_output and the PL/SQL Web Toolkit packages are automatically shown in
a corresponding tab page of the Test Window.

For regression testing you can use the Test Manager to quickly run and verify a set of Test Scripts.

Optimizing

To optimize the SQL statements in your program units, Oracle's Explain Plan utility can be a big help.
Therefore it is integrated into PL/SQL Developer's IDE. By simply selecting the SQL statement in the
source file and pressing F5, the query plan is visually presented to you in a separate Explain Plan

window. You can then modify the statement to optimize its query plan outside the source file, and copy
it back afterwards.

You can also view statistics about executed SQL statements and PL/SQL program units. These statistics
can include elapsed time, CPU time, logical reads, physical reads, physical writes, and so on.
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Oracle8i introduced a PL/SQL Profiler that allows you to profile your PL/SQL code. For each executed
line of PL/SQL code you can determine the execution time, and how many times it was executed.

Querying

To query the data in the database, you can use a SQL window to execute any SQL statement. All
executed statements are kept in a history buffer, so you can easily re-execute them. Any query results
are conveniently displayed in a separate grid that you can subsequently use to insert, update, or delete
records. The result grid can additionally be used in a Query By Example mode, so that you can easily
find the information you need.

To query database objects you can use the Object Browser. All relevant properties of database objects
such as tables, views, sequences, functions, procedures, packages, types and triggers can be viewed,
including any dependencies between the objects. The Object Browser uses a tree view similar to the
explorer in Windows for easy point-and-click browsing.

Running SQL scripts

PL/SQL Developer includes a Command Window that can be used to run SQL scripts or execute SQL
statements. You can additionally execute commands that are very similar to the SQL*Plus commands
that you may be familiar to.

Creating and modifying table definitions

You can easily create and modify table definitions with using any SQL statement. Just fill in the
definition in a dialog window to modify columns, constraints, indexes, privileges, storage information,
comments, and so on. You can apply this definition in the database, and view, modify and save the
resulting SQL.

Diagrams

To visualize the database objects of your application or project and their relations, you can create
diagrams. A diagram can be used for documentation purposes, but can also serve as a workspace to
work with related objects.

Reporting

PL/SQL Developer comes with a number of standard reports, which are HTML based. You can view
these reports within PL/SQL Developer, print them, or save them as HTML files. You can also create
your own custom reports. Reports can be made easily accessible from the reports menu.

Graphics

The Graph Window can be launched from within a SQL Window or Report Window to obtain a
graphical representation of the queried data.

Projects

To organize your work you can use PL/SQL Developer’s project concept. A project consists of a
number of files and database objects. These objects are easily accessible through the Project Items
Window, and can be compiled through a single mouse-click.

Tools

PL/SQL Developer provides several tools that can be helpful during development. These tools include a
Find Database Object tool, allowing you to search for text in database object sources, a Compile Invalid
Objects tool, to quickly compile objects that have become invalid during development, Export and
Import tools, a Data Generator tool to create test data, an Export User Objects tool to export the DDL
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statements of a user’s objects, a Compare User Objects tool to compare the object definitions of 2 users,
a Session information tool, an Event monitor, a Compare Table Data tool to compare and equalize table
contents, and a DBMS Scheduler tool to view and manage your scheduler objects and jobs.

In addition to these standard tools, you can define your own tools and include them in PL/SQL
Developer’s tools menu.
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2. Installation

There are basically two ways to install PL/SQL Developer:

e Workstation installation. In this case you install the software locally on each workstation that it
will be used on.

Server installation. In this case you install the software on a server at a location that can be
accessed from each workstation that it will be used on.

Both installation types will be explained here.

2.1  System requirements

PL/SQL Developer will run on Windows 2000 and later, and is compatible with Oracle Server version
7.0 and later. To connect to an Oracle database, PL/SQL Developer requires a 32-bit Oracle Client
version 7.0 or later. If you are using a 64-bit version of the Oracle Client and/or Server on your
workstation, you will need to install an additional 32-bit Oracle Client.

2.2  Workstation installation

To install PL/SQL Developer locally on a workstation, run the setup program from the installation
medium. After doing this, the following dialog will appear:

’ Select destination directory

Selectthe directony where you want ta install the files

IC\Program FilesiPLSOL Developer =

FL/SOL Developer requires about 20 MB of free space.

Free space on this system

CA 19118 ME
Oy 5344MB
Gy, B741 MB

< Back | MNext > | Cancel

You can select a destination directory for the program files, a folder in the start menu, a location for a
shortcut to PL/SQL Developer on the desktop, and installation options. After pressing the Finish button
on the final page, the program files are copied and the shortcuts are created.

2.3 Server based installation

For multi-user licenses you can create a single PL/SQL Developer installation on a file server and
provide access to all licensed users. To do so, you can run the setup program on the file server in the
same way as described in the previous section. You must choose a destination directory that is shared to
the users that will use the software. When PL/SQL Developer is first run on a workstation, this type of
installation is automatically detected, and local installation is then completed without the user noticing
it.

PL/SQL Developer can be installed into a directory where the users have only read access.

2.4  Scripted installation

In addition to the installation procedure described above, you can also create a script for unattended
installation. Read the included install.txt file for detailed information.
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2.5 Uninstalling PL/SQL Developer

If for some reason you wish to uninstall PL/SQL Developer, you can remove it using Add/Remove
Program in the Control Panel.



PL/SQL Developer 9.0 User’s Guide 15

3. Logging on to an Oracle database

After starting PL/SQL Developer for the first time you will be prompted to logon to an Oracle database:

Orade Logon il

Usarnams | J
e Password
f'. Pl

»

Database A
Connect as [Normal A

If you cancel this logon dialog you will continue without an Oracle connection. This will disable all
PL/SQL Developer functions that require a connection, such as compiling, querying and so on. You can
connect from within the PL/SQL Developer IDE later to enable these functions.

After entering the username, password and database and pressing OK or <Enter>, you will be
connected to the database and the PL/SQL Developer IDE will be displayed. You can now write
PL/SQL Programs, Test PL/SQL Programs, query the database, and so on, as described in the following
chapters.

If you have multiple databases or multiple database accounts, then you can make additional connections
by using the Log on item from the Session menu, or by using the Log on button on the main toolbar.
Each additional connection will be added to the Connection List (see chapter 16), which can
subsequently be used to view and manage your connections. When starting PL/SQL Developer again
later you can quickly log on by selecting a connection from the Connection List.

Logon failure
The logon dialog can fail for the following reasons:

1. Youdo not have the Oracle Client software installed. This is a requirement for PL/SQL
Developer. Install an Oracle Client and try again.

2. You have more than one Oracle Client software installations. In this case PL/SQL Developer may
have chosen an Oracle Client that is not appropriate. Cancel the logon dialog, go to Tools >
Preferences > Oracle / Connection, select the appropriate Oracle Home from the list, restart
PL/SQL Developer and try again.

3. You are using an Oracle Instant Client but have not set all required environment variables:
* PATH - Needs to include the Instant Client directory (where oci.dll is located).
*« TNS_ADMIN - Needs to point to the directory where tnsnames.ora is located.
* NLS_LANG - Defines the language, territory, and character set for the client.
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4. Writing programs

In an Oracle database, you can distinguish five different types of stored program units: functions,
procedures, packages, types and triggers. The Program editor allows you to create and modify these five
types of program units in one uniform way.

4.1  Creating a program

To create a new program, press the New button on the toolbar and select the Program Window item and,
for example, the Function sub item. You are now prompted for various variables that are relevant to this
program type. In this case, where we are creating a function, the name of the function, the parameter
list, and its return type:

4 | emplate Wizard =10 x|

Function

Name |Even

Parameters |l-’alue ininteger

Return tupe:

e

As the title of this dialog suggests, this information comes from a template. PL/SQL Developer provides
several standard templates, which you can modify as needed. You can also define new templates.
Information about defining templates is provided in chapter 26.

After you have entered the variables and pressed the OK button, a Program Editor Window appears with
a template function in it. Each program you create in the Program Editor unit must start with the
familiar 'create or replace' SQL syntax. In this case we are creating a function 'even’, and the source file
could look like this:

&+ Program Window - Edit source of function SCOTT.EVEN@CHICAGO — |0 il

end Even;

(8 x || [Code secton] [Stetement] L
= Parameter list .|B|create or replace function Even(Value in integer) return boolean is
- Value a Result boolean;
=3 Declaration begin
- Resut " check if b is 4 remainder after dividing by 2
51453 Code section - — C'.;!SC.‘;‘\ if there is a remainder after dividing by 2
= Statement = Result := (Value mod 2 = 0);
.= Statement [ return (Result) ;|

=|J‘ |E 18 ~ scott@chicago |Comp|\ed successiully v

At the left side of the editor you see the Code Contents, which displays the structure of the program
unit. This is useful when navigating large program units such as package bodies and type bodies. This
feature is described in detail in chapter 22.12.

Above the editor you see the Code Hierarchy, which displays the hierarchy from the cursor position. In
this case it shows that you are located at a Statement (the return statement) within a Sequence of
statements within a Function. For complex programs, this can be helpful to see where exactly you are
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located, and can help you to select certain portions of the PL/SQL code. This is described in detail in
chapter 22.13.

A program file can contain more than one program unit. By right clicking in the Program Editor, a
popup menu appears that allows you to add or delete a program unit. You can switch between the
program units by selecting the appropriate tab at the top of the window. This way you can conveniently
keep related program units together in one source file. A package specification and body are a good
example of this feature.

A program unit should be positioned after any other program unit in the program file it might reference.
If you create a function 'odd' that references the previously created function 'even’, the program editor
should look like this:

&% Program Window - New _ ol x|

& Even @Oddl
|4 % | [Code seston ] [Sisterment] o

=+ Parameter list .|Blcreate or replace function Odd(Values in integer) return boolean is
(&) Value
=3 Declaration
. D Result
=43 Code section
= Statement
.= Statement

,E ,7‘518 - scott@chicago | 7

4.2  Saving a program

You can save a program file by pressing the Save button on the toolbar. A save dialog appears that
shows some standard extensions for program files:

Program type Extension
Function fnc
Procedure .prc
Package specification & body | .pck
Package specification .spc
Package body .bdy
Type specification & body typ
Type specification ps
Type body tpb
Trigger trg
Java source Jjsp

You can change these extensions through a preference as described in chapter 20.28. If one single
function, procedure, package, type, trigger or java source is in the program file, the filename is
automatically derived from the name and type of this program unit. After saving the file, the filename is
shown in the window title.
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The saved program file has a format that is compatible with Oracle SQL*Plus. As an example, the
source file containing the 'odd' and 'even' function looks like this:

create or replace function Even(Value in integer) return boolean is
Result boolean;

begin
-- Check if there is a remainder after dividing by 2
Result := (Value mod 2 = 0);
return(Result);

end Even;

/

create or replace function Odd(Value in integer) return boolean is
Result boolean;

begin
Result := not Even(Value);
return(Result);

end 0dd;

/

When this file is executed through SQL*Plus, both functions will be created.

4.3  Modifying a program

You can open a previously saved program file by pressing the Open button on the toolbar and selecting
the Program file item. If the file was recently used, you can also open it by selecting Reopen from the
File menu or by clicking on the arrow next to the Open button on the toolbar. When you start editing, a
blue colored indicator at the bottom of the window lights up. This indicates that the file is modified, but
not yet saved. There is also a yellow colored indicator, which indicates that the file is modified, but not
yet compiled.

4.4  Compiling a program

You can compile a program file by pressing the Execute button on the toolbar. All program units in the
program file are compiled, starting with the first one, regardless of the program unit that is currently
selected. When an error occurs, compilation is terminated and the editor is positioned at the source line
that caused the error:

&% Program Window - New =10l x|
& Even |® Odd'
| 4] X || Code section | | Statement 1 "
=143 Parameter list .|8|create or replace function Even(Value in integer) return boolean is

@ Value . Result boolean;
=143 Declaration begin

@ Result —-— Check if there is a remainder after dividing by 2
-1 Code section - B ST o . -

5 Result := (fia,u mod 2 = 0);
return (Result);
end Even;

5 clentf
5 PL/SAL: Statement ignored
1 Hint: Parameter “/alue'is declared but never used in 'Even’

,E ’7‘5 14 ~ scott@chicago ‘Cnmpwled with errors v

If there is more than one error and you wish to correct them, you can click on the next error message at
the bottom of the Program Editor to go to the error location. If you have configured PL/SQL Developer
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to use the HTML manuals as described in chapter 31.2, you can double-click on a compilation error to
display the corresponding paragraph in the Oracle Error Messages manual.

The compilation error list can also contain hints. Hints do not cause the compilation to fail, but they
may indicate an issue that could cause a run-time error (such as a comparison with null, a function
without a return value, an unused parameter, and so on). For more information about hints, see chapter
20.19.

If an error message is displayed in a message box after compilation, this means that the create statement
failed without actually compiling the source. The error message should explain the cause of the error. If
for example you get the ‘create or replace’ syntax wrong, it will say "ORA-00900: Invalid SQL
statement™ in a message box.

Note: If you are using Oracle Server 7.2 or earlier, a trigger compilation error is always reported in a
message box. Only since Oracle Server 7.3, trigger compilation errors are reported in the same way as
procedures, functions, packages and types.

45  Compiler preferences

To set various compiler preferences, you can press the Compiler preferences button on the status line of
the Program Window. This will take you to the corresponding preference page. See chapter 20.3 for
more information.
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5. Testing programs

After successfully compiling a program, you'll need to test it. To achieve this, you can use PL/SQL
Developer's Test Scripts. A Test Script allows you to execute one or more program units, define input,
output and input/output variables and view and assign values to variables. If a run-time error occurs
during execution of the Test Script, you can view the sources of the program units that were involved in
the error.

If you are using Oracle 7.3.4 or later you can use PL/SQL Developer’s integrated debugger. You can
step through your code, set breakpoints, view and set variables, view the call stack, and so on.

5.1 Creating a Test Script

There are two ways to create a Test Script. You can simply right-click on a program unit (a standalone
function or procedure, a packaged function or procedure, or an object type method) in the Object
Browser and select the Test item. This will create a new Test Script with variables for the parameters
and result. For the purpose of this manual, we are going to create a Test Script manually from scratch
though.

To create a new empty Test Script, press the New button on the toolbar and select the Test Window item.
You can now type a PL/SQL block with the familiar declare...begin...end syntax in the body of the Test
Script. As an example we're going to test a package employee, which implements some employee
functions of the employee/department demo tables. Function deptname returns the name of the
department of an employee, and can be tested using the following PL/SQL block:

fﬁ' Test Window - New

Test script | DBMS Output| Statistics | Profiler | Trace |

B | = P
hegin
rdeptname = employee.deptname | empno) ;I
end;
O Mariable [Type [value |
* -

= [2:42 Y

The PL/SQL block contains a simple call to the function that we want to test, and uses variables
deptname and empno. We'll have to assign a value to empno, and after execution, check the value of
deptname to determine if the function returned the correct value.
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By prefixing these variables with a colon, they can be declared at the bottom of the Test Script:

fﬁ' Test Window - New

Test script | DEMS Output | Statistics | Profiler | Trace |

B | 2o
begin
tdeptname = employee.depthame | empno) }
end;
O Nariable | Type |value |[a
¥ | deptname String -
M | empno Integer = 7364 ﬂ

- 242 g

The Scan source for variables button (€) at the upper-left of the variables list can be used to quickly
copy the variables from the source. After this, the integer data type and value 7369 (Mr. Smith from the
research department) is assigned to empno. Now we're ready to execute the script.

You can also declare variables locally in a declare part of the PL/SQL block, but you will not be able to
modify or view the values of these variables. An advantage of these local variables is the fact that you
can use record types, PL/SQL tables, types and so on.

5.2  Executing a Test Script

To execute the Test Script, press the Execute button on the toolbar. After execution, the values of the
variables are updated. Any variable whose value has changed is displayed with a yellow background:

fﬁ' Test Window - New

Test script | DEMS Output | Statistics | Profiler | Trace |

B \ 2o
begin
tdeptname = employee.depthame | empno) }
end;
O MVariable | Type |Value |£|
¥ | deptname String * RESEARCH
M | empno Integer = 7369 ﬂ

= 242 Executed in 0,082 seconds g

The result of the function is 'RESEARCH!, so it obviously functions correctly. At the bottom of the
window, the execution time is displayed. This information can be used to optimize your code for
performance. For optimization purposes you can also view the statistics of the execution of the PL/SQL
block by selecting the Statistics tab. You can also create a profile report for each executed line of
PL/SQL code by pressing the Create Profiler report button before executing the script. After execution
you can switch to the Profiler page to view the report. Statistics and Profiler reports are explained in
chapter 6.2 and 6.3 respectively.
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You can abort a running Test Script by pressing the Break button, which is particularly useful when a
program is stuck in an endless loop, or execution is taking longer than expected. Note that pressing the
Break button will not always be successful. If for example the program is waiting for a lock, it will not
respond to a break signal.

After executing a script, a transaction may have been started by the program units that were executed.
The Commit and Rollback button on the toolbar will be enabled if this is the case. For more information
about transactions, see chapter 17.

5.3

Variable types

The type list in the variables section of the Test Window contains all types that can be used. The
characteristics of these types are explained in this chapter.

Type Description

Integer Can be used for numeric values in the range of -2732 to 232 - 1.

Float Can be used for other numeric values.

String Equivalent of a varchar2 data type in a table. Can be up to 2000 (Oracle7) or 4000
(Oracle8) characters. The value cell of this data type has a cell button that invokes a
text editor, so that you can view and modify multi line strings easily.

Date The date and time data type.

Long The Long data type does not display the value in the grid, but just displays <Long>.
Press the cell button to invoke the text editor.

Long Raw Pressing the cell button of a Long Raw value will invoke an import/export file
dialog, allowing you to load or save the contents of this variable.

Cursor This data type can be used where you can use a cursor variable in PL/SQL. After
executing the Test Script, you can press the cell button of the value to display the
result set ina SQL Window.

CLOB, BLOB | These LOB Locator variables must be initialized on the server before you can view

& BFile the LOB data. The CLOB will invoke a text editor, the BLOB and BFile will

invoke an import/export file dialog.

PL/SQL String

Use this data type for PL/SQL varchar2 values of up to 32000 characters.

Char

A fixed length (space padded) string.

BLOB

Substitution Substitution variables can be used without the restriction of bind variables. The
variable name in the PL/SQL block is substituted by its value in the text before it is
sent to the server.

Temporary These LOB Locators can already hold data before they are passed to the server

CLOB & through the Test Script.




PL/SQL Developer 9.0 User’s Guide 23

Boolean variables

When you select the variable type list-box, you will notice that the Boolean data type is missing. This is
because SQL*Net does not support this data type. To use a Boolean variable, you can declare it as an
integer and use the sys.diutil.bool_to_int and sys.diutil.int_to_bool functions provided by Oracle. These
functions convert between null/true/false and null/0/1. If you use the Test function in the Object
Browser, this conversion is automatically generated for you.

5.4  Saving Test Scripts

To save the Test Script, press the Save button on the toolbar. The save dialog uses .tst as the default
extension for Test Scripts, though you can change the default extension with a preference described in
chapter 20.28. The PL/SQL block, all variables (name, type and value), and the debugger watches (see
chapter 5.10) are saved. By saving a Test Script you can easily re-test a program unit if you modify it
later.

You can open a previously saved Test Script by pressing the Open button on the toolbar and selecting
Test Script, which will create a new Test Window. You can alternatively right-click on a previously
created Test Window and select the Load item, which will open a Test Script in the existing Test
Window.

Saving as SQL*Plus script

You can alternatively save a Test Script in SQL*Plus compatible format. This allows you to run the
script in an environment where PL/SQL Developer is not available (e.g. on a Unix server). To do so,
select SQL*Plus script (*.sql) as file type in the file selector dialog. The example script from the
previous chapter would be saved like this:

rem PL/SQL Developer Test Script

set feedback off
set autoprint off

rem Declare variables
variable result varchar2(2000)
variable p_empno number

rem Set variables

begin
result := null;
p_empno := 7369;
end;
/
rem Execute PL/SQL Block
begin
:result := employee.deptname(:p_empno) ;
end;
/

rem Print variables
print result
print p_empno

Note: You cannot open a SQL*Plus script again as a Test Script. If you want to reuse it in a Test
Window, make sure you save it as a Test Script as well!
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5.5  Tracking run-time errors

Whenever your program unit causes a run-time error, PL/SQL Developer will ask you if you wish to
view the sources of the error stack. This way you can quickly find the cause of the error. If there were
an error in our deptname function, the error stack window would look like this:

JIET
& cmplayee | Seipt |
Al | | [Deslaation | [Funtion | [ Code section ] [1F] [ Code section ] [ Comment o
(1 Declaration if p_empno is null =]
& depthame then
@ morame —— If el 11, return an empty name _J

result :
else
—— Fetch the name of the department
select dept.dname inte result
from dept, emp
. whara dent dentnn = emn dentnac: f

HEE |OR&-01422: exact fetch retums more than requested number of raws 7

At the top you see a tab for each program unit involved in the run-time error. The program units have
been called in right to left order. You can flip through the tabs to easily find the program flow that lead
to the error. In this case it shows that the Test Script has called function employee.deptname. This
obviously can get more complicated and even go across triggers.

Note: If you are using Oracle Server 7.2 or earlier, trigger source will not be shown in the error stack
window.

The error stack highlights each line that was involved in the error in red. For the last program unit in the
stack this is the line that caused the error. For all other program units this is the line where the call to the
next program unit was made.

5.6  Package states & Java session states

When you are editing, compiling and testing packages, the package states will be discarded by Oracle
after each compilation. All global variables in a package will be reset, and the initialization block will
be executed again. This can lead to unexpected results. Whenever PL/SQL Developer detects this
situation, a warning is issued in the status line of the Test Window: "Warning: ORA-04068: Existing
state of packages has been discarded".

Similarly, if you edit and compile a Java source any existing Java session state will be cleared. PLSQL
Developer will also handle this situation, and will display “Warning: ORA-29549: class <class name>
has changed, Java session state cleared” in the status line.

5.7  Viewing result sets

In a Test Script you are not limited to PL/SQL blocks. You can also execute single SQL statements,
including select statements. Executing a select statement will display an additional Results tab page,
which displays all selected rows.

5.8  Viewing dbms_output

For debugging purposes it can sometimes be necessary to "print" some information to the screen from
within a program unit. For this purpose Oracle created the doms_output package. By calling
dbms_output.put_line, information is placed in the output buffer. After execution of a Test Script, you
can select the Output tab at the top of the Test Window to view the contents of the output buffer. On
this page you can additionally set the size (0 for unlimited) of the output buffer or enable/disable
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buffering. The default settings on the output page are controlled by the output preferences as described
in chapter 20.5.

5.9  Viewing HTP output

If you want to test program units that make use of the PL/SQL Web Toolkit, the HTP Output tab page
will be displayed if any HTP output was generated:

= Test Window - htp_demo.tst M[=1E3
Test scripll DEMS Output  HTP Output |Statistu:s| Prmﬂlerl Trace I

=20

Employees in department 30, SALES

[7499 ALLEN [SALESMAN 7658[20-02-1981 00:00:00 [1600(300 30
[7521 WaRD  [SALESMAN 7698[22-02-1981 00:00:00 [1250[500 [30
[7654 MARTIN [SALESMAN 7698 28-09-1981 00:00-00 [1250/1400(30,
[7698 BLAKE |MANAGER 7839(01-05-1981 00 00.00 28500 20
[7844 TURNER [SALESMAN 7698 08-09-1981 p0-00-00 [15000 |30
7900 TAMES |CLERE  [7692[03-12-19a1 oo00:00[e50 [0 30

This page was produced by the PL/SQL Web ToolKit on Cctober 19, 2001 07:09 P

= |22:‘\ ‘Execu(ed in 0,02 seconds

If there is no HTP output, this tab page will not be visible.

5.10 Debugging

For those programming errors that are really hard to track, the Test Window provides an integrated
debugger. At the top of the window you find a toolbar with functions related to the debugger. To start a
debug session, just press the Start button at the left of the debug toolbar instead of the Execute button in
the main toolbar. The other buttons are now enabled and you are ready to debug.

Controlling execution

After starting the debugger, execution will pause before the first statement in the Test Script. After this,
you can control execution with the buttons in the debug toolbar:

b Run the script until completion.

Step into a procedure, function or method call on the next line. If the next line contains an update,
insert or delete statement that will cause a trigger to be fired, you will step into that trigger.

o Step over the next line. It will be executed, but you will not step into the source.
a Step out of the current program unit.

Run until an exception occurs. Execution will be paused on the line that causes the exception.
After the next step the exception will actually be raised.

Whenever you step into a program unit, its source will automatically be loaded into the Test Window.
The bottom of the editor panel will now show tabs for each program unit, so that you can easily switch
between them to view the source, set/remove breakpoints, and so on. By right-clicking on the editor
panel you can remove a program unit from the Test Window if you are no longer interested in it:
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% Test Window - Script for function E"lPLOYEE_DEPTNAME

Test script | Output | Statisticsl
2| b o Al 200
—— Return the name of the department -
function deptname(p_%mpno in emp.empnostype) return dept.dnsmeitype is
result dept.dnamest: p_empna = 7369
hegin
@ if p ewpno is null
then
—— If empne is null, return an empty kame
result := null;
else

—— Fetch thke name of the department
dept.dname into result

from dept, ewmp
where ewp.ewpho = p_etpno
and dept.deptno = emp.deptno; LI

emplayes

“ariable |‘\a’alue |§ Call stack |
result MNULL _I [Line 13]  selectdept.dname into result
b

= 131 Executing... &

Viewing and setting variable values

To view the value of a variable during a debug session, you can simply move the mouse cursor over the
variable in the source. After %2 a second, its value will be displayed in a popup. Variables in the PL/SQL
block of Test Script can never be displayed. Complex variables (e.g. record and object types) cannot be
displayed either, though you can view individual fields. Future versions of Oracle may remove these
limitations.

To set the value of a variable, right-click in its name in the program source and select the Set Variable
item from the popup menu. An input field appears with the current value of the variable. You can enter
a new value and press Enter to apply it, or Esc to cancel the operation:

MNew value IRESEAF%]

From the same popup menu you can also select to add the variable to the watch list, which means that
after each debug step the variable value will automatically be displayed and updated in the watch list at
the bottom-left of the Test Window.

If a variable is a collection (a PL/SQL table, varray or nested table) of a scalar data type you can view
the entire collection by right clicking on it and selecting View collection variable from the popup menu.

Note that variable values can only be viewed and set if the program units are compiled with debug
information. A preference exists that will cause each compilation to include debug information, and you
can manually add debug information by right-clicking on a program unit in the Object Browser and
selecting the Add debug information item from the popup menu.

Using Breakpoints

Breakpoints can be used to halt program execution on a certain line in your PL/SQL code. When
execution halts, you can view and set variables, step through the code, and so on. You can define a
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condition for a breakpoint, in which case execution will only be halted when this condition is met. For
each breakpoint you can define a message that will be placed in the output page when the breakpoint is
reached.

Setting breakpoints

There are two ways to set breakpoints: in a Program Window or in a Test Window. In both cases you
simply need to click on the appropriate line in the left margin of the editor. A breakpoint mark will
appear, indicating that a breakpoint is present on that line. When you execute a Test Window in debug
mode, execution will stop if one of the breakpoints is encountered.

If you set a breakpoint in a Program Window, it can be that this particular program unit has not yet been
compiled into the database. Therefore, such a breakpoint cannot be applied to the database yet either. In
this case the breakpoint mark will have a different appearance. When you subsequently compile the
program unit, the breakpoint will be applied and the corresponding mark will change to reflect this. As
long as the program unit is not compiled, any previously set breakpoints in this program unit will be
effective.

You cannot set breakpoints in the PL/SQL block of the Test Script.
To delete a breakpoint, simply click on the breakpoint mark again.

Breakpoint conditions

Sometimes you define a breakpoint on a line that is executed very often, even though you are only
interested in the program status under certain circumstances. In that case you can define a condition for
the breakpoint. Execution will only halt when the condition is met.

To define a condition for a breakpoint, right-click on the mark and select the Modify Breakpoints item
from the popup menu. The following dialog will appear:

=68 DEPARTMENT

‘(%@ Line 38 g_deptrecord = null:

-8 EMPLOYEE

[# @ Line 15: select dept.dname into result
null;

@ SETPASEWORD
% @ Line 5 dbms_sql parse(cid, 'BLTER USER.' || use

< | b

¥ Use Condition I.p_empnu is not null

™ Use Message I
I Don't Break

™ Use Pass Count |1 2 l

In this dialog you see all program units that have breakpoints, with the breakpoints listed below them.
Each breakpoint has a checkbox that can be used to enable or disable it. The bottom section displays the
following fields:

. Use Condition — The checkbox enables or disables the condition. The condition itself should be a
boolean expression. When the breakpoint line is reached, execution will only be halted if the
condition evaluates to True. You can use any SQL expression in the condition, and you can use
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any variable that is known at the location of the breakpoint. These are the same variables that you
can view or set during interactive debugging. Variables should be preceded with a colon. For
example upper(:ename) = “SMITH” isa valid condition if ename is a valid variable at the
breakpoint location.

. Use Message — The checkbox enables or disables the message. When the breakpoint line is
reached, and if the conditions are met, the message will be placed on the output page.

. Don’t Break — This checkbox is only useful if you also define a message. When it is checked,
execution is never halted on this breakpoint line. This way you can define breakpoints that only
generate messages on the output page.

. Use Pass Count — This checkbox enables or disables the pass count, which defines how many
times the breakpoint line must be passed before execution is halted. If, for example, you define a
pass count of 10, execution will halt every 10th time the breakpoint line is reached.

Viewing the call stack
The call stack can be viewed at the bottom-right of the Test Window. It is automatically updated after
each debug step.

Debugger preferences

In the Preferences item in the Tools menu you can find a section of debugger related preferences. These
preferences are described in detail in chapter 20.4.

5.11 Tracing execution

If you are using Oracle8i or later, you can use the Test Window’s Trace facility to trace the execution of
your PL/SQL code. You can configure which events you want to trace: Calls, Exceptions, SQL, or even
every executed line of PL/SQL code. Press the Select Trace Levels button next to the Create Trace
report button to bring up the following configuration screen:

™ Test Window - Script fol =olx|
Test script |DBMS Outputl Etailst\csl mellerl Trace I
B | @ o-
hegin Call
—-=- Call the function ]
iresult := employee.deptnan  Mone Cral o EnabIEd:
end;
Exception
£~ None Al & Enabled
FS0L
 None LAl & Enahled
rLine
O [Variable [Tvpe € MNane C Al & Enabled
| || result String
M| p_empno Integer OK Cancel
Eall

= 1:1 Executed in 0,01 seconds y

You can control if you want to trace specific events in each program unit (All), only in those program
units that are compiled with debug information (Enabled), or never (None).
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To create a Trace report, simply press the Create Trace report on the toolbar of the Test Window and
execute your Test Script. After execution you can switch to the Trace tab page to view the report, and to
view reports of previous runs:

2 Test Window - Script for function EMPLOYEE. DEPTNAME M=l
Teslscrlpl' DBMS Outpul' Slansncs' Profiler Trace |

# © {3 Fun [15-10-2001 189:28:41 -

Comment _[Eventtime _[Unitnams _Unitline __[Unit line text _[Exception |
|| PL/SOL Virual Machine staned 19-10-2001 19:29:41
|| Procedure Call 18-10-2001 19:29:41
|| Mewline executed 18-10-2001 19:29:41 | EMPLOYEE.DEPTNAME
|| Mewline executed 19-10-2001 19:29:41 | EMPLOYEE.DEPTNAME
|| Mew line exacuted 19-10-2001 19:29:41 | EMPLOYEE.DEPTMNAME 9 if p_empna is null
|| Mewiline executed 19-10-2001 19:29:41 | EMPLOYEE.DEFTNAME 15 select dept.dname into result
|»| SELECT DEFT.DNAME FROM DEFT 19-10-2001 19:29:41  EMPLOYEE.DEFTNAME 15 select dept.dname into result
| | Exception raised 19-10-2001 19:29:41 | EMPLOYEE.DEPTMAME 15 select dept.dname info result 1403
|| Exception handled 19-10-2001 19:29:41 | EMPLOYEE.DEPTNAME 27 wihen no_data_found then retuminull); | 1403
|| Mew line executed 19-10-2001 19:29:41 | EMPLOYEE.DEPTMAME 27 when no_data_found then returninull);
|| Mewline executed 19-10-2001 19:29:41 | EMPLOYEE.DEPTMAME 28 end;
|| Return fram pracedure call 19-10-2001 19:29:41 | EMPLOVEE.DEFPTNAME 28 encl;
|| PL/SOL Virual Machine started 19-10-2001 19:29:.41
- ‘1 1 ‘Exe:uted in 0,01 seconds 4

In this (simple) report you can see that a select statement on line 15 of function employee.deptname
raised exception 1403 (No data found), which was handled on line 27 in the same program unit.

For each traced event, you can include information in the report like the event description, time,
program unit, line number, exception, and so on. To configure this, press the Preferences button at the
upper left of the Trace toolbar. This will bring up the Trace preferences page as described in chapter
20.6.

To view old trace reports, select a previous trace run from the Run selection list. Press the Delete Run
button to delete the currently selected run.

For more information on the Oracle Trace facility, see the DBMS_TRACE chapter in the Oracle
Supplied Packages Reference manual.
5.12 Regression testing

To use Test Scripts for regression testing, you can use the Test Manager tool (see chapter 21.15) to
define and run Test Sets based on Test Scripts.
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6. Optimizing

To optimize the SQL statements in your program units, Oracle's Explain Plan utility can be a big help
by showing the execution path of a statement. Therefore it is integrated into PL/SQL Developer's IDE.

To view the actual resource use of a SQL statement or PL/SQL program unit, PL/SQL Developer can
display statistics about its execution. You can configure which statistics you wish to display, and can
include elapsed time, CPU time, logical reads, physical reads, physical writes, and so on.

To determine the execution time of each individual line of PL/SQL code, you can use the PL/SQL
Profiler. This feature is not available on Oracle 8.0 or earlier.

Finally, you can use Oracle's tkprof utility to get resource use information about all executed SQL
statements in a program unit by enabling SQL Trace.

6.1  Using the Explain Plan Window

To use Oracle's Explain Plan utility, press the New button on the toolbar and select Explain Plan
Window. An empty Explain Plan Window appears. In the top half of the window, you can type the SQL
statement you wish to analyze. After pressing the Execute button on the toolbar the execution plan is
displayed in the bottom half of the window:

2 Explain Plan Window M=1E]
select d.dnsme

from dept d, emp =
where e.empno = 7365

and e.deptno = d.deptno

Optimizer goal | Choose - L

Description \ Object owner | Object name | Cost | Cardinality \ Buwtes
= SELECT STATEMENT. GOAL = CHOOSE 2 1 15
E-NESTED LOOPS 2 1 15
B TABLE ACCESS BY INDEX ROWID ~ SCOTT EMP 1 1 5
INDEX UNICUE SCAN: SCOTT PK_EMP 1
B TABLE ACCESS BY INDEXROWID  SCOTT DEFT 1 5 50
-INDEX UNIQUE SCAN SCOTT PK_DEFT 5
|Se|ec:l & unigue value from a unigue index 4

You can now change the SQL statement and press the Execute button again to see the impact of the
changes. For more information about execution plans, you can read Oracle’s Server Tuning manual.

To see the effect of different optimizer goals on the query plan, select the corresponding entry from the
Optimizer goal list. The plan will immediately be updated to reflect these changes.

Use the First, Previous, Next, and Last operation buttons to navigate through the query plan in order of
operation. After the plan has been determined, the first operation will be highlighted.

The Explain Plan utility uses a so-called plan table to store the execution plan. If such a table is not
available to the current user, PL/SQL Developer will ask you if it should create this table in the schema
of the current user. To define which columns from the plan table you want to see, and in which order,
press the Preferences button. This will bring up the corresponding preference page (see chapter 20.22).

Note: If you are using Oracle Server 7.2 or earlier, the cost and cardinality are not available in the plan
table. If you are using Oracle Server 7.3 or higher and cost and cardinality are not displayed, you
probably need to upgrade the plan table.

If you right-click on the Object name column, this will bring up the popup menu for the selected object.
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Analyzing SQL in a program unit

Most of the time, the SQL statements you wish to analyze are contained in the source of a program unit.
To do this, you can select the SQL statement in the Program Editor and select Explain Plan from the
Help menu (or press F5). A new Explain Plan Window is created for the selected SQL statement, and
all PL/SQL variables are replaced by bind variables.

If you explicitly copy & paste a SQL statement that contains PL/SQL variables from the program unit
and you execute the Explain Plan window, you will receive an "ORA-00904: Invalid column name"
error. The Explain Plan utility mistakenly assumes all these variables to be columns. Each variable must
therefore be prefixed with a colon. If we wanted to analyze the SQL statement in the
employee.deptname function, the result and p_empno variables would have to be altered in the
following way:

= Explain Plan Window M[=1E3
select d.dnsme into :result

from dept d, emp =
where e.empno = ip_deptno

and e.deptno = d.deptno

Optimizer goal | Choose - N -

Description | Object owher | Object hame | Cost \ Cardinality \ Buwtes
= SELECT STATEMENT, GOAL = CHOOSE 2 1 15
E-NESTED LOOPS 2 1 15
B TABLE ACCESS BY INDEX ROWID  SCOTT EMP 1 1 5
[ INDEX UNIQUE SCAN SCOTT PK_EMP 1
B TABLE ACCESS BY INDEX ROWID  SCOTT DEPT 1 & 50
- INDEX UNIQUE SCAN SCOTT PK_DEPT 5
|Se|ec:l a unique value from a unigue index 4

Now the Explain Plan utility knows which identifier is a column, and which identifier isa PL/SQL
variable.

6.2  Automatic statistics

When you execute a statement in a SQL Window or in a Test Window, PL/SQL Developer will
automatically generate a statistic report of this execution. One condition is that you need to have select
privileges on the dynamic performance tables v$session, v$statname and v$sesstat (provided through
the standard plustrace role).

You can view the statistic report by changing to the Statistics tab at the top of the SQL Window or Test
Window. The statistics for the execution of the employee.deptname function might look as follows:

Testscriptl DEMS Qutput  Statistics |Pr01i|er| Trace |

MName | Last | Tatal |
CPU used by this session 1] 1]
physical reads 5 12
physical writes 0 1]
session logical reads 17 45
sorts (disk) 1] 1]
sorts (memary) 2 2
sorts (rows) 5 5
table fetch by rowid 1 3
table scan blocks gotten 3 5
takle scan rows gotten 19 2
table scans (long tables) 0 0
table scans (shor tahles) 3 5

= | |Executed in 0,084 seconds A
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For each statistic you see the value of the last execute, and the total for the current session. You can
configure if and which statistics are displayed by setting a preference, as described in chapter 20.2. The
default set of statistics is relevant to the tuning of your SQL and PL/SQL, and is described here:

Statistic

Meaning

CPU used by this session

The CPU usage in hundredths of a second

Physical reads

The number of blocks read from disk

Physical writes

The number of blocks written to disk

session logical reads

The number of blocks read from the block buffer or from disk

sorts (disk)

The number of sorts performed in a temporary segment

sorts (memory)

The number of sorts performed in memory

sorts (rows)

The number of rows that were sorted

table fetch by rowid

The number of rows fetched by rowid, usually as a result of index accesses

table scan blocks gotten

The number of blocks read for full table scans

table scan rows gotten

The number of rows read for full table scans

table scans (long tables)

The number of full table scans on long tables

table scans (short tables)

The number of full table scans on short tables

Which other statistics you can include depends on the version of the Oracle Server and are not described
in this manual. If you wish to get information about them, there are many Oracle tuning books available
that address this topic. The Oracle Server Reference also briefly describes these statistics.

The statistics can be exported to a CSV file (Comma Separated Values) that can be opened in a spread
sheet application later. Just right-click on the statistics, select the Export item and choose the CSV file
item. You can alternatively select a TSV, XML or HTML format, or copy it to the clipboard.

6.3  The PL/SQL Profiler

The PL/SQL Profiler is a very powerful tool to help you optimize your PL/SQL code. For each
executed line of code, the total time, maximum time, minimum time, average time, and the number of
occurrences will be determined.

The Profiler is easily accessible in the Test Window. Before executing a Test Script, simply press the
Create Profiler report button on the toolbar of the Test Window. If you subsequently execute the script,
you can switch to the Profiler page to view the report.
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The following example report shows that in the employee.deptname function, the select statement took
149 milliseconds, and the 3 dbms_output calls took 57 milliseconds:

2 Test Window - deptname st 9 [=] E3'
Tes(acript' Output | Statistics PTDNET'
£ @ ¥ Run [deptame tst-14-01-2001 144618 =l i [an-244 =
Unit [Line [Totaltime [Occurrences | Text |
ANONTMOUS BLOCK 4 27 2 result = employee.deptname(p_empno => ;p_empna);
| [EMPLOVEE q 1 1 ifp_empnois null
| |EMPLOYEE 12 0 0 result:= null;
? EMPLOYEE 15 149 1 select dept.dname into result
: EMPLOYEE 20 57 3 dbms_output put_line(to_char(sysdate, 'dd-mm-ysany hh24miss")
EMPLOYEE 24 5 1 return(result):
| |[EMPLOYEE 27 0 0 when no_data_found then return{null);
: EMPLOYEE 28 4 1 end;
EMPLOYEE 34 0 0 it p_empno is null then
| |EMPLOVEE 36 0 0 result = null;
| |EMPLOYEE 3 0 0 select m.ename into result
| |EMPLOVEE 44 0 0 dbms_output put_line(to_char(sysdate, 'dd-mm-sany hh24micss)
: EMPLOYEE 43 0 0 return{resul);
EMPLOYEE RO 0 0 when no_data_found then return(null);
| |EMPLOVEE 51 0 0 end;
= |1 1 |Execu|ed in 0 seconds 4

By default the Profiler page will display the report of the last run. You can also select previous runs
from the Run list. The Unit list allows you to zoom in on a specific program unit of a run.

The Total time column shows a graphical representation of the relative time of the line, compared to the
line with the highest time. This allows you to quickly identify the lines that are most expensive. The
report can be sorted by pressing on the sort-buttons in the heading of the columns.

If a source line is displayed in red, this means that the program unit has been changed since the profile
report was created. Therefore the displayed line of code can now be different than when the profile was
created.

You can change various layout aspects of the Profiler report by pressing the Preferences button. This
will bring up the corresponding preference page, as described in chapter 20.7.

For more information about the PL/SQL Profiler, see the dbms_profiler chapter in the “Oracle8i
Supplied Packages Reference” manual.

Note: not all platforms provide equally accurate timing information.

6.4 SQL Trace

You can enable SQL Trace by pressing the SQL Trace button on the toolbar. After this, all server
processing caused by a SQL Window or Test Window will be logged in a trace file on the database
server. One condition is that the timed statistics parameter of the database instance you are using must
be set to true.

You can disable SQL Trace by pressing the SQL Trace button again.

You can view the information in the trace file by using Oracle's tkprof utility on the database server. It

will generate a report about elapsed time, CPU time, 1/O, and so on for each SQL statement. Therefore,
it can give you some insight into which statements are the most costly in a program unit. To learn more
about Oracle's tkprof utility, you might read the "Oracle 7 Server Tuning" manual.

The tkprof report for the execution of the employee.deptname function might look as follows:
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TKPROF: Release 7.2.2.3.1 - Production on Fri Sep 26 14:59:08 1997
Copyright (c) Oracle Corporation 1979, 1994. All rights reserved.

Trace file: ora07087.trc
Sort options: default

count = number of times OCI procedure was executed

cpu = cpu time in seconds executing

elapsed = elapsed time in seconds executing

disk = number of physical reads of buffers from disk

query = number of buffers gotten for consistent read

current = number of buffers gotten in current mode (usually for update)

rows = number of rows processed by the fetch or execute call

begin

:deptname := employee.deptname(:empno);

end;

call count cpu elapsed disk query current rows
Parse 1 0.00 0.00 0 0 0 0
Execute 1 0.01 0.01 0 0 0 1
Fetch 0 0.00 0.00 0 0 0 0
total 2 0.01 0.01 0 0 0 1
Misses in library cache during parse: 0
Optimizer hint: CHOOSE

Parsing user id: 16
SELECT DEPT.DNAME

FROM

DEPT,EMP WHERE EMP.EMPNO = :bl AND DEPT.DEPTNO = EMP.DEPTNO
call count cpu elapsed disk query current rows
Parse 1 0.00 0.00 0 0 0 0
Execute 1 0.00 0.00 0 0 0 5
Fetch 1 0.06 0.06 4 4 0 1
total 3 0.06 0.06 4 4 0 6

Misses in library cache during parse: 0
Optimizer hint: CHOOSE
Parsing user id: 16 (recursive depth: 1)
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7. Ad hoc SQL

Often during program development you need to execute some SQL statement. Either to test the SQL
statement, to view data in a table, or to update data. You can do this from within PL/SQL Developer by
using the SQL Window.

7.1  Using the SQL Window

To create a new SQL Window, press the New button on the toolbar and select SQL Window. An empty
SQL Window appears, in which you can type a SQL statement. If it is a select-statement, the window
splits into two parts and shows the results in a grid in the bottom half. If we wanted to view all the
employees in the employee table, the SQL Window would look like this:

~io/x]
SOL | Uutputl Slatlstu:sl
select * from emp
oxrder by enamel s
Hi-| & vEH @ ==
EMPNO _[EMAME [ JOB __|MGR_[HIREDATE _|SAL _[COMM _[DEPTNG |
M1 7876 ADAMS | CLERK 7788 | 23-05-1987 = 1100,00 20
2] 7499 ALLEMN SALESMAN 7698 20-02-1981 = 160000 300,00 a0
| 3] 7698 BLAKE MANAGER 7638 01-06-1881 = 2850.00 in
| | 4] 762 CLARK MANAGER 7839 | 09-06-1981 = 2450,00 10
| [ 5] 7902 FORD ANALYST 7BEBE 03-12-1981 = 3000.00 20
| | & 2900 JAMES  CLERK 7B98 03-12-1881 = 850,00 in
:j 7566 JOMES  MANAGER 7039 | 02-04-1951 = 2975,00 20
i 7839 KING FRESIDENT 17-11-1881 = 6000.00 10
BE 654 MARTIN | SALESMAM 7H96 28-09-1981 = 125000 140000 in
:E 7834 MILLER.  CLERK 7702 |23-01-1962 =1300,00 10
= T [215 10 rows selected in 0,016 seconds (more. ] v

The SQL statement is executed and 10 rows have been retrieved. The result set is larger than 10 rows,
which is indicated by the fact that both the Next Page and Last Page buttons on the result set toolbar are
enabled, and the fact that (more...) is displayed on the status line. Only 10 are initially retrieved because
this is the number of records that can be displayed on the grid. Pressing the Next Page will retrieve the
next 10 rows, and so on. Pressing the Last Page button will retrieve all rows.
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If you have multiple SQL statements in the SQL Editor and press the Execute button, all statements will
be executed, and the results will be displayed in separate tab pages:

% QL Window - select * from emp order by ename; select =1}

SOL | Duput | Statistios |

select * from emp ol 0
order by ename; &+
select * from dept

order by dname;|

Select emp  Select deptl
B- e | o @ s
DEPTMO _|DMAME  [LOC ]|

10 ACCOUNTIMNG MEW YORK

40 OPERATIONS BOSTOM

20 RESEARCH  DALLAS

30 SALES CHICAGO

S -

L

(===

= T 418 4 rows selected in 0 seconds 4

SQL statements must be terminated with a semi-colon or a slash, and PL/SQL blocks must be
terminated with a slash, just like in SQL*Plus. If you select a result tab, the corresponding text in the
SQL Editor will be highlighted.

If you select a part of the text in the SQL Editor, only the selected text will be executed. This way you
can have more than one statement in the editor, and still execute them one by one.

If you execute a SQL statement that takes a long time to finish you can press the Break button to abort
it. Note that pressing the Break button will not always be successful. If for example the statement is
waiting for a lock, it will not respond to a break signal. If you have pressed the Break button when the
SQL Window is retrieving rows, it will simply stop and display the rows that have already been
retrieved. You can now continue retrieving records with the Next Page and Last Page buttons.

Note that the SQL Window preferences allow you to determine how many rows are initially retrieved
for a select statement. This is described in chapter 20.20.

At the right side of the window you see two buttons that allow you to navigate through all SQL
statements that you have entered in the SQL Window. This way you can quickly re-execute statements
entered previously.

For optimization purposes you can view the statistics of the execution of the SQL statement by selecting
the Statistics tab. Statistics are explained in chapter 6.2.

When you print a SQL Window, the SQL statement and the result grid will be printed. By selecting
rows in the result grid, you can limit the amount of rows that will be printed.

By default the tab titles will be derived from the statements. To override this you can use a comment
with a tab=<title> expression before the statement. For example:

-- tab=Department 10
select * from emp
where deptno = 10;

In this case the tab title is Department 10 instead of the default Select emp.
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7.2 Result grid manipulation

The result grid of the SQL Window can be manipulated in various ways. Some cell types have special
behavior, rows, columns, and cell ranges can be selected and printed, columns can be moved, rows can
be sorted, you can switch to a single record view, and so on.

Aligning cells
To quickly align cells based on the column values, you can use the Align button:
B 8 e dla |

Column width to header and contents
Column width to header
Column width to contents

»

Row height to contents
Row haight to single

Align from template »
S )

ave as template
¥ Auto-align from template

7
2
3
4
5

If you press this button, the width of each cell will be determined by the column header and the
contents. If you press the pull down button next to the Align button, you can select different alignment
options from the pull down menu. You can limit the width alignment to the header or contents, and you
can additionally align the row heights.

You can also create custom template alignments for specific queries that you frequently use. After
setting the cell widths you can select the Save as template item to save it. If you execute the same query
later, this alignment can either be applied explicitly by selecting the Align from template option, or
implicitly if you enable the Auto-align from template option. Note that in addition to the column widths,
the template will also save the column order.

Recognizing null values

Null values are displayed as a cell with a light yellow background, so that you can quickly distinct them
from a value with all blanks. It is also helpful to recognize null values for cells that do not display the
value directly in the grid, such as longs and LOB’s. You can change the color of the null value cells
through a preference (see chapter 20.20).

Viewing large data columns

The values of Long, Long Raw, CLOB, BLOB and BFILE columns are not displayed in the result grid.
Instead, they are simply displayed as <Long>, <Long Raw>. <CLOB>, <BLOB> and <BFILE>:
BCC_ADDRESS| &

<CLOB> W F
<CLOB> C
-

PIaal=1N

When you click on the cell button of such a column, the Large Data Editor is invoked, which allows you
to view or edit the data in various formats. See chapter 23 for more details.

You can also click on the cell button of character columns to invoke the Large Data Editor. The cell
button is only present if the column size is larger than 20 characters.
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Viewing date columns

A date column has a cell button that displays a calendar with the current date highlighted. If the date
also has a time fraction, you can view its value on the calendar as well:

0o : 0000

EEEREr =

Viewing timestamp columns

Timestamp columns are displayed in the format that is specified in the NLS_TIMESTAMP_FORMAT
and NLS_TIMESTAMP_TZ_FORMAT registry settings of your Oracle Home.

Viewing XML data

There are various ways to store XML data in the database: as CLOB’s (Oracle8i), as XMLTYPE
(Oracle9i), or even as Varchar2 or Long columns. In any case the Large Data Editor will recognize the
XML format if it starts with the standard XML header, and will switch to the XML format. See chapter
23 for more details.

Viewing nested cursor columns

If you include a nested cursor in the field list of a select statement, the column value will initially be
displayed as <Cursor>. Pressing the cell button will bring up a new SQL Window with a result grid with
the cursor result set. This can be used to view simple nested queries. Note that each nested cursor value
will implicitly result in an open cursor, so for large result sets you can easily run into the
OPEN_CURSORS limit and get “ORA-01000: maximum open cursors exceeded” errors.

Selecting columns, rows and cells

To select rows or columns in the result grid, just click on the row heading or column heading and drag
the mouse pointer to highlight the selection:

EMPMO _[ENAME _[JOB " [MGR_[HIREDATE [SAL |«
7369 SMITH | CLERK 7302 17-12-1380 = 000,00
7499 ALLEN  SALESMAN 7690 20-02-1961 = 1600.00
7521 \WARD | SALESMAN  763822-02-1381 = 1250,00

1oF 3 a

EMPNO  [ENAME
7369 SMITH
7439 ALLEN
7521 WARD
7566 JONES
754 MARTIN
7698 BLAKE
7782 CLARK.
7780 SCOTT
7039 KING
7844 TURNER

BLAKI ER 01 a0
7782 CLARK MANAGER 7838/ 09-06-1981 245000
7788 SCOTT  ANALYST 7566 09-12-1982 300000
7839 KING PRESIDENT 17111951 500000
7844 TURNER | SALESMAN 7698/ 08-09-1981 WSUDTﬁI

13

| N

e eme==

1

=

-

A column selection can now be moved by releasing the mouse button, clicking on one of the selected
column headings again, and dragging the selection to the new location.
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To select a specific range of cells, move the mouse pointer over the left edge of a cell until its shape
changes, press the mouse button, and drag the mouse to highlight the selection:

7844 TURNER | SALESMAN

7698 22-02-1381
7839 02-04-1381
7698 28-03-1381
7839 01-05-1981

7698/ 08-09-1981

EMPNO _[ENAME OB " [MGR__[HREDATE [SAL | =
7389 SMITH | CLERK 7902(17-12-1980 = 800.00
SALESMAN 7698 20-02-1381 = 1600.00

1250,00
2575,00
1250,00
2850,00

FEGH CLARK ER, 7839/ 09-06-1981 2450,00
7708 SCOTT  ANALYS i 7566/ 09-12-1962 300000
7039 KING PRESIDENT 17-11-1981 500000

150000 =
13

To select all rows and columns, press the upper left cell, or right-click on the grid and select the Select
All item from the popup menu.

The highlighted selection can be copied or printed as usual.

Scroll locking

Sometimes you want to prevent that certain key data scrolls off screen. For the example above you may
want to prevent that the empno column scrolls off screen when you scroll the grid contents to the left.
To do so, right-click on the empno column and select Lock columns item from the Scroll lock popup
menu item. To lock more than one column you can lock the rightmost column.

You can lock rows in a similar way: right-click on a row and select Lock rows item from the Scroll lock
popup menu item.
Sorting rows

To sort the rows in a result grid, press the heading button of the column on which you want the rows to
be sorted:

EMPNGO [ENAME [ JOB “[MGR__[HIREDATE -[SAL [«
B 7788 SCOTT  AMALYST "% 7566 03-12-1882 = 3000.00
7369 SMITH  CLERK 7302 17-12-1380 = 800,00
7876 ADAMS  CLERK 7788/12-01-1883 = 1100,00
EEG JOMES  MAMAGER | 7039 02041981 = 297500
7RG ELAKE  MAMAGER | 7039 01-05-19G1 = 265000
7782 CLARK.  MAMAGER | 7333 09-06-1381 = 245000
7839 KING PRESIDENT. 17-11-1381 = 5000,00
7499 ALLEN  SALESMAMN 7638 20-02-1381 = 100,00
7521 WARD  SALESMAM 7698 22-02-1981 = 1250,00
7044 TURMER SALESMAM 7690 06-09-1901 = mDﬂj
4 »

The rows will be sorted in ascending order, as indicated by the heading button. Pressing the heading
button again will sort the rows in descending order. Pressing it a 3rd time will undo the sorting. Pressing
the heading button in another column will sort the rows on this column, but will also use the previous
sort column as the secondary sort column (indicated by the dot in the heading button). In the example
above, the job column is the primary sort column, and the hiredate column is the secondary sort
column. By default the sort order will not be case sensitive. Right-click on the grid and select the Sort
case sensitive item to change the sorting behavior.

Note that sorting is performed locally, and only for the rows that are already retrieved. If you retrieve
additional rows after sorting the results, these new rows will be added at the end of the result grid,
without any sorting. For large result sets, local sorting can take a long time. In this case it might be
better to use an order by clause in the select statement and let the Oracle Server do the sorting.



40 PL/SQL Developer 9.0 User’s Guide

Single Record View

If the result set contains many columns, it may be inconvenient that each record is displayed on a single
line. You need to scroll back and forth to view related columns (though you can move the columns),
and cannot view all the columns of the record at once.

By pressing the Single Record View on the grid toolbar, you can view a single record at a time:

* 8QL Window - select * from emp order by ename (=13

SGL |Uutput| Slatlstu:sl

select * from emp
order by ename >
B- 8 vEn (av (< ESE-
Rowl _|Fields |
P EMPNO 7876
ENAME ADAME
JoB CLERK
MGR 7788
HIREDATE| 23-05-1987 =
SAL 1100.00
COMM
DEFTHO |20
= 143 |2'TE |empnn, rumber(4). mandatory, The 4 digit number of the employes v

Now each row displays a single column name and value. The Next Record and Previous Record on the
grid toolbar can be used to navigate through the result set. To switch back to the Multi Record View,
press the Single Record View button again.

Exporting data

There are several ways to export the data in the result set grid. After executing a select statement, you
can select a range of cells as described above, right-click on it, and select the Export Results item from
the popup menu. This will display a submenu where you can choose to export the data in CSV format
(Comma Separated Values), TSV format (Tab Separated Values), HTML format, XML format, or SQL
format. After selecting the format, you can specify the export file. The SQL format will generate a SQL
file with insert statements for the queried table or view.

You can alternatively copy the selection to the clipboard by pressing Ctrl-C, or by right-clicking on the
selection and selecting the Copy or Copy with Header item from the popup menu. You can subsequently
paste this data in another application like a spreadsheet, word processor, an so on.

To quickly manipulate the result set information in Microsoft Excel, select the Copy to Excel item. This
will export the selected data to a temporary file and open it in Excel. If you are using Excel 2003 or
earlier, use the Copy as xIs submenu item. If you are using Excel 2007 or later, use the Copy as xlIsx
submenu item. The older xIs format has a limit of 65535 records per page, so if the selected data
exceeds this limitation it will be split over multiple Excel pages. If you have multiple result sets you can
also use the Copy all as xls or Copy all as xIsx item instead, which will create separate Excel pages for
each result set.
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7.3 Query By Example mode

After executing a select statement, you can press the Query By Example button above the result grid if
you want to search for specific records. Pressing this button will clear the grid, and leave one empty
record where you can enter your query values. If, for example, you want to find all employees that start
with the letter A in department 20, enter A% in the ename column and 20 in the deptno column:

% SQL Window - select * from emp order by ename =13
SOL | Duput | Statistios |
select * from emp
order by cehame &+
-  mse  wEEa-
| [EMPNO_[ENAME _[JOB __[MGR_[HIREDATE _[SAL _[COMM _|DEPTNG _|
7 A% = 20 2
= [ |2 15 |deptnﬂ, rumber(2), optional, The 3 digit number of the department 7

Pressing the Query By Example button again, or pressing the Execute button, will execute the modified
query and display the restricted results. Press the Query By Example button again to continue with the
previous query values. Press the Clear record button to clear the query values.

Query values are not restricted to single values with wildcard characters. You can use the following
expressions (alternative expressions between square brackets):

e  value [=value]

e  value with wildcards [like value with wildcards]

. > value
. <value
. 1= value [<> value]

. in (valuel, value2, ...)

. between valuel and value2
. null [is null]

. not null [is not null]

Note that if you use a literal value, you can omit quotes for character values (e.g. SMITH will
automatically be converted to ‘SMITH?” in the SQL text). For all other expressions you must provide a
literal value that the Oracle Server understands (e.g. != ‘SMITH?). This is also the case for number and
date values. If you use it in an expression, use a format that the Oracle Server understands.

Several preferences exist that allow you to control the default behavior of the Query By Example
functionality (e.g. case sensitivity). Chapter 20.20 describes these preferences.
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7.4  Linked Queries

When viewing a result set, you often want to query a related table. For example, when viewing the dept
table, you may want to query all employees of a department, Or vice versa: when viewing the emp table,
you may want to query an employee’s department.

Most of the time you will have foreign key constraints between these parent and child tables, in which
case the SQL Window can automatically generate and execute these queries for you. If you are located
on a specific record in the result set, press the Linked Query button on the grid toolbar. This will display
a popup menu with all parent and child tables of the table of the current select statement. If, for
example, you were querying the emp table, the following popup menu might appear:

‘.,@«:.;

@ dept (emp_dept_fl) |DEPTNOJ
7788 12-01 et e a1 20
7698 20-02 n

emp (eme-ngrt)
7839 09-06-2087 = Z450,00 0

The top section displays the parent tables (and the foreign key names), and the bottom section displays
the child tables. The dept item will generate a query for this employee’s department (30). The first
(parent) emp item will generate a query for this employee’s manager (7839). The second (child) emp
item, will generate a query for all employees that are managed by this employee.

The linked query will be executed in the same SQL Window, unless you enable the SQL Window
preference Linked Query in New Window (see chapter 20.20). If you hold down the Ctrl key while
pressing the Linked Query button, the opposite of this preference will occur.

7.5  Substitution variables

You can use substitution variables in your SQL text to allow user input when the query is executed. The
most simple form of an substitution variable is similar to the way you may be used to from SQL*Plus:

LTEY
SOl | Duput | Statistios |
select * from emp i
where deptno=&deptno &
order by enaue =alx|
|Name |\/a\ue ‘
| deptno| 20 -
It
H- 8 |
EMPNO _[ENAME _[J( EPTNO
LN 7876 ADAMS 20
| 2| 7902 FORD Al 20
3] 7566 JOMES M Caneel Clear I 20
WE 7788 SCOTT Al 20
| 5] 7369 SMTH v 20
= [213 [Initializing 4

By specifying &deptno in the SQL text, you will be prompted for a value for this variable. The variable
reference in the SQL text will be substituted by this value before execution. You can specify more than
one substitution variable, and you can specify a single substitution variable more than once.
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Furthermore you can define the data type, default value, selection lists, list queries, checkboxes, and
other advanced options. These features are also used in the Report Window, and are described in detail
in chapter 12.

7.6  Updating the database

To update, insert or delete records in the database, you can execute the appropriate DML statements in a
SQL Window. It is probably much more convenient to make a result grid updateable by including the
rowid in the select list or use a select ... for update statement:

** SQL Window - select emp.*, rowid from emp order by ena ol x|
SaL |Dutput| Stat\slicsl
select emp.*, rowid from emp Bis
order by =name e
H-la+-v%s @ £ 3| & w-
EMFNO_[EMAME [J0OB _ [MGR_[HIREDATE [3AL [COMM _[DEPTMO [«
T 7076 ADAMS | CLERK 7788 23-05-1987 = 1100.00 20
|| 2] 7499 ALLEN SALESMAN 7698 20-02-19681 = 1600.00 300,00 30
LF| 3| 7698 BLAKE RAN]| 7839 01-05-1981 = 2850.00 30
I 4] 7782 CLARK MANAGER 7839 09-06-1981 = 2450.00 10
| 15| 7902 FORD AMNALYST 7hEE 03-12-1881 = 3000.00 20
| | B 7900 JAMES | CLERK 7698 03-12-1981 = 950,00 30
7 TEGE JOMES | MANAGER 7839 02-04-1981 = 297500 20
| | 8] 7839 KING PRESIDENT 17-11-1981 = 5000.00 10
9] 7E54 MARTIN | SALESMAN | 7698 26-09-1981 = 1250.00  1400.00 0.
| | »
= o ‘2.15 ||Db, varchar2(3), optional. default = 'CLERK', The job of the mployes v

You should be aware that a select ... for update statement will lock all selected records, so including the
rowid might generally be the best way to make a result grid updateable. If the select statement is a join,
columns of the first table can be updated. All other columns will be read-only. Columns that are given
an alias cannot be updated either.

If the result grid is updateable, you can press the Edit data button at the right side of the result grid and
edit the records. You can insert or delete records on the grid by pressing the Insert record or Delete
record button. If you have selected multiple records, all selected records will be deleted.

When editing character or number fields, the text color will go red if you enter data beyond the size,
precision, or scale of the underlying column.

After editing a column value that appears in a virtual column expression, the corresponding virtual
column value will be updated as well.

Modifying the result grid does not actually change anything in the database. To post the updated,
inserted or deleted records to the database press the Post changes button. Any column value changes
that are performed by server-side logic (by before insert or update triggers or default values for an insert
statement) will immediately be reflected in the result grid as well.

After posting (if you have the AutoCommit SQL Window option disabled) the Commit and Rollback
button on the toolbar will be enabled if a transaction has been started. For more information about
transactions, see chapter 17.
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Editing large data columns

As explained in the previous chapter, you can click on the cell button of a Long, Long Raw, CLOB,
BLOB and BFILE columns to view the value in various formats. When the result grid is updateable,
you can use the Large Data Editor to change a column value.

7.7 Viewing and editing XMLTYPE columns

The SYS.XMLTYPE type is not supported by Oracle Net 9.0 and earlier, so you will not be able to
directly access the XML data that is stored inside such a column. If, for example, xml_text is a
SYS.XMLTYPE column, then the following query will not provide the expected result:

select id, xml_text from xml_table

Only the id column will show up in the result set. To view the XML data, use the getclobval() member
function:

select id, t.xml_text.getclobval() from xml_table t

This way the CLOB can be viewed in the Text Editor, and XML syntax highlighting will automatically
be applied. To edit the XML data, make the result set updateable as usual by including the rowid:

select id, t.xml_text.getclobval(), rowid from xml_table t

Now you can edit the CLOB and post the modified data to the database. Note that the View Data and
Edit Data functions for tables and views will automatically apply these rules, so the easiest way to view
or edit XMLTYPE columns is to right-click on the table or view, and selecting the corresponding items
from the popup menu.

7.8  Direct Query Export

For queries with large result sets (ten thousands of records or more) it may be inconvenient to first
query the data into the result grid, to subsequently export it to a file. This may take a long time and a lot
of memory resources. In this case it is much more efficient to directly write the result set into an export
file. To do so, you can press the Export Query Results... button on the result set toolbar, instead of the
Execute button on the main toolbar. This will display a popup menu where you can choose to export the
data in CSV format (Comma Separated Values), TSV format (Tab Separated Values), HTML format, or
XML format. After selecting the format, you can specify the export file, after which the query will be
executed. The result set will not be displayed in this situation, but will only be written to the export file.

7.9  Saving SQL Scripts

If you have created a SQL statement that you wish to re-execute later, you can save it to a SQL Script.
To do so, press the Save button on the toolbar and enter an appropriate filename in the save dialog. The
default extension for a SQL Script is .sql, though you can change the default extension with a
preference described in chapter 20.28. Note that only the current SQL statement is saved to the file, not
the entire history of statements. To include the history in the saved file, right-click on the SQL Window
and select the Save with history item. All statements will be separated with a slash in that case.

You can open a previously saved SQL Script by pressing the Open button on the toolbar and selecting
SQL Script, which will create a new SQL Window. You can alternatively right-click on a previously
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created SQL Window and select the Load item, which will open a SQL Script in the existing SQL
Window.

7.10 Creating Standard Queries

For most tables and views you will have various standard queries that you frequently need to run. For
example: “show all employees that are managers”, or “show the sum of the salary of all employees,
ordered by department number”. You can save such a query as a so called “Standard Query”, which can
easily be invoked later from the popup menu for the corresponding table or view. This popup menu will
appear when right-clicking on the table or view in the Object Browser or in a PL/SQL or SQL source.

After creating a standard query in the SQL Window, you can press the Save as Standard Query button
on the toolbar of the result grid. The following dialog will appear:

*7 QL Window - select * from el —lo| x|
SaL |Dutput| Stat\slicsl
select * from emp Bis
where job = 'MANAGER' -
order by deptno
Standard Query x|
Query narme
iy
Eﬂ‘ M | & | IManagars
EMPNO _[EMAME " TJOB gt e DEFTNO
LN 7782 CLARK | bAAN, [scotT 10
2] 7665 JONES (MAN, - 20
3 7693 BLAKE  |Man, DObiectname 30
— [EmP
Ok I Cancel Preferences..
- 318 |3 rows selected in 0,016 secands v

You can enter the name of the query, which will be displayed in the popup menu. You can also change
the owner and name of the table or view for which the standard query will be displayed. Press the
Preferences button to change the directory where the standard queries will be stored.

The following information will be saved with the standard query:
. The SQL text

. The size of the SQL Window

e The grid mode: multi record or single record view

Note that you can use substitution variables (see chapter 7.5) to make the standard queries more
flexible.
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8. The Command Window

The Command Window allows you to execute SQL scripts in a way that is very much similar to
Oracle's SQL*Plus. To create a Command Window press the New button on the toolbar or select the
New item in the File menu. A Command Window is created and you can type SQL and SQL*Plus
commands like you are used to, without leaving PL/SQL Developer’s IDE:

* command Window - New — ol x|

Dialeg | Editor |

SQL> select * from emp ;I
2 where deptno = 20

3 order by ename;

EMENC ENAME JCB 2 HIREDATE SEL COMM DEETNO
7878 ADRMS CLERE 7788 1Z-01-1383 1100,00 20
7302 FORD ANALYST 7566 03-12-1381 3000,00 20
7588 JONES MANAGER 7833 0Z-04-1381 £375,00 20
7788 SCOTT ANALYST 7566 09-12-1382 3000,00 20
7363 SMITH CLERE 7902 17-12-1380 800,00 20

SQL> exec dbms_cutput.put_line (employee.deptname (787€) )
RESEARCH

BL/SQL procedure successfully completed

SQL> desc dep
Object dep does not exist

SQL> desc dept
Name Iype Nullable Default Comments

DEEFTNC NUMBE

{z) The Z-digit identification number of the department

DNAME VARCHARZ (14) ¥ The name of the department
LOC  VARCHARZ (13) ¥ The locaticn of the department
spL> | d

= ECH |TRM |FDB |VEF |APR [HDG |THG |0 » |F'L.-"SQL procedure successfully completed in O seconds

&

8.1  Entering SQL statements and commands

Just like in SQL*Plus, you can type SQL statements across multiple lines, and end a statement with a
semi-colon or slash. You can use the cursor left and right keys to edit the command line, and use the
cursor up and down keys to recall previously entered lines

By entering the edit command, you can use a simple text editor to edit the entire input buffer. After
editing the buffer, you can execute it by entering a slash on the command line. The editor has a history
buffer with all previously executed commands, so that you can quickly execute a modified command.

The status line of the Command Window shows the status of the Echo, Termout, Feedback, Verify,
Autoprint, Heading and Timing options. You can additionally double-click on such an option to change
it between on and off.
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8.2  Developing command files

To develop a command file with multiple SQL statements and commands, you often need to edit the
file, runit, edit it again, run it again, and so on. To make this a comfortable process, the Command
Window has a built-in editor with SQL, PL/SQL and SQL*Plus syntax highlighting:

* command Window - demobid.sql =1olx|
Dialog  Editor |

SET TERMDUT ON
FROMPT Building demonstration tables. Plezse wait.
SET TERMOUT OFF

- Drop old tables
OROP TAEBLE EME;
DOROP TAELE LDEET;
OROP TAELE BCNUS;
OROP TABLE SALERRDE;

- Create new tables

CREATE TABLE EMP
(EMENO NUMBER (4) NOT NULL,
ENREME VARCHARZ2(10),
JCB VARCHARZ (3),

MER NUMBER (4), d
= ECH [TRM [FDE [VEF [APR [HDG [THG [0 > | 7

Opening, Executing, and Saving a command file

To create a command file, switch to the Editor page and enter the commands. To execute the commands
in the editor, simply press the Execute button on the toolbar, or press F8. The Command Window will
switch back to the Dialog page and will execute all commands.

To edit an existing command file, press the Open button on the toolbar and select the Command File
item. This will load the command file into the editor of a new Command Window. You can
alternatively right-click in the editor and select the Load item from the popup menu. To save a modified
Command File, press the Save button on the toolbar.

Stepping through a command file

If you press the Pause Execution button on the status line before or during execution, you can single-
step though the script in a controlled manner. The next command will be highlighted in the Editor, and
will be executed when you press the Execute Next Command button on the status line. If you press the
Pause Execution button again, execution will continue normally after the next step. You can force such
a pause from within a script by using the SET EXECPAUSE command.
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8.3  Supported commands

Besides all SQL statements, the command window supports the following standard SQL*PLus

commands in this release:

Command Meaning
/ Executes the SQL buffer
? [Keyword] Provides SQL help on the keyword

@[@] [Filename] [Parameter list]

Runs the specified command file, passing the specified
parameters

ACC[EPT] Variable [DEF[AULT] Value]
[PROMPT Text | NOPR[OMPT]]

Allows the user to enter the value of a substitution variable

CL[EAR] [SCR[EENT]

Clears the screen

CL[EAR] SQL

Clears the SQL buffer

COL[UMN] [Column] [Format] [NEW_VALUE
Variable]

Defines the format of a column, displays the format of a
column, or displays all column formats

CON[NECT] [username/password@ database]

Connects to the database with the speciffied user

DEF[INE] [Variable] [ = Text]

Defines a substitution variable, displays a variable, or
displays all substitution variables.

DESC[RIBE] Object

Gives a description of the specified object

DISC[CONNECT]

Disconnects from the database

EDIT

Displays a text editor to edit the SQL buffer

EXEC[UTE] Procedure

Executes the specified procedure

EXIT [APPLICATION]

Quits a running script or closes the Command Window.
Adding the APPLICATION parameter will also close
PL/SQL Developer.

GET [Filename]

Loads a command file into the editor

HOST [Command]

Executes the host command

HELP [Keyword]

Provides SQL help on the keyword

PAUSE [Message]

Displays the message and pauses until the user presses Okay
or Cancel

PRI[NT] [Variable]

Displays the value of the bind variable, or all bind variables

PROMPT [Text]

Displays the specified text

QUIT [APPLICATION]

Quits a running script or closes the Command Window.
Adding the APPLICATION parameter will also close
PL/SQL Developer.

R[UN]

Executes the SQL buffer

REM[ARK] [Text]

A comment line

SET AUTOP[RINT] [ON | OFF]

Determines if bind variables are automatically displayed
after executing a SQL statement or PL/SQL block.

SET COLSEP [Separator | OFF]

Determines the column separator (default = “”).

SET CON[CAT] [Character | ON | OFF]

Determines the character that terminates a substitution
variable reference (default = .)

SET DEF[INE] [Character | ON | OFF]

Determines the character that starts a substitution variable
reference (default = &)

SET ECHO [ON | OFF]

Determines if executed commands in a script are displayed

SET ESC[APE] [Character | ON | OFF]

Determines the character that escapes the character that
starts a substitution variable reference (default =\)

SET FEED[BACK] [ON | OFF]

Determines if the number of affected rows of a SQL
statement is displayed

SET HEA[DING] [ON | OFF]

Determines if headings are displayed above the columns of
a result set

SET LONG [Width]

Determines the maximum display width of a long column

SET NUM[WIDTH] [Width]

Determines the maximum display width of a number
column without precision

SET PAGES[IZE] [Size]

Determines the number of lines that are displayed for a
result set, before the headings are repeated

SET PROMPT [Prompt]

Replace the standard SQL> prompt. Instead of a literal text




PL/SQL Developer 9.0 User’s Guide

49

Command

Meaning

you can also use the variables [user], [db], or [connection].
Furthermore you can include a bind variable (set prompt
:bind_var_name).

SET SCAN [ON | OFF]

Determines if substitution variables should be scanned

SET SERVEROUT[PUT] [ON | OFF] [SIZE n]

Determines if output of calls to dbms_output.put_line is
displayed, and what the size of the output buffer is. The
value “n” can be “UNLIMITED” for unlimited output size.

SET SPOOL*DIRECTORY [Directory]

Determines in which directory spool files are stored if the
SPOOL command does not specify an absolute path.

SET TERM[OUT] [ON | OFF]

Determines if output of executed SQL statements is
displayed

SET TIMI[NG] [ON | OFF]

Determines if timing information about executed SQL
statements is displayed

SET VER[IFY] [ON | OFF]

Determines if substitution variables are displayed when used
in a SQL statement or PL/SQL block

SHO[W] ERR[ORS] [Type Name]

Displays errors for the previous compilation, or for the
specified object

SHO[W] REL[EASE]

Displays Oracle release information for the current
connection

SHO[W] SQLCODE

Displays the result code of the executed SQL statement

SHO[W] USER

Displays the username of the current connection

SPO[OL] [Filename [APPEND]] | OFF | OUT]

Starts or stops spooling and optionally print (OUT). If
Filename has a .zip extension, the spool file will be zipped.

STA[RT] [Filename] [Parameter list]

Runs the specified command file, passing the specified
parameters

STORE SET [Filename]

Stores the values of all options in the filename. You can
execute this file later to restore these options.

UNDEF[INE] Variable

Undefines the given substitution variable

VAR[IABLE] [Variable] [Datatype]

Defines a bind variable, displays a bind variable, or displays
all bind variables.

WHENEVER [OSERROR | SQLERROR] [Action]

Specify an action whenever an OS error or SQL error
occurs. The action can either be EXIT or CONTINUE,
optionally followed by COMMIT or ROLLBACK.

All of these commands function the same as in SQL*Plus. The following commands are specific to

PL/SQL Developer:

Command

Meaning

BEAUT[IFY] File | Object

Beautifies the specified file or database object, using the
current rules or the rules specified with the SET
BEAUTIFIERRULES command.

BROWSE Object

Select the Object in the Object Browser

EDIT Object

Opens an editable window with the object’s definition

EDITD[ATA] Table | View

Opens a SQL Window for the table or view with an editable
result set

EXPORT[DATA] Table

Opens the Export Tool for the specified table

INFO

Displays information about the connection

PROP[ERTIES] Object

Displays a Property Window for the specified object

QUERY[DATA] Table | View

Opens a SQL Window for the table or view with a read-only
result set

REC[OMPILE] Object

Recompiles the object

RUNTEST[SET] TestSetFile [LogFile]

Runs the specified Test Set File in the Test Manager and
logs the result in the Log File.

SET BEAUT[IFIERRULES] [File]

Temporarily use the beautifier rules from the specified file.
This can be used with the BEAUTIFY command.

SET COL[WIDTH] [Width]

Determines the maximum column width in a result set. If
Width = 0, the width is unlimited. The default is 80.

SET EXEC[PAUSE] [ON | OFF]

Pauses execution at the next command (ON), or continues
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normally with the next command (OFF).

SHOW CONNI[ECTION]

Shows information about all PL/SQL Developer
connections.

SQLPLUS

Invokes SQL*Plus with the current file.

TEST ProgramUnit

Opens a Test Window with a standard Test Script for the
specified program unit

VIEW Object

Opens a read-only window with the object’s definition

ZIP Archive [File | Directory]

Adds the given file or directory to the zip archive. If the file
or directory parameter is omitted, the contents of the zip
archive are displayed.
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9. Creating and modifying non-PL/SQL objects

During PL/SQL development you may find that you often need to create a table, modify a constraint or
index, reset a sequence, and so on. PL/SQL Developer has several functions that allow you to create and
modify tables (and related elements), sequences, synonyms, libraries, directories, users, and roles. This
chapter does not explain the functionality of these objects, but merely explains how you can create,
modify and view their properties. For more information about the each object’s functionality, see the
Oracle documentation like the “SQL Reference Guide™.

To create an object, you can either press the New button on the toolbar and select the corresponding
object type, or select the New item in the File menu. You can also right-click on the root folder of the
object type in the Object Browser and select the New item from the popup menu.

To modify an object, select it in the Object Browser, right-click on it, and select the Edit item from the
popup menu. You cannot change the name of an object like this, but must explicitly use the Rename
function from the Object Browser to accomplish this (if the object type supports it). If you just want to
view the object, select the View item from the popup menu.

You can additionally duplicate an object by selecting the Duplicate item in the popup menu of the
Object Browser. The object’s editor window will appear with all properties filled in, except for the
owner (if applicable) and name. This way you can quickly create a similar object to explore an
alternative, perform some risky or destructive test, or whatever.

9.1  The table definition editor

The table definition editor has 7 tab pages for various aspects of a table:

General | Colurans | 0 Keys | o Checksl of Indexesl 11 Frivileges | B Partmonsl

OWnerIBCOTF LI [* Recreate takle
“arning: this will delete all data,
NameIEMP triggers. and foreign key references
[ Storage
Tahlespace IUSERS - Initial Extent|64 KB hd
%Fres IWU MNext Extent Bytes -
%Usedl #lncrease
Ini Trans IT Min Extents |1
Max Trans |255 Max Extents ¥ Unlimited
Cluster
MName = Cn\umnsl J
~Duration Organization
|— Temparary l_ FPreserve rows on commit ’7 |7 Heap l_ Indexc l_ External
CDmpressmnINo compressian j ¥ Logging [~ Rowdependencies
Cummemsl J

Apply | Befrash | Close | Help | Query. | Wi SOL |

| T scott@ol111 I 4

At the bottom of the editor, you see the following 6 buttons:
e Apply — Will apply all modifications you have made in the editor to the database.
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. Refresh — Retrieves the definition from the database again, discarding any changes you may have
made.

. Close — Closes the editor window.
. Help — Shows the online help.
. Query - Invokes a SQL Window with a query that allows you to view and edit the table data.

. View SQL - Displays a text editor with the SQL statements that have resulted from the changes
made in the editor. If you have not yet made any changes, it will show the complete creation SQL.

The following chapters will describe the different pages of the table definition editor.

General page

The General page is displayed in the previous chapter, and contains the table owner and name, storage
information, cluster information, and comments. For a new table you can leave all properties empty,
except for the name. All other properties will get a default value:

. Owner — the current user that is logged on.

. Tablespace — the default tablespace for the current user.
. %Free—10

. %Used - 40

. Initial transaction entries — 1

. Maximum transaction entries — 255

The default values of the segment properties (initial extent, next extent, %increase, minimum extents
and maximum extents) depend on the corresponding defaults of the tablespace.

The cluster information, storage information, and duration properties are mutually exclusive, because
the cluster implicitly defines the storage characteristics of the table, and temporary tables cannot be
clustered and also have implicit storage characteristics.

If you select External as the organization of the table, storage properties will be disabled, and a new
External tab page will become visible where you can define the external directory and file information.

If you enter or select a cluster name, the storage properties and duration properties will become read-
only, and the cluster columns can be entered. Clearing the cluster name has the opposite effect.

If you define the table as temporary, the cluster and storage information will become read-only, and you
can define if rows are preserved after a commit.

If you define an index organization table, you must define a primary key. For a heap organized table
(the default) this is not a requirement.

If you are modifying an existing table, not all properties can be changed. The tablespace, initial extent,
minimum extents, cluster information, duration properties and organization properties cannot be
changed for a table that already exists in the database. If you want to change any of these properties,
you need to check the Recreate table option at the top of the window. As a result, the table will first be
dropped and recreated with the new definition. All data, triggers, and foreign key references will be lost,
so you should be careful when using this option!
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Columns page

On the Columns page you can view, add, delete, move, and modify the table’s columns. If you are
creating an object table, you can also select the object type on this page:

1 General 0 Columns | =6 Keys | = Checks | # Indexes | 4 Privileges | BB Parttions |
Type ownarl LI Namel LI
Name |Virtua|‘Type |Nu||able‘Defau|thxpr. ‘Storage Cc +
| |EMPNO ~ | NUMBER(4) - r The 4-digit number of the employee
| |ENAME " VARCHAR2(10) ~ =3 The last name of the employee
| |[JoB I VARCHAR2(9) *| ¥ |'CLERK' . The job of the employee
| IMGR " |NUMBER(4) - ~ The employee number of the manager
| |HIREDATE| I DATE T F  trunc(sysdate) . The date on which the employee was hired
| |SAL © NUMBER(72) = W The salary of the employee
| |COMM T NUMBER(7.2) -~ =3 The commission of the employee
| |DEPTNO I~ NUMBER(2) TR The 2-digit number of the department
| » EMAIL ~ F ename || ‘@acme.com’ The e-mail address of the employee
* 4 - 4

Apply | Befresh | Close | Help | Query. | iew SOL

|+ scot@al1t [ Y

To add a column you can press the Insert column button, or you can start typing the new column
information on the last row (which will create a new, empty last row). The Type column has a
suggestion list for most common data types, but you can also use other data types here. The Default
column requires that you enter a value in the appropriate format, e.g. string values must be quoted.

To delete a column, press the Delete column button. This will either delete the column that currently has
the focus, or it will delete all selected columns. You can select one or more columns by clicking on the
row heading. Dragging the mouse will select a range of rows. Pressing the Control key while clicking
on a row heading allows you to select multiple individual rows.

To move one or more columns, select them as described in the previous paragraph. Now you can click
on one of the selected headings and move the selection to the desired location.

For a virtual column (the email column in the example above) you can enter its expression in the
Default/Expr field. For real columns this field contains the default value.

For existing tables you cannot change the name of existing columns, unless you are using Oracle9.2 or
later. You cannot delete such a column either, unless you are using Oracle8i or later. To overcome these
limitations, you need to check the Recreate table option on the General page. The consequences of this
option are described in the previous chapter.

Note that changing the name of a column will automatically be propagated to the constraint columns,
index columns, and cluster columns.

If you select the type owner and type name at the top of this tab page, you will create an object table,
based on this object type. The column names and types are now defined by and restricted to the top-
level attributes of the object type. You can still define if a column is nullable, the default value, its
storage, and a comment. If you want to change the object type later, you must select the Recreate table
option on the General page.
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Keys page

On the Keys page you can view, add, delete, and modify the table’s primary, unique and foreign key
constraints:

* Edit table EMP i - ol x|
E] General | Columns &4 Keys |vaJ Checks | L] \ndexesl ¥¥ Privileges | BE Pamtinns'
Name [Type  [Columns  |Enabled| Referencing table|Referencing columns[On Delete [Deferrable|Deferred] 4
[v|EMP_PK. Frimary = EMPNO [ [ | £ r
| |EMP_DEFT_FK Foreign ™ DEPTNO = 2 DEPT = |DEFTNO ™ |Mo action = r r -
B . v - - T ® | ®
K — i
Apply | Befresh | Close | Help | Query. | Wiew SOL

This grid can be manipulated in the same way as the column grid in the previous chapter. You can add,
delete and modify the key constraints. Moving the constraints will not have any effect, as they are not
really ordered.

Note that the storage information of the underlying index that is used to enforce a primary or unique key
constraint is not defined on this page. If the constraint is enabled, there will automatically be a
corresponding index on the Indexes page with the same name. For this index you can define the storage
definition. Disabling or deleting a primary or unique key constraint will implicitly delete the underlying
index.

The Type column has a list that allows you to select just the Primary, Unique or Foreign key type. You
can quickly select the correct type by typing the first character (P, U or F). Note that a table can only
have one primary key constraint, and the default value for this column (Primary or Unique) depends on
this. Changing the type will affect the Referencing table, Referencing columns and Cascade columns, as
they are only valid for foreign key constraints. Changing the type to Foreign will also implicitly delete
the index.
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To define the Columns to which the constraint applies, you can simply type the column names in the
appropriate cell (separated by commas), or press the cell button. This will invoke a column selection
screen where you can easily add, remove or move (reorder) the key columns:

Select key columns il
All columns Key columns

ename
job

mEr
3>
sal

COmm
deptno

ampna

€«

EN RSN

0K | Cancel |

For foreign key constraints you can type or select a Referencing table. Doing so will automatically
select default Referencing columns, based on the primary and unique key constraints of this table. The
selection list for this column shows all column sets that make up primary or unique key constraints for
the referencing table, and are therefore the only candidates here. In the On Delete listbox you can define
what action should be performed for the records in the child table when the parent record is deleted. The
Set null action is supported in Oracle8i and later.

If you are using Oracle8, you can additionally define if the constraint is deferrable, and if it is initially

deferred. These 2 options are obviously related: you cannot have a non-deferrable constraint that is
initially deferred.
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Checks page
On the Checks page you can view, add, delete, and modify the table’s check constraints:
# Edit table EMP _ ol x|
Generall CDIumns' Wi Keys 1 Checks |n‘|§§ Indexesl 1§ Privileges I B Partitions'
Name | Candition |Enabled| Deferrable| Deferred|Last change &+
| b EMP_COMM_CK1 comm >=0 I r [m] 5-6-2004 17:05:03
| |EMP_MGR_CK1  mor<>empro [ r [T |5-6-200417.05:03 =
| |EMP_SAL CK1 sal>=0 Iv! r | 5-6-2004 17.05:03
Ea 13 i 1
Al Befresh Close Help Queny.. YWiewy SQL

This grid can be manipulated in the same way as the column grid. You can add, delete and modify the
check constraints.

The Condition column should contain the boolean expression that must be true (or null) for all rows in
the table. You cannot apply a check constraint if one or more rows violate the condition, unless you also
uncheck the Enable option. The check constraint can be enabled after correcting the violating rows.

If you are using Oracle8 or later, you can additionally define if the constraint is deferrable, and if it is
initially deferred. These 2 options are obviously related: you cannot have a non-deferrable constraint
that is initially deferred.
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Indexes page
On the Indexes page you can view, add, delete, and modify the table’s indexes:

[Z] Genersl | €3 Columns | & Keys | 5@ Checks # Indexes |ii Privileges |

Owner ‘Name |Type ‘Columns |Compress‘Prefix Iength‘Reverse‘Local‘Storage | +
|/ SCOTT ~ EMP_DEPT_IDX Normal ™ DEPTNO [ - " tablespace users pctfree 10~ _
SCOTT = EMP_MGR_IDX |Normal ™ MGR r C I” tablespace users pctfree 10
| [SCOTT |EMP_PK |Unique [EMPNO | r " tablespace users pctfree 10
el - - i 4 o4 4 :

Al | Befresh | Cloze | Help | Querny. | MWiew SOL

" scoft@ol11 v

This grid can be manipulated in the same way as the column grid. You can add, delete and modify the
indexes.

The Owner of the index can be left empty, the default owner is the user that is currently logged on. If
you want to use a different owner for the index, just select it from the list.

The Type of the index can be Normal, Unique, or Bitmap. The last index type is only available on
Oracle7.3 Servers and later. Note that you can only create a unique index if the index columns of each
row in the database are indeed unique. As long as this is not the case, you cannot apply this index to the
database.

To define the Columns that you want the table to be indexed by, you can simply type the column names
in the appropriate cell (separated by commas), or press the cell button. This will invoke a column
selection screen where you can easily add, remove or order the index columns.

For function based indexes you can specify the functions, separated by commas. For descending
indexes, you can follow the column name by DESC.

You can additionally enable key compression for the index, including the number of prefix columns to
compress, and define the index as a reverse index.

If the index is for a primary or unique key then the owner, name, type, and columns cannot be modified.
These properties are all derived from the key constraint. Changing the name of the key constraint will
automatically change the name of the corresponding index, changing the constraint columns will change
the corresponding columns for the index. The owner will always be the same as the owner of the table,
and the type of the index will always be unique.
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The Storage parameters can be defined or viewed by pressing the cell button. This will invoke a storage
editor:

Storage parameters

Tablespace lm Iritial Extentlm— lﬂ
ZFreelw— Mext Extentlw— Iﬂ
#lsed I— Zlncrease I5U—
|2— Min E stents |1—
Max Trang |255— Max Eutents |121— I Unlimited

Ini Trans

0k | LCancel | Help |

For new indexes you do not need to enter any of this information, as each property has a default value:

Tablespace — the default tablespace for the current user.
%Free—10
Initial transaction entries — 2

Maximum transaction entries — 255

The default values of the segment properties (initial extent, next extent, %increase, minimum extents
and maximum extents) depend on the corresponding defaults of the tablespace. The %Used property
does not apply to indexes.

Note that if you modify the %free, initial extent, and minimum extents properties of an existing index,
this will implicate that the index (and constraint) will be dropped and recreated to apply this change. For
large indexes, this may be time consuming.
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Privileges page

On the Privileges page you can grant/revoke privileges on the table to/from users and roles:

%% Edit table EMP : o =1
=1 General I Columns' 4l Keysl &1 Checks | & Indexes EE Frivieges |

Grantee ‘Seled ‘\nsen ‘Updale‘De\etE|References‘AHEr ‘Index | +
| |DEMO_SELECT = “es = = = = = = =
| |DEMO_UPDATE = *ves T Yes T Yes T Yes T - - - -
| [KING ~ Grantable ™ Yes ™ Yes = Yes ™ Yes = |Yes ¥ Yes =
|| FUBLIC = |Yes = = = = = = =
|+ - - - - - - - -

Apply Befresh Close Helg Query... Yiew SCIL

This grid can be manipulated in the same way as the column grid. You can add, delete and modify a
grantee. Deleting a grantee is equivalent to revoking all individual privileges.

The Grantee is the user or role to which you want to grant certain privileges. Note that privileges
granted to a role will often not suffice for the purpose of development of stored program units. If a user
is granted select privilege on a table through a role, and references this table in a stored program unit,
compilation will fail because the table is unknown. The user must personally be granted select privilege
if the object is to be used in a program unit that he or she owns.

The individual privilege columns can have 3 values:

. (Blank) — The grantee does not have the privilege

. Yes — The grantee has the privilege

. Grantable — The grantee has the privilege, and can grant it to other users or roles

The Select, Insert, Update and Delete privileges allow the grantee to perform this action on the records
of the table. The References privilege allows the grantee to create a foreign key to this table. The Alter
privilege allows the grantee to alter the table definition with the alter table command. The Index
privilege allows the grantee to create an index on the table.
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Partitions page

The Partitions page is only visible when you (re)create a table, or when you edit an existing partitioned
table:

Edit table EMP _ o] x|
Generall CDIumnsl {==4] Keysl {==4] Checksl nﬁ Indexes | 9§ Privileges @ Partitions |
TypelRange LI Colurnhs Iempnn J

Narme [values less than [Starage | +
| LT_2000 2000 tahlespace emp_ts_1 storage [ initial bk
| |LT_4000 4000 tablespace emp_ts_? storage (initial B4k =
| |LT_8000 BO0O tablespace emp_ts_3 storage (initial B4k
| |LT 8000 §000 tablespace emp_ts_4 storage (initial B4k
|| LT_MaxvalUE Mo ALUE tablespace emp_ts_5 storage (initial B4k
el

Applhy Befresh Close Help | Queny.. | YWiewy SQL

At the top of the page you can select Range, Hash, or List partitioning, as well as the partition columns.
In the grid you can define the name, column values (if applicable), and storage of each partition. If you
have defined more than one partition column, you must separate the values by a comma.

For Range partitions you can additionally define subpartitions on an additional Subpartitions tab page.
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External page

If the organization of the table is defined as External on the general page, this tab page will become
visible:

¥ Edit table DEP1_EX1ERNAL [l

Genelall (| Cdumnsl §9 Frivieges EE Extemal |

Tupe|ORACLE_LOADER

Default diectorylEHT_DIH

RECORDS DELIMITED BY newline

BADFILE 'dept.bad

DISCARDFILE ‘dept.dis'

LOGFILE 'dept.log'

ficoegs parameters|SKIP 200

FIELD'S TERMIMATED BY ", OPTIOMALLY EMCLOSED BY ™

(
LI »

I Y

Directary  |Specifier |+
) p|EXT_DIR = deptctl
Locations || = -
al
Aeject I'mitl ¥ Unlirited
Project column IAII - I
Apply Fefresh Cloze I Help | Hueny... | Miew SOL

Here you can set the access driver type and the external data properties that define the external table.



62 PL/SQL Developer 9.0 User’s Guide

Viewing and modifying the SQL

After creating a table, or after modifying an existing table, you can view the resulting SQL by pressing
the View SQL button. After adding a comment to the table and modifying the ename and job columns
from optional to mandatory, the resulting SQL would look like this:

=19 x|

X

alter table EMP modify ENAME not nmll;
alter table EMF modify JOB not nmll;
—— Add comments to the table

comment on table EME
i 'An employee, working in a department';

[ & 6o

o e L Ry

Apply | Fefresh | Close | Help | Luery... | I Wiew SOL

You can save the SQL to a file, copy it to the clipboard, or open it in a Command Window with the
corresponding buttons at the upper right corner of the window. The Print button on the toolbar will print
the SQL. You can additionally make changes to the SQL and apply the changed SQL. After applying
the changed SQL, the window will return to form mode and will refresh the table definition. Changes
made to the SQL will immediately be reflected in the forms.

If you press the View SQL button again, the window will return to form mode, discarding any unapplied
changes you may have made to the SQL.

If you selected the View option in the Object Browser to view the table definition, the View SQL button
will display the creation SQL for the table, without preceding it with a drop command. This way you
can save a table definition in a file, or copy its definition to another database or user.
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9.2  The sequence definition editor

The sequence editor allows you to easily create or modify a sequence:

: Edit sequence EMPNO_SEQ _ (O] x|
OwnerISCOTF MNesct number|?954
NﬁmeIEMPNO_SEQ Increment by|1
in value I‘I Cache size |1 0
Maxvaluelﬂﬂﬂﬂ I” Cycle [~ Order
gy | Fefresh | Close | Wiew S0L

Most properties have a default value, and you only need to supply a name when creating a new
sequence:

Owner — The user that is currently logged on
Minimum value — 1

Maximum value — Unlimited

Initial value — 1

Increment by — 1

Cache size — 20

Cycle - Off

Order — Off

9.3  The synonym definition editor

The synonym editor allows you to easily create or modify a synonym:

i Edit synonym DEMO_EMP =13
Synonyrm Translation
Ouwner [SCOTT Ohbject owner [DEMO =]
= | Pubilic Object nameIEMP LI
Name IDEMO?EMP Datahase Imkl LI
Apply | Fefresh | Close | View SQL |

The default value for the Owner will be the user that is currently logged on. Checking the Public option
will create a public synonym, and will make the Owner field read-only. The Object owner and Object
name fields have a suggestion list to easily select a translation object for the synonym. If the Object
owner field is empty, the Object name list will display all objects.
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9.4  The library definition editor
The library editor allows you to easily create or modify a library:

: Edit library USER32 9 [=] 3

OWnerISYS

Name [USER32

F\IespecIC:\W\NDOWS\SVSTEMSE\userSE.dII BI

Apply | Refreshl Close | Wiew S0L

The default value for the Owner will be the user that is currently logged on, and you can use the
suggestion list to create a library with a different owner. The Filespec is the full file specification of the
3GL library that you want to use. If you are developing on the database server, then you can use the
Select DLL file button to select the dynamic link library. Otherwise you have to type the name of the
DLL (Windows) or shared object (UNIX). The validity of the Filespec is not checked.

9.5  The directory definition editor

The directory editor allows you to easily create or modify a directory, which can subsequently be used
for BFILE’s:

| Edit directory TEMP 9 [=] 3
Name |TEMF>
Path |c:\temp\ =)

Apply | Refreshl Cloge | Wiew SOL

If you are developing on the database server, then you can use the Select directory button to select the
directory path. The validity of the directory path is not checked.
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9.6  The job definition editor

The job editor allows you to create or modify a job:

2 Editjob 21 _ ol x|
Submitter [SCOTT Frivuser[SCOTT
JUbI?W Schema userISCO'I_I'
‘What |begin Lastdatel
clear_transaction_log;
end: This diete |

Total time (sec) |0
Mext dateIEE*B*ZUUZ Failures |0

Intarval ISySdﬁlE +2 MNLS environment INLS_LANGUAGE='DUTCH‘ ML

l_ Broken

Apply | Befresh | Close | Help | Yiew SCIL

Creating a new job is equivalent to calling doms_job.submit. Modifying an existing job is equivalent to

calling dbms_job.change. For more information about jobs, see the DBMS_JOB chapter in the Oracle

Supplied Packages Reference manual.

The Open PL/SQL Editor button next to the What field invokes a more convenient PL/SQL Editor with

syntax highlighting, Code Assistant, and so on.

9.7  The queue definition editor

The queue editor allows you to create or modify an advanced queue:

2 Create queue T _ O] x|

Ouinat [SCOTT = Max retries [
NameIDEF’T_QUEUE Retry delay (sec) [0
Tahle name IDEPT_QUEUE_TABLE j Create Fietention time (sec) |0

QueuelypeINurma\ fqueue LI

CDmmenlI

Apply | Eefresh | Close | Help | Yiew SOL

For the queue table name you can select an existing queue table, or you can press the Create button to

create a new queue table (see chapter 9.8).

For more information about Oracle's Advanced Queuing, see the following Oracle documentation:

e  Application Developer's Guide - Advanced Queuing

e  Supplied PL/SQL Packages and Types Reference
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9.8  The queue table definition editor
The queue table editor allows you to create or modify an advanced queue table:

¥ Edit table DEPT_QUEUE_TABLE o =1

=] General BE Queue Iii Pr\vileqes'

Payload type [SCOTT TOEPT =

Sonlist|ENG_TIME

o Multiple consumers

hessage grouping W
Compat\b\elﬁ
Prirmary mstancelﬂ—
Secondary Instance lﬂi

Apply Befresh Close Helg Query... Yiew SCIL

On the General tab page you can define the name, storage parameters, and comment for the table. On
the Priviliges tab page you can grant privileges on the table to users and roles. See also chapter 9.1.

On the Queue page you can supply the queue table specific information. For the payload type you can
select an existing object type, or RAW to create a raw queue.

For more information about Oracle's Advanced Queuing, see the following Oracle documentation:
e  Application Developer's Guide - Advanced Queuing

e  Supplied PL/SQL Packages and Types Reference
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9.9  The user definition editor

The user editor allows you to create or modify a user, its privileges, and tablespace quotas:

: Edit user SCOTT =10]x]

General | Ohject privileges | Raole privileges I System prl\;l\egesl Cluotas |

MName ISCO"I_F

Passwurdl [ Identified externally

Defaulttablespace IUSERS

Temporary tablespace ITEMP

L L] 1]

Prafile [DEFAULT

I Passward expire

™ Account locked

Apphy | Refreshl Close | Wiew SOL

Note that you need specific system privileges (such as provided by the DBA role) to view and modify
user information.

General page

On the general page you basically only need to enter the name and password. All other properties have a
default value:

. Default tablespace — SYSTEM

. Temporary tablespace — SYSTEM
. Profile - DEFAULT

. Password expire — Off

e Account Locked — Off

If you modify an existing user, the current password will not be displayed. Enter a new password to
change it, or leave it empty to leave the password unchanged. If the user is identified externally, you
cannot enter a password.
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Object privileges page

: Edit user SCOTT I [=] E3
General Ohject privilzges | Role privileges | System privileges I Quotasl

Object [Select]Insert [Update| Delete|References| Alter| Index| Execute| Read +
_dbmsfalert &2 &2 = = = &2 = " Yes = =
|| dbms_pipe ¥ . - v - - = * YVes = v =
_planjable * Yes T Yes T Yes T Yes &2 = = &2 =
| |temp . . - v - - = v v Yag =
> = = = = = B B = = =

Apphy | Refreshl Close | Wiew SOL

This page allows you to view and modify the object privileges granted to the user. This does not include
the privileges that are indirectly granted through a role.

In the first column you can see the object on which privileges are granted to the user. All other columns
represent a specific privilege. Each privilege can have the following value:

. (Blank) — The user does not have the privilege
e Yes-The user has the privilege

e  Grantable — The user has the privilege, and can grant it to other users or roles

Role privileges page

| Edit user SCOTT S [=1E3
General I Object privileges  Fole privileges | System prl\;l\egesl Quotas |

Raole | Grantatle Default] +
| [connect = 1= ~
| [dema_rale = = 1= =
| [resource = r ~
L4 z r ~

Apphy | Refreshl Close | Wiew SOL

This page displays the roles that are granted to the user. Each role privilege can be grantable, so that the
user can grant it to other users and roles. If a role privilege is default, the role will be enabled when the
user logs on. If it is not default, the role privilege must explicitly be enabled for the session by executing
a set role command after the user has logged on.
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System privileges page

: Edit user SCOTT 1 [=] E3
General | Ohject privileges | Role privileges  System privileges |Qu0tas |

System privilege |Gramable| +
|| create any directory ™ r
|| create library - r =
L3 x r

Apply | Refresh | Cloge | Wiew SOIL |

This page displays the system privileges that are granted to the user. Each system privilege can be

grantable, so that the user can grant it to other users and roles.

Quotas page
: Edit user SCOTT I [=] E3
General I Ohject privileges | Raole privileges I System privileges  Quadtas |
Tablespace | Maximurm | Unit [Unlimited| +
| [temp =10 b r
| |users "5 = r =
O = M= T
Apphy | Refresh | Close | Wiew SOL

This page displays the tablespace quotas of the user. You can enter a maximum number of bytes,
kilobyes, or megabytes that the user can allocate in a tablespace, or you can specify that the quota is
unlimited.
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9.10 The role definition editor
The role editor allows you to create or modify a role and its privileges:

! Edit role DEMO_ROLE (O] x|

General | Ohiject privileges I Ruole privileges I System privileges |

Marme [DEMO_ROLE

Identification
@ Motidentified

" |dentified by password
" |dentified externally

Fassword

Apply | Refreshl Close | V\eWSOLl

By default a role does not need to be identified. You can also define password identification or external
identification for a role. Password identification requires that you enter a password, and is useful if the

role is not granted by default to users. Such a role needs to be explicitly set after a user logs on, which

requires the password.

The other 3 tab pages (Object privileges, Role privileges and System privileges) work in the same way
as the corresponding pages of the User definition function.




PL/SQL Developer 9.0 User’s Guide

9.11 The profile definition editor

The profile editor allows you to edit the resource limits, password limits, and users of a profile:

i Edit profile APP_DEFAULT

General |Users |

Narne [APP_DEFAULT

Resource limit

Sessions / usar m

CFU / session (0.01 sec) Im
CPU/ call (001 sec) [Defaul =]
Cannecttime (rmin Im

Idle time (min) Iﬁ

Logical reads / session IW[

Passward limit

Failed login attempts m
Password life time (days) lm
Pagsword reuse time (cays) m
Password reuse max |Default vl
Passward lock time (days) lm
Fassword grace time (days) lm

Logical reads [ call IDefau\t -
Composite limit IDeIau\t -
Private SGA (Bytes) IDelau\t -

Pasewaord verify function

Default

L]

Apply | Befreshl Close |

View SOL

Each limit can be set to Default, in which case the value will be inherited from the standard profile
DEFAULT, to Unlimited, or to a concrete value.

On the Users tab page you can define to which users this profile applies. Note that if you remove a user
from the profile, it will implicitly be changed to the DEFAULT profile.

9.12 The database link definition editor

The database link editor allows you to create and edit a database link:

+ Create database link !EB
 Database link  Connect To
OW”E’IPUBUC Username [SCOTT I Current
Mame [CHICAGO Password o=
7 Public Detehase [CHICAGO]
I~ Shared
Authenticatad B
Usemamel
Passwurdl
Apply | Eefresh | Close | Wiew SQLl

Note that the Password and the Authenticated By properties will not be retrieved when you edit an
existing database link. You will have to enter this information every time you edit the database link.
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10. DBMS Scheduler

You can use the DBMS Scheduler tool to access the Oracle database scheduler (DBMS_SCHEDULER)
provided in Oracle10g and later. To do so, you can use the DBMS Scheduler item from the Tools menu,
or right-click on a scheduler object in the Object Browser and select Edit or View from the popup menu.
The corresponding Object Bowser folders are Windows, Window groups, Schedules, Programs, Jobs
and Job classes.

Note: for detailed information about DBMS_SCHEDULER functionality see the Oracle Database
Concepts guide for scheduler concepts, and the Oracle Database PL/SQL Packages and Types
Reference guide for the programming interface.

After starting the DBMS Scheduler tool, you will see a screen like this:

&7 DBMS Scheduler (=]

Job runs

Program properties

Running jobs
&4 Jobs Property [Valie |
=l Programs MName SCOTT.DELETE_EMPTY_DEPARTMENTS
= [1 8COTT Enabled I
 .[] DELETE_EMPTY_DEPARTMENTS Type Stored procedure v
=- SYS » Action deparment delete_empty|
#H- L Job classes Comments |Delete empty departments
= f Windows
(5 FRIDAY_WINDOW
(3 MONDAY _WINDOW Arguments |Pri\fi|eﬂf5|
(&) SATURDAY_WINDOW Name TAigumentlype |Datatype | Default |
(5 SUNDAY_WINDOW » P_ARCHIVE Momnal = CHAR -
(5 THURSDAY_WINDOW [ P_LOG MNamal = CHAR i
(5 TUESDAY_WINDOW | - =

-(5) WEDNESDAY_WINDOW
(5 WEEKEND_WINDOW
(5 WEEKNIGHT _WINDOW
= Window groups
5 MAINTENANCE_WINDOW_GROUP
(5 ORASAT_WGRP_OS
(5 ORASAT_WGRP_SA
(5 ORASAT_WGRP_SQ
- Schedules

Refresh Aoy | Caneel | VlewSHLl

|Pragram SCOTT.DELETE_EMFT_DEPARTMENTS updaled W

On the left side you see folders for the scheduler object types, as well as a folder for running jobs and
job runs. Window groups, Windows and Job classes are system wide, and are displayed immediately in
the root of the corresponding folder. Schedules, Programs and Jobs are owned by specific users, so that
each folder contains subfolders for the owners.

On the upper right side you see the properties of the selected object, and additional object details are
displayed on the lower right side. When creating or editing objects, you can enter the information here.
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Schedules

Schedule properties
Froperty Walue
MName SCOTTDAILY_SCHEDULE
Start date x
End date =
Fraquancy Diaily x
Intarval 4]
By month =
By week number
By year day
By month day
By week day
By hour 23
By minute 0
By second 0

» Comments Schedule that wuns daily at 23:00 hours

A schedule specifies when and how many times a job is run. Schedules can be shared by multiple jobs.
For example, the end of a business quarter may be a common time frame for many jobs. Instead of
having to define an end-of-quarter schedule each time a new job is defined, you can point to a named
schedule.

Windows

Window properties

Property Value

MName TUESDAY_WINDOW
Enabled H
Resource plan DEFAULT_MAINTENAMNCE_PLAN -

-

Schedule
Start date
End date
Frequency daily
Interval 2]
By month =
Byweek number
Byvyear day
By month day
Byweek day TUE
By hour 22

0
0

By minute
Bysecond

Duration (days hh:mm:ss) |0 04:00:00

Priority Low

Active r
Comments Tuesday window for maintenance tasks

Member of window groups ‘ Details |

MAINTENANCE_WINDOW_GROUP
¥ ORASAT_WGRP_0S
DRASAT_WGRP_SA
DRASAT_WGRP_SQ

Windows can be used to automatically start jobs or to change resource allocation among jobs during
various time periods of the day, week, and so on. A window is represented by an interval of time with a
well-defined beginning and end, such as "from 12am-6am".
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You can explicitly enter the individual schedule properties for the window. This is called an inline
schedule. You can alternatively select an existing schedule for the window. All schedule properties will
be displayed italic, indicating that they refer to the selected schedule. If you override one or more
schedule properties, the selected schedule will be cleared, and you will have defined an inline schedule
instead. This allows you to use an existing schedule as a template.

In the bottom section you can add or remove window group membership for the current window by
checking or unchecking the corresponding option.

Window groups

Window group properties

Property Value
Name MAINTENANCE_WINDO
»|Enabled

Comments Window group for Automated Maintenan
Next start date | 16-1UJL-09 10.00.00.000000 PM EUROPE/BERLIN

Member windows
FRIDAY_WINDDW

SUNDAY_WINDOW

¥ THURSDAY_WINDOW
TUESDAY_WINDOW
WEDMESDAY_WINDOW
] WEEKEND_WINDOW

] WEEKNIGHT _WINDOW

Window groups can be created for ease of use when scheduling jobs. If a job must run during multiple
time periods throughout the day, week, and so on, you can create a window for each time period, and
then add the windows to a window group. You can then set the schedule of the job to this window
group, and the job executes during all the time periods specified in the window group.

To add or remove member windows, simply check or uncheck the corresponding option in the Member
windows section at the bottom of the screen.

Job classes

Job dass properties

Froperty Value
hName DEFAULT_JOB_CLASS

» Resoulce consumer group -
Service
Logging level Runs =
Log history (days) =
Comments Thisis the default job class.

Privileges |

Grantee |Privilege [Grant option |
PUBLIC = Exectute = ~
5 = =

[E352

Job classes provide a way to assign the same set of attribute values to member jobs, or to set service
affinity for member jobs. You can grant execute privileges to other users or roles that need to use this
job class. To revoke a privilege, right-click on it and select Delete from the popup menu.
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Programs

Program properties

Froperty |Value

Name SCOTT.DELETE_EMPTY_DEPARTMENTS
» Enabled
Type Stored procedure =
Action deparment.delete_smpty

Comments

Delete empty deparments

Arguments | Privileg&'

Name |Argumenttype  [Data type |Default |
|| P_ARCHIVE Wormal - CHAR -
| |[P_LOG MNormal ~ CHAR -
¥ - -

A program describes what is to be run by the Scheduler. A program includes an action like the name of
a stored procedure, the name of an executable found in the OS file system, or the text of a PL/SQL
anonymous block.

A program is a separate entity from a job. A job runs at a certain time or because a certain event
occurred, and invokes a certain program. Jobs can be created that point a program, which means that
different jobs can use the same program and run the program at different times and with different
settings. Given the right privileges, different users can thus use the same program without having to
redefine it. This enables the creation of program libraries, where users can select from a list of existing
programs.

A program can define arguments if the stored procedure or external executable that is references accepts
these arguments. In the Arguments section you can define these arguments. To delete an argument,
right-click on it and select Delete from the popup menu.

To grant Execute or Alter privileges for the program to other users and roles, go to the Privileges
section. To revoke a privilege, right-click on the privilege and select Delete from the popup menu.
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Jobs

Job properties

Property Value |
Name SCOTT.DELETE_EMPTY_DEPARTMENTS_JOB

Enabled -

Program SCOTT.DELETE_EMPTY_DEPARTMEMNTS =
Tipe 5
Action g

smpty

Schedule SCOTT.DAILY_SCHEDULE
Start date
End date
Freguency Daiy
fterval
Bymonth
By week number
By yearday
By month day
By week day
By hour
By minute
By second

Bl

S

Jobclass DEFAULT_JOB_CLASS

Auto drop r
p| Comments Delete dept recards wilhout employees, daily at23:00 hours|

Arguments | Privileges| Run detailleug |

Name Datatype Value
»|P_ARCHIVE |CHAR NO
P_LOG CHAR MNO

Jobs associate a program with a schedule (or a window or window group), and are the principal object
that you work with in the Scheduler. You can create multiple jobs that refer to the same program but
that run at different schedules. A job can override the default values of program arguments, so multiple
jobs can refer to the same program but provide different argument values.

You specify the job action by specifying program unit, external executable, or PL/SQL Block to run.
This is known as specifying the job action inline. You can alternatively select an existing scheduler
program.

You can explicitly enter the individual schedule properties for the job. This is called an inline schedule.
You can alternatively select an existing schedule for the job. All schedule properties will be displayed
italic, indicating that they refer to the selected schedule. If you override one or more schedule
properties, the selected schedule will be cleared, and you will have defined an inline schedule instead.
This allows you to use an existing schedule as a template.

To grant Alter privileges for the job to other users and roles, go to the Privileges section. To revoke a
privilege, right-click on the privilege and select Delete from the popup menu.

You can view details and logs of finished job runs on the corresponding tab page in the bottom section
of the screen.
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10.1 Creating objects

To create a new object, right-click on the corresponding folder and select New from the popup menu.
Now you can enter the properties and additional detail information on the right side of the screen. When
you are done, press the Apply button to create the object in the database. To view the SQL for the object
creation, press the View SQL button. To cancel the object creation, press the Cancel button.

10.2 Editing objects

To edit an existing object, select it in the folder on the left side of the screen and edit the properties and
additional detail information on the right side of the screen. When you are done, press the Apply button
to modify the object in the database. To view the SQL for the object modification, press the View SQL
button. To cancel the changes, press the Cancel button.

10.3 Deleting objects

To delete an object, select it in the folder on the left side of the screen and select Drop from the popup
menu. After confirmation the object will be permanently deleted from the database.

10.4 Viewing job runs

To view information about job runs that have finished execution, you can open the Job runs folder.
Here you will see a number of predefined reports, such as All, Failed, and so on. Click on a report to see
the job run details that match the criteria from the report:

4% DBMS Scheduler —|of x|
Sy Job runs LoglD _ [Log date __[Oowner [ Job name _[Job subname _ [Status |
[ i (b 437 0707-2009 12:35:00 SCOTT | DELETE EMPTY_DEPARTMENTS_JOB SUCCEEDED
Failed [ [436 07072009 12:30:00 SCOTT |DELETE_EMPTY_DEPARTMENTS_JOB SUCCEEDED
Succeedad 435 07072009 12:25:00 SCOTT |DELETE_EMPTY_DEPARTMENTS_JOB FAILED
This week B
B Ermmngjnbs
- [ Jobs
@ Programs
L Job classes
£ Windows
& [l Window groups
@ B Schedules
K - E]
[ 4

The job runs can be sorted by clicking on the sort button of a column header. Columns can be moved by
dragging & dropping the header(s).

You can copy job run information to the clipboard by selecting a range of rows, columns, or cells, right-
clicking on them, and selecting Copy Comma Separated or Copy Tab Separated from the popup menu.
If you do not select a range, the entire report will be copied.

To refresh the report contents, press the Refresh button at the bottom of the screen.
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Creating custom job run reports

To create a custom report, right-click on the Job run folder and select the New item from the popup
menu. The following screen will appear:

Job Run Query x|

Name

Field list | Where clause | Order by cause | Conditions |

owner
job_name
job_subname
log_id

log_date

status

errorz
req_start_date
actual_start_date
run_duration
instance_id
session_id
slave_pid
cpu_used
additional_info

At the top you can supply a logical name for the report.

In the bottom section you can define how the sys.all_scheduler_job_run_details view will be queried
for the report. See the Oracle Database Reference guide for more information about this view. The field
selection list to the right can be used to quickly select fields. Double-click on a field to apply it to the
currently selected section on the left.

The Field list allows you to select the fields that will be displayed in the report. This is a comma
separated list. You can also enter an asterisk in the field list to include all fields.

The Where clause allows you to define which job runs will be displayed in the report. For example, to
create a report that displays all succeeded job runs from today, use a where clause like this:

log_date >= trunc(sysdate) and status = "SUCCEEDED"
The Order by clause allows you to define a list of fields by which the job runs will be ordered.
On the Conditions tab page you can define the display color of job runs that meet a certain condition:

Fleld Ilstl Wihere dausel Order by dause  Candifions |
Condition Color [Color property |
Text

|| status = ‘FAILED'
e -

The condition can be any valid SQL expression. For the Color property you can select either the text or
the background.

To edit or delete a report, right-click on it and select the corresponding item from the popup menu.

10.5 Viewing running jobs

To view information about currently running jobs, click on the Running jobs folder. The right side of
the screen will show information about the currently running jobs.
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11. Diagrams

The Diagram Window allows you to create a graphical representation of a selection of objects. This way
you can easily visualize (a part of) the database objects of your application or project and their relations:

& Diagram Window - dept_smp.pdd =S =lol =

Type Nalinble| Defnut| Comments {Eloment | Typs
NUMBER(4] The 4 digi ol the X FLINGTION
) ENAME  VARCHARR(D) The last name ofthe employe § |MGRNAME  FLINCTION
o 08 VARCHARNS) Y null The o of the enployee
@ MGR NUMBERH] ¥ The rember of fha manager
& HREDATE  DATE ¥ nll  Tha duta anwhichths ample)
m SAL NUMBER?Z ¥ The salasy of the emglovee
W COMM NUMBERZZ ¥ The comission althe omolo
DEPTNO  NUMBERZ) Y The 2 chgt number of ha dag: )\ Column | Type | Mulable Dedault| Commant
Ky Columnls) Tpe [ GRADE NUNBER Y
op PKEMP  EMPNO P m LOSAL NUMBER ¥
e FEK_DEPTNG DEPTNO R | HSAL NUMBER ¥
ndiex Calmi(s) Twe Ll
& PK_EMP EMPNO unique FY_DEFTNG|

Column | Type Nullable | Detaul] Comments
i DEPTNG NUMBER(Z) Dot Aumber
DMAME  VARCHARZM) Y
H LoC VARCHARZTY) ¥

Propaty Vaba [Proparty ]
2] MINVALUE 0 5 M VALLE ’ e :?‘UEFT g‘ér‘m;a ﬁm
Bl MALVALLE 99 B MAXVALLE 9999 mowr | Conmnts) Typé
B NCREMENT_BY 1 £ F] PR_OEFT DEPTND uriqué

E] CYCLE_FLAG N
®] ORDERFIAG N
B] CACHE SCE 20
E] LAST NUMBER 0

4 1o

You can add all relevant object types to a diagram, and include the relations between them. Foreign key
references between tables are automatically included. Dependency references between objects can also
be automatically added. For large diagrams you can add additional structure by including object groups.

A diagram can be used for documentation purposes, but can also serve as a workspace. Right-clicking
on an object provides access to all object functions, and double-clicking on an object will invoke the
default action for the object type.

11.1 Creating a diagram

To create a new diagram, select the Diagram Window from the New submenu in the File menu. An
empty Diagram Window will appear. To add a database object to the diagram, drag it from the Object
Browser into the Diagram Window. You can drag & drop multiple objects at once.

To move a diagram object, click on the title bar and drag it to the new location. To resize a diagram
object you can drag an edge or a corner. To delete an object from the diagram, press on the X at the
upper-right of the object. This will only affect the diagram, and the database object will not be dropped.

Showing and hiding items

To show or hide a specific item of a diagram object, right-click on it and go to the Items submenu. Here
you will see a submenu with all items that are applicable for the selected object. For a table you can
select which items of a column, key or index you want to show. You can also hide the complete key or
index section.

You can also right-click on a group or on the diagram to show or hide items for objects within the group
or all objects in the diagram.
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By default all items will be displayed, but if you right-click on an object and select Set as default, the
visible items will apply to all objects added to a diagram in the future. You can do this for all object
types.

Sorting items

You can sort all items by right-clicking on the diagram object and selecting Order as created or Order
alphabetically from the Items submenu. You can also explicitly drag & drop an item to place itat a
different position.

Adding relations

To add a relation between 2 objects, click on the icon of an element of the source object, and drag it to
the element of the target object. A line will be drawn between the 2 elements of the objects. You can
move the line to another element by selecting the line and moving the selection point up or down. To
remove a line, select it and press the Delete key.

If you add a table to a diagram, foreign key relations with other tables on the diagram will automatically
be included. These relations can be deleted if necessary.

If an object references other objects, or is referenced by other objects, you can right-click on the object
and select Reference links from the popup menu. You can subsequently select which references you
want to include in the diagram. For example, if you right-click on the employee package and select
Reference links, you can see that it references the DEPT and EMP tables:

FMPLOYEE Reference links... |
Line Colsr I

FMPLIYEE 3 TABLE JONFS DEPT
EMFLUYEE - TABLE JONES EMP

I

By default relations will be drawn as straight lines. You can add additional bends by right-clicking on a
line and selecting Insert bend from the popup menu. You can also hold down the Ctrl key while
clicking on a line to insert a bend. A new selection point is added to the line as a result.

To change the line end, right-click on the end of the line and select Change line end from the popup
menu. Here you can select a symbol for one-to-many relations, optional relations, and arrows.

To change the color, size, and label of a line, right-click on it and select Line properties from the popup
menu:
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Line Properties x|
Line Calor 1l
Line Size E@
[ Lahel
Call
Coeel
The label will move with the line if objects are moved.
Adding groups
To add additional structure to a large diagram, you can create object groups. Groups can have
distinctive colors, and can have a title at the upper or lower left or right:
o Hagram Window - dept_emp.pdd oy (=]
MRaHe s &
Colmn Type |Musatia| Detaull Comments i Eiement | Type
—| @ EMPHO  HUMBER(4) The 4 digit number of the e {l © DEPTHAME FUNCTION
B FNAME WARCHARZ 10} ¥ Thee lnat naene of e mepoyes. fl B MORNAME FUNCTION
E VARCHARZ() Y ndl  The job of the employse
et NUMBERH) ¥ The number of the manages
& HREDATE DATE A null The dete onwhich e smployes|
&= sAL NUMBER( ¥ The salary of the employes
& COMM NUMBERZ2 Y The commission afthe employed
& DEPTNO  NWUMBERZ) Y The 2 digit numibir of e depam| |Colursn | Type | Nullable | Defaul | Comments
Kay Column(s) Type € GRADE NUMBER ¥
o PK_EMP EMPNO P B LOSAL NUMBER Y
w0 FK_DEPTMO DEPTHO R B HISAL NUMBER Y
1 Column(s)  [Type | I
& PK_EMP EMPNO UnKGUE F¥,_DEPTHD|
| |Coumn | Type | Mullabla | Default| Commeants
@ DEPTNO NUMBER(Z) Dept number
r El DNAME  VARCHARZT4) ¥
7 Valse P ® Loc VARCHARH(13) ¥
B MN_VALLE O B MIN_VALUE [ P g:rrrpr m;' ;m
B MAX_VALUE 79 [ MAX_VALUE ) Index Coumnjs) Type
g m?;&tm' :I g g&-[l_d:ﬁ\; 8y "‘I € PH_DLFT DEFTHD Cuneque
[E] ORDER_FLAG N ) ORDER_FLAG N
[E) CACHE SIZE 20 B CACHE_SIZE X0 -
[E] LAST_NUMBER [ B LAST_NUMBER 0

Sequences

ol

A

To add a group, right click at an empty position on the diagram and select New group from the popup
menu. A new group will appear at this location, which you can resize to appropriate dimensions. All
objects that are completely covered by the group will implicitly be part of that group, and moving the
group will also move these enclosed objects. If you hold down the Ctrl key while moving a group, the
enclosed objects will not be moved.
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To change the appearance of a group, right-click on it and select the Properties item from the popup
menu. You can also double-click on the group. The following screen will appear:

Group Properties x|
Microsaft Sans Ser, 10pt
Fill Color | I~ Trarsparent
Line Color Il ™ Autosize to text
Line Sies [3 3]
Sequences ~ | © Location
» (sl
=||c o
4 b ~
I3 Cancel

You can change the font, fill color, line color and line size of the group, make the group transparent, and
make it automatically resize based on the text. You can optionally enter the title of the group, and
specify the location of the title.

If groups are visually overlapping, you can right-click on a group and select Send to back or Bring to
front from the popup menu.

To create a default group appearance, right-click on it and select Set as default. This will apply to all
groups added to a diagram in the future.

To delete a group from the diagram, select it and press the Delete key. This will only delete the group,
and not the enclosed objects.
Adding notes

You can add text notes to the diagram by right-clicking at the desired location on the diagram and
selecting New note from the popup menu:

Group Properties x|
Font. | WS Sans Serif, Bpt
Fill Color [~ ¥ Transparent
Lire Color | [V futosize to text
Line Size IU_@
Mew nate..| ;I " Location
[0l (ol
= e (ol
[l B

As you can see, the properties for a note are the same as for a group, but with different default values.
To create a default note appearance, right-click on it and select Set as default. This will apply to all
notes added to a diagram in the future.

Aligning items

You can quickly align items by right-clicking on them and selecting Align to grid from the popup menu.
This will place the selected item on an 8 pixel grid. To align all items, right-click on the diagram and
select Align all to grid from the popup menu, or press the corresponding button on the Diagram
Window toolbar.



PL/SQL Developer 9.0 User’s Guide 83

11.2 Zooming

You can zoom in and out on the diagram by right-clicking on the diagram and using the Zoom item
from the popup menu, or by using the corresponding button on the Diagram Window toolbar. You can
zoom in by 150% or 200%, or you can zoom out from 90% to 10%.

11.3 Saving and opening a diagram file

To save a diagram to a file, select the Save item from the File menu. A diagram will be saved in a file
with a .pdd extension, which can be reopened later. To define a standard location for diagram files, go
to the Directories preference page and set the corresponding option.

11.4 Updating a diagram

A diagram is a static representation of the database. If database objects change over time, you will need
to update the diagram to reflect these changes. To do so, right-click on a diagram object and select
Update from DB from the popup menu. To update all objects on the diagram, right-click on it and select
Update All from DB. You can also press the corresponding button on the Diagram Window toolbar.

If an object is dropped from the database, you will also need to delete it from the diagram. If an object is
renamed in the database, you will need to delete the diagram object and add it with the new name.

11,5 Printing a diagram

To print a diagram, click on the Print button on main toolbar. To print the current view you can press
the Print view button on the Diagram Window toolbar. The page orientation will automatically be
determined when printing the current view.

The page size can be controlled by using the Page size button on the Diagram Window toolbar. Set it to
Automatic to automatically determine an appropriate size. Set it to Manual to manually control the page
size. For large diagrams you can now zoom out and move the horizontal and vertical page ends to an
appropriate location, or move diagram objects so that they do not span multiple pages.

11.6 Exporting a diagram

You can export a diagram to an image file by right-clicking on it and selecting Save as image from the
popup menu. You can subsequently select the file format (bmp, jpg, wmf or emf).

You can also copy the diagram image to the clipboard by right-clicking on it and selecting Copy as
image from the popup menu.
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12. Reports

To run reports against your application data or against the Oracle dictionary, you can use PL/SQL
Developer’s built-in Report functionality. There are a number of standard reports, and you can easily
create your own custom reports. These custom reports can be saved in a report file, which can in turn be
included in the reports menu. This makes it very easy to run your own frequently used custom reports.

12.1 Standard reports

The standard reports are accessible through the Reports main menu. If, for example, you select the
Compilation errors report, you will first be prompted for the object type, owner, and name for which
you want to display the current compilation errors:

# variables ol x|

Name Value ]
Obiject type | Al =
Object owner SCOTT -
W | Object name | 5 -

Cancel Clear
The name of the object, or % for all objects
4

After entering the appropriate values and pressing the OK button, the report will be displayed:

|~ epart Window - Complstioncerorsrep =0l
Compilation errors = &
H
Vasiablms =
P -

Otiject cranne = SCOTT
Otijact rame = B

Type PACKAGE BODY
Dwmer SCOTT
Hame EMPLOYEE
Line Error text
38 PLS-00302 companant DEPTHAME must bo declamd
38 PL/SOL: ORA-D0%04" imaalid column name
38 PUSOL: SOU Siatement ignored

Type TRIGGER
Owmer SCOTT
Hame EMP_INSERT
Lin Error tewt i~
4 PLISOL- ORA07289 sequance does not exist lﬂ
| *

il
ERI11 s smmcindn 106 s

The result isan HTML document that is displayed by PL/SQL Developer’s internal HTML viewer or
by the Internet Explorer ActiveX control, depending on the preferences (see chapter 20.10).

You can subsequently print the report by pressing the Print button on the toolbar, or you can save the
report in HTML format by pressing the Save results button on the right side of the Report Window. The
Copy as HTML button copies the report results to the clipboard. The Export Results button allows you
to export the results in CSV, TSV or XML format, or to export the results directly to Excel.

The Edit report button provides access to the report definition, if the report is not locked.

You can right-click on the results for additional options.
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12.2 Custom reports

Custom reports are very easy to create. First you create a new, empty report by pressing the New button
on the toolbar, and selecting the Report Window item from the popup menu. An empty Report Window
will appear:

* neport window tew _nix

SaL |Layout| Dpllansl

— | 4

In the SQL editor you can type a single SQL select statement for your report. For master/detail reports
you can use a join select statement (this will be described later). Let’s start simple with the well-known
emp table by typing the select statement and pressing the Execute button on the toolbar:

“* Report Window - select * from emp order by depino, ... =0lx|

SaL |Layout| Dpllansl

select * from emp
order by deptnoc, ename

Empno Ename  Job Mgr Hiredate Sal Comm Deptno = @

7782 CLARK ~ MANAGER 7839 09-06-1981 2450.00 10 B
7839 KING PRESIDENT 17-11-1981  5000.00 10
7934 MILLER  CLERK 7782 23-01-1982 1300.00 10 =
7876 ADAMS  CLERK 7788 12-01-1983  1100,00 20
7902 FORD ANALYST 7566 03-12-1981 3000.00 20
7566 JONES ~ MANAGER 7839 02-04-1981 2975,00 20 j

= |23 114 rows selected in 0,03 saconds v

This is a very basic report, with only the default style properties applied. The following chapters
describe how you can refine the report’s functionality.
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12.3 Variables

Very often your reports will require some additional input before they can run. Let’s assume that you
want to restrict the report from the previous chapter to the employees of just one department. In that
case you need supply a substitution variable in the SQL text:

select * from emp

where deptno = &department

order by ename
When this report is run, the user is prompted for a department before the select statement is executed.
This is of course not very foolproof. What if the user enters nothing? The statement would lead to a
ORA-00936: missing expression exception. What if the user enters a value that is not a number? Or a
number that does not exist in the dept table? To prevent these situations, you can use the parameter
options described in the following chapters. These options must be specified between brackets, just like
attributes in an HTML or XML document.

Name option

The name of a variable is used as a prompt in the variable input form. Therefore you should make sure
that it describes the meaning of the variable. The name is the only option that does not have to be
specified between brackets, if it is the only option. If the name contains spaces or other special
characters, enclose it in double quotes. The following 2 examples are equivalent:

select * from emp

where deptno = &”Department number”

order by ename
and

select * from emp

where deptno = &<name="Department number”>

order by ename

Hint option

Besides the name option, you can additionally specify a hint text. This hint will be displayed on the
status line of the variable input form when this variable has the focus:
select * from emp
where deptno = &<name="Department number”
hint="0nly employees from this department will be listed”>
order by ename

Type option

The type option restricts the user to the information that can be entered, and also controls how the value
should be inserted into the resulting SQL text:

select * from emp

where deptno = &<name="Department number”

type="integer’>

order by ename
In this situation the user can only enter values that are valid integer values. The entered value will be
replaced in the SQL text as is. For strings however, you would want the value to be enclosed in quotes.
Consider the following select statement:

select * from emp

where ename = &<name="Employee name”

type="string”>

If you enter SCOTT (without quotes) in the variable input form, the resulting SQL would be:

select * from emp
where ename = “SCOTT”
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Valid types are: none, string, integer, float, and date. No validation will occur for date values, so that
the user can additionally supply date expressions like sysdate, trunc(sysdate, ‘MM”) and so on.

Required option
If you require a value for a certain variable, set its required option to “yes” or “true”:

select * from emp

where deptno = &<name="Department number”
required="yes”>

order by ename

Now the report can only be run if a value is specified for the department number.

Default option

To present a default value for the variable, specify the default option:
select * from emp
where deptno = &<name="Department number”
default="10">
order by ename
The default value can also be a select statement. This select statement should return just one row with
one column. For example:

select * from emp

where deptno = &<name="Department number”
default="select min(deptno) from dept’>

order by ename

In this case the default value will be the smallest department number.

Ifempty option
As an alternative to making a variable required or providing a default value, you can specify the ifempty
value in case the user does not specify one:

select * from emp
where ename like &<name="Employee name”
type="string”
ifempty="%">
If the user does not specify a value, the percent sign will be used, and all employees will be retrieved.
This option cannot be specified together with the required option.

Uppercase option
If you have a string variable and want to implicitly convert its value to uppercase, set its uppercase
option to “‘yes” or “true”:
select * from emp
where ename = &<name="Employee name”
type="string”
uppercase=""yes”’>

The value is displayed as typed, but is converted to uppercase in the resulting SQL text.

Readonly option

A variable can be defined as read-only by specifying readonly="yes”. The user can see the variable and
its value, but cannot change it.

Hidden option

You can hide variable by specifying hidden="yes”.
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List option

The list option provides the user with a list of possible values. You can specify a comma-separated list
of items:

select * from emp

where deptno = &<name="Department number”
list="10, 20, 30, 407>

order by ename

This allows the user to select one of the four items, or to type a different value. In this case it makes
more sense to use a select statement though:

select * from emp
where deptno = &<name="Department number”

list="select deptno from dept order by deptno’>
order by ename

You can additionally provide a description for each item:

select * from emp
where deptno = &<name="Department number”
list="10, ACCOUNTING,
20, RESEARCH,
30, SALES,
40, OPERATIONS™
description="yes”>
order by ename

Each item is now followed by a description, and the description option is added. The list will only
display the descriptions, but the actual value will be used in the resulting SQL text.

Again you can do the same with a select statement with 2 fields:

select * from emp

where deptno = &<name="Department number”
list="select deptno, dname from dept order by dname”
description="yes”>

order by ename

To restrict the user to just the items in the list, specify the restricted option:

select * from emp

where deptno = &<name="Department number”
list="select deptno, dname from dept order by dname”
description="yes”
restricted="yes””>

order by ename

Now the user can only select values from the list, and cannot enter any other value by hand.

The items in a list can sometimes depend on the value of another variable. Imagine that you want to
create a report that shows all columns of a specific table. A table is identified by the owner and the
name. For the owner you can use a list of all users in the database. For the table name you can query the
all_tables view for the selected owner:
select * from all_tab_columns
where owner = &<name="Owner"
type="'string"”
list=""select username from all_users order by username'>
and table_name = &<name="Table"
type="'string"”
list=""select table_name from all_tables
where owner = :owner
order by table_name'>

order by column_id

As you can see, the select statement for the second (table) list refers to the first variable through the
:owner bind variable. Whenever the value of the owner is changed, the table list will be populated.
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Note that the name of the bind variable cannot be longer than 30 characters, and cannot contain spaces
or other special characters. Spaces in the variable name will be converted to underscores. If the variable
name had been Owner of the table, then the bind variable would have been :owner_of_the_table.

Also note that if the value of a variable is empty, the dependant list will also be empty. No query will be
performed in this situation.

Checkbox option

If the user can select one of two distinct possibilities, you can use the checkbox option. This option
needs to be followed by the checked and unchecked values:
select * from emp
order by hiredate &<name="Descending sort order”
checkbox=""desc, asc”>
Even though you must always specify 2 values, one of the values can be empty:

select * from emp
order by hiredate &<name="Descending sort order”
checkbox=""desc,”>

Since the default sort order is ascending, these 2 examples are equivalent.

Prefix and suffix options

If a variable value is empty, this may imply that certain fixed portions of the SQL text must also be
omitted. Consider the example that you want to provide an optional sort column. If no column is
specified, the order by clause should be completely omitted. In this case you can specify this text as
prefix or suffix of the variable. If the variable value is empty, the prefix and suffix will be omitted as
well:
select * from emp
&<name=""Descending sort column”
list="empno, ename, hiredate”
prefix="order by "
suffix=" desc”>
If no value is specified for this variable, the result will be empty as well:
select * from emp
If a column is specified, the result will be:
select * from emp
order by empno desc
Note the spaces after the prefix and before the suffix. These are important, because the prefix, value and
suffix are concatenated exactly as specified!

Escape character

If you wish to use an ampersand in the SQL text that should not be interpreted as a substitution variable,
use a double ampersand instead. The following example will retrieve all employees from the ‘R&D’
department:

select * from emp

where emp.deptno in (select dept.deptno from dept
where dname = "R&&DT)

order by empno desc

If the text 'R&D" had been used instead, you would have been prompted for the D variable.

12.4 Refining the layout

After opening a new Report Window, typing a select statement, and executing the report, the layout will
use the default style properties. It will have a simple tabular layout, with standard font properties, table
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style, colors, and so on. To refine the standard layout, switch to the Layout tab page. For a new report,
this page will look as follows:

*® Report Window - select * from emp order by deptno, ... =10l x|

SOL  Lapout | Options |

A & T Auto Update
| Item ‘ Description ‘ Style | Header |Ahgn ‘ Format | Break. | Sum
' Report Title -
v ariables -
Tabular Tables =
Form Tables 2
Default Field =
Empno Ename Joh Mgr Hiredate Sal Comm Deptno = @
7782 CLARK MANAGER 7839 09-06-1981 2450,00 10 =]
7839 KING PRESIDENT 17-11-1981 5000,00 10
7934 MILLER CLERK 7782 23-01-1982 1300,00 10 e
7876 ADAMS CLERK 7788 12-01-1983 110000 20
7902 FORD ANALYST 7566 03-12-1981 3000.00 20
7566 JONES MANAGER 7839 02-04-1981 2975.00 20
7788 SCOTT ANALYST 7566 09-12-1982 3000,00 20 ;I
= |z23 114 rows selected in 0,03 seconds v

As you can see, you can define various layout properties for all layout items (the report title, variables,
tables, and the fields). If you want to define properties for an individual field, you first need to press the
Refresh Fieldlist button on the toolbar:

*® Report Window - select * from emp order by deptno, ... ol x|
0L Lapout | Gptions |
A <p I Auto Update
[Item | Description | Style | Header | Align | Format | Ereak | Sum -
v Report Title -
¥ Variables -
Tabular Tables -
Form Tables =
Default Field 2
¥ EMPNO - - - -
[ EMAME - - - -
¥ Joe - - - -
F MGR - - - -~
Empno Ename Job Mgr Hiredate Sal Comm Deptno = @
7782 CLARK MANAGER 7839 09-06-1981 2450.00 10 =]
7839 KING PRESIDENT 17-11-1981 5000.00 10
7934 MILLER CLERK 7782 23-01-1982 1300.00 10 "
7876 ADAMS CLERK 7788 12-01-1983 1100,00 20 =
7902 FORD ANALYST 7566 03-12-1981 3000,00 20 ;I
= |z23 114 rows selected in 0,03 seconds v

Now all fields of the result set of the select statement will be included in the layout grid, and you can set
the layout properties of each individual field. If you leave the Style, Header or Align property of a field
empty, the corresponding property from the Default Field will be used.

After changing a layout property, you can execute the report again to view the effect this has on the
results. You can alternatively enable the Auto Update option on the toolbar, in which case each change
will immediately be reflected in the results.

The following chapters describe the various layout properties in detail.
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Displayed

The checkbox in the leftmost column of the layout grid indicates if the layout item should be displayed
or not. This allows you to suppress the report title or variables, and allows you to control whether a
specific field should be displayed or not.

Description

The description of the Report Title will be displayed at the top of the report and after each page break.
The description of the Variables will be displayed above the variables.

For the individual fields you can define a description to override the standard field name. This
description will be used for the header of the column.

Style
The style controls the appearance of the layout items. Press the cell button (...) to bring up the style
editor:

*% Style Editor [_[a[x]| the listbox at the top of the style editor you can see all
standard styles, and a Custom style. You can select a
standard style from the Style Library (see chapter 12.5), or

Bright Field
Brright Farm you can select the custom style so that you can change the

Bright Header various style properties for the current layout item.

Bright Tahle ) ) )

Bright Title Ll & Note that this style system is based on the Cascadln_g Style

Nafzuilt Fiald Hasdar Sheets (CSS) standard. The properties that you see in the

Property Walue || style editor are the ones that you will most frequently use,

Background ™| but you can also add other CSS properties and values

Color #000080 Mavy " | below the standard properties. You can, for example, add a

gz:gg:\m; ~ | Height style property with a value of 20pt to set the cell

ST CRlEr = height to _20 point§. See http://www_.vvs.org/TR/REC-CSSZ

Padding = for more information about Cascading Style Sheets.

Fontfamily | verdana ™| The Copy and Paste buttons allow you to copy the

Fant size 14pt “I| properties of a style, so that you quickly derive a new style

Fontweight | Bold "| froman existing one.

Faont style =

Text align - If you define nothing for the field styles, the Default Field

“idth = | style from the Style Library will be used. You can override
this by defining the style of the Default Field layout item.

You can override this default style at the field level by

| Ok ” Cancel | specifying the corresponding style. Note that each field
header inherits its style properties from the Default Header
style, so you only need to override the properties that you want to change. If, for example, you define
the Default Field style as Verdana, 14 points, blue, and you want to display the EMPNO column in
Verdana, 14 points, red, you only need to define the color at the EMPNO level. The font family and font
size will automatically be inherited from the Default Field level.

The default styles of the various layout item types are described in chapter 12.5.

Header

Just like you can set the style for the data of the individual fields, you can also set the style for their

headers. If you define nothing, the Default Field Header style from the Style Library will be used. You
can override this by defining the style of the Default Header layout item. You can override this default
style at the field level by specifying the corresponding header style. Note that each field header inherits



92 PL/SQL Developer 9.0 User’s Guide

its style properties from the Default Header style, so you only need to override the properties that you
want to change.

Align

You can align the layout items in the following ways:

. Left — The item will be left-aligned within its cell

. Right — The item will be right-aligned within its cell

. Center — The item will be centered within its cell

. Default — Numbers will be right-aligned, all other items will be left-aligned

. None - No alignment will be specified

Note that you can also set the Text Alignment style property for a layout item. This will take precedence
over the alignment option you can specify in the layout grid. Also note that the effect of the alignment
may depend on the Width style property of the layout item.

Format

By default the format of a field is controlled by the data type, scale, and precision. Very often you will
use calculated fields or aggregated fields, in which case the scale and precision are unknown. In these
situations you can specify a format.

The Format property only has effect for date and number fields. For number fields you can use a 9 for a
zero-suppressed digit, 0 for a normal digit, G for a thousand separator, D for a decimal separator, and E
for scientific notation. You can additionally specify literal text in double or single quotes. Some
examples:

Format Value =1234 | Value=5 Value =0.1
999G990D00 | 1,234.00 5.00 0.10
9G990 1,234 5 0

0000 1234 0005 0000

0"%”" 1234% 5% 0%
0D000e+00 1.234e+03 5.000e+00 1.000e-01
0D000e-0 1.234e3 5.000e0 1.000e-1

For date fields you can use the standard Windows date and time formats.
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Break

The break layout property allows you to structure your report results. Assume that you want to display
the departments and their employees. You can specify the following query for this:

select d.*, e.*

from emp e, dept d

where e.deptno = d.deptno

order by d.deptno, e.empno

This would of course lead to a simple tabular report:

b
Ix

% Report Window - select d.”, e.* from emp e, dept ...
5aL |Layaul| Dptionsl

select d.*, e.*
from emp e, dept d

where e.deptno = d.deptnc
order by d.deptne, e.empne

i % Da ||

Deptno Dname Loc Empno Ename Job Mgr Hiredate Sal Comm —|
10 ACCOUNTING NEW YORK 7782 CLARK MANAGER 7839 09-06-1981 2450,00
10 ACCOUNTING NEW YORK 7839 KING ~ PRESIDENT 17-11-1981 5000,00
10 ACCOUNTING NEW YORK 7934 MILLER CLERK 7782 23-01-1982 1300,00
20 RESEARCH DALLAS 7369 SMITH CLERK 7902 17-12-1980 800,00
20 RESEARCH DALLAS 7566 JONES MANAGER 7839 02-04-1981 2975.00
20 RESEARCH DALLAS 7788 SCOTT ANALYST 7566 09-12-1982 3000.00
20 RESEARCH DALLAS 7876 ADAMS CLERK 7788 12-01-1983 1100,00
20 RESEARCH DALLAS 7902 FORD  ANALYST 7566 03-12-1981 3000,00 |
30 SALES CHICAGO 7499 ALLEN SALESMAN 7698 20-02-1981 1600,00 300,00
30 SALES CHICAGO 7621 WARD SALESMAN 7698 22-02-1981 1250,00 500,00
30 SALES CHICAGO 7654 MARTIN SALESMAN 7698 28-09-1981 1250,00 1400,00 LI
= |4:27 114 rows selected in 0,03 seconds v

By specifying a Break on the LOC column, you will get some more structure into your report:

% Report Window - select d.”, e.* from emp e, dept ... =loix]
oL Levout | Options|

2 &p I AutolUpdate
[ Item | Deseription | Style | Header | &lign | Format |Break | Sum |;|
¥ DEFTHO - - - -
AT : : : =
¥ EMPNO - - = - =
Deptno Dname Loc Empno Ename Job Mgr Hiredate Sal Comm = @
10 ACCOUNTING NEW YORK 7782 CLARK MANAGER 7839 09-06-1981 2450,00 B
7838 KING PRESIDENT 17-11-1981 5000,00
7934 MILLER CLERK 7782 23-01-1982 1300,00 —
20 RESEARCH DALLAS 7369 SMITH CLERK 7902 17-12-1980 800,00
7566 JONES MAMAGER 7839 02-04-1981 297500
7788 SCOTT AMALYST 7566 09-12-1982 3000,00
7876 ADAMS CLERK 7788 12-01-1983 1100,00
7902 FORD  AMALYST 7566 03-12-1981 3000,00
30 SALES CHICAGO T499 ALLEN SALESMAN 7698 20-02-1981 1600,00 300,00 _I
TEAA AN ©ALCSRIAL FE00 A% AN AN04_A9L0 AN £AN AN
= |4:27 114 rows selected in 0,03 seconds v

Repeating values for the fields up to (and including) LOC will be suppressed. In short: each dept record
will only be displayed once. In this case it is necessary that the records are sorted by department (the
DEPTNO column). If you want to repeat the header after each break, use the Break + Header option.
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You can alternatively select a Master/Detail layout:

% Report Window - select d.*, e.™ from emp e, dept ... =1
0L Lavout | Options|

2 & I duto Update
[ Them | Description [Stwle [Header [Align [ Fommat [Bieak [Sum |;|
¥ DEFTHD g - - -
P e = - I
¥ EMPHD - - - =
Deptno 10 ;I @
Dname ACCOUNTING H
Loc NEW YORK
Empno Ename Job Mgr Hiredate Sal Comm =
7782 CLARK MANAGER 7839 09-06-1961 2450.00
7839 KING PRESIDENT 17-11-1981 5000,00
7934 MILLER CLERK 7782 23-01-1982 1300.00
Deptno 20
Dname RESEARCH
Loc DALLAS
Empno Ename Job Mgr Hiredate Sal Comm
7369 SMITH CLERK 7902 17-12-1980 800,00
7566 JOMES MANAGER 7839 02-04-1981 2975.00 ;I
= |4:27 |14 10w selected in 0,04 seconds v

You can have multiple breaks for a report. The order by clause of the query must assure that the result
set is sorted on all break columns.

Sum
The sum property allows you include a sum for a field:

“* Report Window - select d.*, e.* from emp e, dept ... =lolx|
soL  Laout | mptions |

2 & [ AutoUpdate
| Item | Description | Stle | Header | Align | Format |Break [Sum |:|
¥ MER - - - -
¥ HIREDATE - -
v saL = S
[ COMM - -
Deptno 10
Dname ACCOUNTING B
Loc NEW YORK
Empno Ename Job Mgr Hiredate Sal Comm =
7782 CLARK MANAGER 7839 09-06-1981 2450,00
7839 KING PRESIDENT 17-11-1981 5000.00
7934 MILLER CLERK 7782 23-01-1982 1300,00
8750.00 0,00 LI
= [4:27 114 rows selected in 0,04 seconds v

You can specify that the sum is to be calculated at the break level, at the report level, or both.
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Page headers

To define a page header, you first need to set the page size (see chapter 12.6). The Report Title will be
repeated after each page break, and can include the following variables:

e OSUser — The Operating System user.

. DBUser — The user that is connected to the database.

. Database — The database that the user is connected to.

. Date — The current date.

. Time — The current time.

. Page — The current page.

To include such a variable in the page header, precede it with an ampersand. For example:

All employees (&dbuser@&database)
If you run the report connected as user scott to database chicago, the header will look as follows:
All employees (scott@chicago)

Since the report is formatted as HTML, you can additionally include HTML code. To include an image,
you could include the <img> tag:

All employees <img src=logo.gif>

To include left aligned, centered, and right-aligned information, you can use a single-row table with 3
cells, and include the information in the corresponding cell:

<table width="100%"> <tr> <td>&dbuser</td> <td align="center'>All
Employees</td> <td align="right'>&page</td> </tr> </table>

This will be displayed as:

[ Scott Al Employees 1]

Note that you can use these variables and HTML code in the description of all layout items, but they are
most useful for the Report Title.
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12.5 The Style Library

Instead of defining and redefining the same styles over and over again, you can press the Style Library
button on the toolbar to create and modify your standard styles. If, for example, you would like all fields
that contain SQL expressions to be displayed in Courier New, 12 points, blue, simply define a SQL style
with these properties in the library and apply it where appropriate.

There are a number of style names that have a special meaning:

Style name Description

Default Report Title Will be applied to the report title

Default Variables Will be applied to the variables

Default Tabular Tables | Will be applied to all tabular tables (e.g. detail records)

Default Form Tables Will be applied to all form tables (e.g. master records)

Default Field Style Will be applied to all fields that do not have a defined style
Default Field Header Will be applied to all field headers that do not have a defined style

These are default styles, so you can override them in an individual report by defining the style for the
corresponding layout item.

Note that all used styles (standard and custom) are stored in the report file. When a report is run and a
style needs to be applied, PL/SQL Developer will try to locate it in the in the style library. When it is
not available, the style from the report file will be used. This will ensure that your report will always

display correctly but that styles can still be overruled.

12.6 Options

You can specify various options for your report:

** Report Window - select d.*, e.* from emp e, dept d —|ol x|
S0L | Layout  Options |
Connect P; Securit ~Layout
Usemname | scott @ b IL_"me layaut
Password | £ Locked for other users SHimaran
@ Locked for all users O[3 Fieels
Database |chicago N
Top margin
Connect as |Nomal - IF:isjlm"j— 0 z Pixels
Iv Use this connection Page break
0 Z Lines
Background Image I gl I Only NESP
Background Color | [ Inchude SOL
Deptno 10 :II @
Dname ACCOUNTING B
Loc NEW YORK
Empno Ename Job Mgr Hiredate Sal Comm =
7782 CLARK MANAGER 7639 09-06-1981 245000 LI
= [1:18 114 rows selected in 0,04 seconds v

Connect Parameters

The Connect Parameters determine how the report query will be run. If, for example, it is necessary that
your report is executed under the SYS account, you can enter this name in the Username field. You can
additionally enter the Password, or you can leave it empty. If you leave it empty, you will be prompted
for the password when the report is executed. You can also specify the Database, if the report should
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always be executed in the same database instance. You can alternatively enter * in the database field,
which indicates that the report should be executed in the current database.

The Use this connection option allows you to disable or enable the Connect Parameters for a report. If it
is disabled, the current PL/SQL Developer connection will be used.

Security

The Security options allow you to lock the report definition (the SQL, Layout, and Options), so that a
user cannot view or change it. This may be useful if the Connect Parameters specify a privileged
account (such as SY'S) with password. If a user can change the SQL, he or she could execute any
statement under the SYS account if the report is not locked.

The Security can be set to one of the following values:
. Unlocked — Anybody can change the report definition.

. Locked for other users — You can only change the report definition if you know the report’s
Password, or if you are connected in PL/SQL Developer with the same account as specified in the
Connect Parameters.

. Locked for all users — You are always prompted for the report’s Password before you can change
the report definition, regardless how you are currently connected in PL/SQL Developer.

If the report is locked, the report file (.rep) is encrypted so that is cannot be viewed or changed with a
text editor.

Layout options

. Form layout — By default all records are displayed in tabular layout, except for master records,
which are displayed in form layout. By enabling this option, all records will be displayed in form
layout. This may be useful if each record has many and/or wide fields, that cannot be displayed on
asingle line.

. Left margin — The number of pixels for the left margin of the report. This option only works if you
are using the Internet Explorer as HTML viewer.

. Top margin — The number of pixels for the top margin of the report. This option only works if you
are using the Internet Explorer as HTML viewer.

. Page break — The number of lines after which a page break should occur. The report header will be
repeated after each page break.

. Only NBSP — When enabled, all spaces in the data will be converted to NBSP’s (non-breaking
spaces) in the HTML output. When disabled, normal spaces will be used. This can affect the
layout, because HTML viewers will display consecutive spaces as one space.

. Include SQL — When enabled, the SQL text of the report is included in the HTML output.

Other options

. Background image — The image (.jpg or .gif) that should be displayed in the background of this
report. You can use the Select file button to find your image file.

. Background color — The color that should be displayed in the background of this report.
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12.7 The Reports menu

By default the Reports menu item is included in the main menu, and contains only the standard reports.
These standard reports are located in the Reports subdirectory of the PL/SQL Developer installation
directory. The menu is simply a representation of this directory structure. Selecting an item from the
reports menu will execute that report.

You can add or remove reports in this directory, but you can also configure the reports menu through
the Configure Reports item in the Tools menu. This will bring up the following dialog:

2 Configure Reports m

Read Reports from

¥ Default Report directory -

FiCompanyRepors
KiUserstScotti PLSAL Developer\MyRepons

¥ Reports as main menu item

The Default Report directory option indicates whether the Reports menu should include the Reports
subdirectory from PL/SQL Developer installation directory. This directory contains the standard
reports. The edit field below this option contains a list of directories that should be included. You can
type directories manually, or you can select a directory by pressing the Add directory to list button on
the right.

Note that the report files and subdirectories will be merged in the Reports menu. You should try to
prevent duplicate subdirectory and report filenames within this directory list, otherwise you will get
ambiguous menu items in the Report menu.

The Style Library is also accessible from within this report configuration dialog (see chapter 12.5).
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13. Graphics

To quickly display a graphical representation of column data queried in a SQL Window or Report
Window, you can use the Graph Window. Consider the following query in a SQL Window:

= U E10 [Jiow selechedin 0001 seconds F

To see a graph of the salaries of the department you can press the Graph button:
i -

The same button is available on the Report Window. It will either start the Graph Wizard as described
below, or you can select a pre-defined graph style or template, and appropriate columns will be selected
for the X and Y axis.

The Graph Wizard will first allow you to select the data for the X-axis:

% Graph Wizard ol x|

Select field for the ¥ axis

[Index]
DEFTMO
EMPLOYEES
SALARY

< Brevious | Mest » | Finish I LCancel |

This shows all columns and an [Index] item, which is useful if you don’t have an X-axis value but want
to display data on the Y-axis in order of occurrence. In this case we want to display the salary by
department number, so we select DEPTNO and press the Next button to select the data for the Y -axis:

% Graph Wizard ol x|

Select data fields for the v axiz

[ Index]

[ DEPTHO
EMPLOYEES
SALARY

< Previous Finish LCancel
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After selecting SALARY for the Y-axis, you can press Next to select various graph style properties:

# Graph Wizard -0l x|

Select graph type

. b ] 75 ]
ElR| ¥

¥ 3D [ lrwert 34 axis
¥ Show legend ID Z] Fuirts per page
Title:

¥ Use template if available

< Previous | i [ | Finizh I LCancel |

After pressing Finish, the resulting Graph Window will be displayed:

8 graphics - select deptno, count(*) as employees, (o] x|

&

Qi KS@ e

10.000
5.000
8000
7.000
£.000
5.000
4.000
3.000
2000
1.000

o

10 20 0

The toolbar of the Graph Window provides the following functions:

Rotate — Press the left mouse button and move the mouse to rotate the graph around the X and Y
axis.

Move — Press the left mouse button and move the mouse to move the graph across the window.
This function is always available by pressing the right mouse button, regardless of the activated
toolbar function.

Zoom — Press the left mouse button and move the mouse to zoom in to and out of the graph.

Depth — Press the left mouse button and move the mouse to increase or decrease the depth of the
graph.

3D - Switch the graph between a 2D and 3D view.
Edit - Edit the graph data and layout.

Save as template — Saves the layout of the graph as a template for future graphs based on the same
column names. If you create a graph later and select From template from the Graph button popup
menu, then the layout information from this template will be used.

You can additionally print a graph or copy it to the clipboard by pressing the corresponding buttons on
the main toolbar.

PL/SQL Developer 9.0 User’s Guide
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14. Projects

To organize your work you can use PL/SQL Developer’s built-in project concept. A project consists of
a collection of source files, database objects, notes, and options. It allows you to work within the scope
of a specific set of items, instead of a complete database or schema. This makes it easy to find the
project items you need, to compile all project items, or to move a project from one location or database
to another.

A project keeps track of your desktop configuration. If you reopen a project, all items that were opened
when the project was previously closed will be opened at the same position. The AutoSave Desktop
preference must be enabled for this. This information is not stored in the project definition file
(Project.prj), but in the project desktop file (Project.dsk)

Note: to work with projects, the Use Projects preference must be enabled. If this is not the case, the

main menu will not contain the Project item. For all project menu items there are also corresponding
toolbar buttons, which can be added to the toolbar through the Toolbar preference page (see chapter

20.11).

14.1 Creating a new project

To create a new project, select the New item from the Project menu. This will bring up the Project
Options dialog:

¥ Project Options =10l x|

Items I Motes I To-Do \temsl

Connect P. Compile Options—————————

Usemame Iscott ™ Halt after first error

Databaze Ichicagn
Connect as I Mormal hd l

[~ Cornect when project is opened %

ok I LCancel | Help |

On the General page you can define how you want to connect when this project is opened. You can also
define if you want to continue project compilation after a compilation error has occurred.

The Items page allows you to view the project items. This can be source files of PL/SQL program units,
Test Scripts, SQL Scripts, Reports, and so on. A project item can also be an object that is stored in the
database, and that does not have a representation in a source file. Project items can also include other
files such as MS Word documents, HTML documents, and so on. When the project is first created, the
item list will be empty.

The Notes page allows you to maintain project notes. These notes can contain anything, such as a to-do
list, project decisions, design, and so on.

The To-Do items tab page shows the to-do items for the source files of the project. See chapter 15 for
more information about to-do items.



102 PL/SQL Developer 9.0 User’s Guide

14.2 Saving a project

After setting the options, you can save the project by selecting the Save item from the Project menu.
This will create a project file with the extension .prj. The project file contains the item specifications,
the options, and the notes. Therefore you need to save a project whenever you add or remove an item,
when you change an option, or when you change the notes.

Saving a project will not implicitly save the source files that are included in the project.

14.3 Adding files to a project
There are 2 methods to add a file to your project:

If the file is already opened in the IDE, you can simply select the Add to Project item from the Project
menu. For program files (which contain the source of PL/SQL program units), the item is implicitly
enabled for compilation. This means that when you make or build the project, this file will be included
in the compilation process. Other files, such as Test Scripts, SQL Scripts, Report files, and so on, will
not be enabled for compilation.

If the file is not opened in the IDE, you can press the Add file(s) button on the Project items toolbar and
select the files to add.

Note that the path of the file is stored relative to the location of the project file, if possible. For example,
if the file is located in the same directory as the project file, no path will be saved. If the file is located
in a subdirectory of the project file, only the subdirectory path will be saved. If the file is located
elsewhere, the full path will be saved. This makes the project easily ‘portable’ from one directory to
another.

14.4 Adding database objects to a project

To add a database object to the project, right-click on it in the Object Browser and select the Add to
Project item from the popup menu. Just like with Program Files, a PL/SQL program unit will implicitly
be enabled for compilation. Other objects, such as tables and sequences, cannot be compiled.

You can alternatively drag & drop a database object from the Object Browser to the Project Items
Window (see below).

If the current user owns the database object, the owner will not be saved in the project file. If another
user owns the object, the owner will be saved as part of the object specification. This makes the project
portable from one user to another.
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14.5 Working with project items

After adding items to the project, you can select Project Items from the Project menu to work with the
project items. The Project Items Window may look something like this:

=
Ll = R NN N
Al

|Sauroe filss | pata |

v employee spc
| |El ¥ employee.bdy
¥ dept_before_inserttrg
™ | emp_before_insert trg
| |ET T deptname st Open Rem
|_|&] T mgmameist Open all Items
| |E] [T employeesql Close all tems
—% ": ¥2gtg EE\‘;T Disable Compilation
| |%5 ™ SEQUENCE DEPTNO_SEQ
||| ™ SEQUENCE EMPNO_SEQ Move to Croup ™ ¥
Make
Build
Save Project
Close Froject
[ Project Options... :,,é

The first 4 Program Files are enabled for compilation. The 2 Test Scripts, the SQL script, and the tables
and sequences are not enabled for compilation.

You can keep the Project Items Window open at all times to have quick and easy access to all project
items. This window is part of the project desktop, and will implicitly be reopened when the project is
reopened.

To edit an item, you can simply double-click on it. If the item is a source file, it will be opened in a
corresponding window (Program Window, Test Window, and so on). If the item is a database object,
the appropriate editor will opened with the object definition. If an item is an external file, the
corresponding application will be launched (e.g. Acrobat Reader for a PDF file).

You can alternatively right-click on an item to bring up the popup menu as displayed above. Here you
can disable/enable the item for compilation, or you can remove the item from the project. If the item isa
database object, you will also have access to the object popup menu for that object as a submenu.

To change the order of the project items, you can click on the row header and drag it to the new
location. The order is not only visually important, but also determines the order of compilation.

To search for text in the contents of the project items, you can press the Find in Project button on the
project items toolbar, or use the Find item from the Project menu.

Item groups

You can use item groups to organize project items for larger projects. You can use these groups for
limited build and make operations, to limit searches, to open/close all items, and in general to get a
better overview. Items can only belong to one group, and will additionally belong to the special group
named All.

To switch between item groups you can select the corresponding tab page above the item list. Initially
there will only be a group named All. This is a special group that contains all items. To add a group,
right-click on a group tab page, select Add Group, and provide a name for the group. You can rename,
delete or move a group by right-clicking on its tab page and selecting the corresponding item from the
popup menu.
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To move an item to a group, right-click on it, select Move to group, and select the group from the
submenu. If you select None, the item will subsequently only belong to the All group. When adding a
new project item, it will implicitly be moved to the currently selected group.

14.6 Compiling a project

To compile a project, you can select the Build or Make item from the Project menu.

The Build function will simply compile all project items for the currently selected group that are
enabled for compilation. The items will be compiled in the order as they appear in the project item list.

If the compilation of an item fails, the project option Halt after first error determines if the project
compilation will continue or not:

Progress...

Compiling: employee.spc, Done
Compiling: emplovee.bdy. Done
Cormpiling: emp.rg, Errar

Build cancelled with errors

|Compwled: 2of14 Errors: 1 Time: 0.972 5

The Make function will only compile those items that have been changed since the previous
compilation. If a PL/SQL Program Unit is included as a database object, and it is invalid in the
database, it will also be recompiled. The timestamp of the compilation is stored in the project’s desktop
file. Items that are enabled for compilation but are up-to-date, will be listed as Skipped in the
compilation progress window.
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15. To-Do Items

You can use To-Do Items in any source file to make a quick note that something needs to be done in
this source file, and access this information later from the To-Do List. These To-Do Items are placed
into the source file as a comment with a specific format, at an appropriate location:

** program Window - Edit source of package _' — |0 il
P employee & employes |
[Packege body | [Function | [Sequence | [Sequence | [Comment 4 »‘
else :I
-- Fetch the name of the department

select dept.dname

into result

from dept, emp

where emp.empno = p_empno
dept.deptno = emp.deptno;

owner=

tegory="Optimize" priority="z - Medium" created="1

yuld only be generated i1f diagnostics are =nabled.
See diag.pck for more details."

dbms_output.put_line (to_char (sysdate, 'dd-mm-yyyy hh24:mi:ss') ||

- Department ' || rtrim(result) || —
! farchad far ! 11 temnlawes ' 11

% Edit To-Do Item _|O il
end if:

return (zes 1E%
exception dibms_output should only be generated if diagnostics are enablad
__ If tne [|Seediagpckiormare details |
when no_da
return (n
end;

—— Ratrnen th

e

Priarity IZ*MEd\um LI Category IOpt\mize LI Owner |Carall -

Created [18-06-2004 Closed |

0K | Cancel | Delete | Close item | Preferences | Help |

In this example you can see the comment in the source file (starting with the text TODO:) and the To-
Do Item editor where you can enter the text, priority, category, owner, creation date, and close date. The

contents of the selection lists for the priority, category and owner fields can be defined through a
preference (see chapter 20.25).

To-Do Items can be accessed through the To-Do Item editor, which is a convenient way to create, edit,

view or delete a To-Do Item. You can also edit the comment directly in the source file, as long as you
do not change the format.

Because the To-Do Items are stored as comment in the source file, they will always correspond with the
actual status of the source. Regardless whether the source comes from the database, from the file
system, or is an old version from a version control system.
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To access all To-Do Items for a specific source file you can invoke the To-Do List:

® To-Do List (=g

™ Lock_ ption -High Bill 4
[ Sortfunction needs additional testing for date -Medium| John 10-06-2004| 18-06-2004
™ dibms_output should anly be generated if diagnostics are enab 2 - Medium| Carall | Optimize | 18-08-2004
™ Implement some caching mechanism? 3-Low Bill Optimize  09-05-2004
™ Does not conform to standards. 3-Low Bill Fix 01-06-2004

Close |

Gota | Help

Here you can quickly find a To-Do Item and locate it in the source file by double-clicking on it or by
pressing the Goto button.

The To-Do List can be sorted by clicking on the column header.
Right-click on the list to copy, print, or export the To-Do Items.

15.1 Creating a To-Do Item

To create a To-Do Item, you first need to place the cursor at an appropriate location in the source file.
This is where the comment will be inserted, so it is important that this is near the location where the
work needs to be done. Next you can right-click at this location and select Add Item from the To-Do
Items submenu from the popup menu:

HTML Manuals F1 |
Query Builder
Show Lst..
Change Window to 4
i Edit Item...
HIELE Close Item
e Celete Item
Insert new program before »
Insert new program after 4
Insert Template 4
Delete program
Show contents

The To-Do Item editor mentioned above will appear, and you can enter the information for the new To-
Do Item. After pressing the OK button the comment will be inserted at the exact cursor location.

15.2 Editing a To-Do Item

To edit an existing To-Do item, you can either right-click on the corresponding comment in the source
file and select Edit Item from the To-Do Items submenu, or select the Show List item if you are not
currently near the To-Do Item you want to edit. In that case you can select the To-Do Item from the list
and press the Edit button.

Now you can changes the various properties of the To-Do Item and press the OK button to update the
comment in the source file.
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15.3 Closing a To-Do Item

A To-Do Item can be closed by right-clicking on the comment in the source file and selecting Close
Item from the To-Do Items submenu. Alternatively you can invoke the To-Do Item editor and press the
Close button.

15.4 Deleting a To-Do Item

A To-Do Item can be deleted by right-clicking on the comment in the source file and selecting Delete
Item from the To-Do Items submenu. Alternatively you can invoke the To-Do Item editor and press the
Delete button.

You can also simply delete the comment from the source file.
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16. The Connection List

The Connection List shows a list of connections that you have previously defined or that you have
recently used. From this list you can set the main connection, open windows for a connection, and view
current windows for a connection. You can create folders and subfolders to group connections in a
hierarchy.

16.1 Using the Connection List

By default the Connection List is docked in the top-left docking area:

Connections
o d =
.4
.4
& sys@newyork %
~§2) sys@chicago %
1 New York
- 2 sys@newyork %
=1 Recent
E@ scott@chicago ¥ 4
- -] DBMS Scheduler
SQL Window - emp.sql
“E] TestWindow - New
& sys@newyork %
& jones@chicago .4
i3 sys@chicago 'y

At the top of the Connection List you see a button to refresh the list, to expand and collapse the tree
view, and a button to define folders and connections (see chapter 16.2).

The first items in the Connection List are the user-defined folders. These folders can hold connections
that are explicitly defined in the folder, and/or connections that are implicitly added as a result of the
criteria of the folder. The Recent folder shows all connections that you have recently used.

Each connection can have a grey color if it is implicitly added, or a user-defined color if it has been
explicitly defined. Under each connection you can view and manipulate the windows that have a
corresponding database session.

The key icons behind each connection shows the status of the connection:

“  The password for the connection is known, and there are one or more database sessions for the
connection.

The password for the connection is known, and there are no database sessions for the connection.

The password for the connection is unknown. When trying to connect you will be prompted for
the password.
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Connection functions
Right-clicking on a connection will show the following popup menu:

New 4
Open 4
Reopen 4
Tools 4
Reports v

Show All Windows
Close Al Windows

Connect...
Connect as Main
Disconmect
Remove

e  The first5 items allow you to open windows for the selected connection. For example, if you want
to run a report using a specific connection, right-click on it, click on the Reports menu item, and
select a report from the submenu.

e The Show All Windows item will display windows that belong to the selected connection, and will
minimize all windows that belong to other connections.

e The Close All Windows item will close all windows that belong to the selected connection.

e The Connect item will make a connection to the database. If the password is unknown you will
first be prompted.

. The Connect as Main item will make the selected connection the main connection. You can also
double-click on a connection to make it the main connection.

e  The Disconnect item will log off all sessions associated to the selected connection. This includes
all windows for the connection.

e  The Remove item is only enabled for implicitly added connections. It allows you to clean up the
Recent folder for connections that you do not frequently use.

Folder functions

Right-clicking on a folder will show the following popup menu:

Show Al Windows
Close Al Windows

e The Show All Windows item will display windows that belong to the connections of the selected
folder, and will minimize all windows that belong to other connections.

e The Close All Windows item will close all windows that belong to the connections of the selected
folder.
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Window functions

Right-clicking on a window will show the following popup menu:

Activate

Close Window

Minimize

Change Connection *
Rename...

Short Text

Execute

From this popup menu you can activate, close, and resize the window to a normal or minimized state.

You can change the connection of a window by selecting it from the Change Connection submenu.

Furthermore you can rename a window. This can be useful if you just created a new window and want
to provide a meaningful name instead of, for example, SQL Window — New.

The Short Text item will switch to shorter descriptions. For example, the description “Program Window
- employee.pck™ will be shortened to “P - employee.pck™.

To execute a window, you can select the Execute menu item.

16.2 Defining folders and connections

To define your own folders and connections you can press the Define Connections button at the top of
the Connection List. The following dialog will appear:

15/

(20 NewYark

- i

~Definition

Displayname

Image

|Scott I@ “rellow Vl
Usemarme Database
|Scott Ichicago LI
Password Connect as

I

[ Identified extemally

INDrmaI LI

QK Cancel
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At the right you can see buttons to create a new connection, to create a new folder, to delete the selected
connection or folder, or to move it up or down. You can also move an item by dragging & dropping.
Defining a folder

To define a folder, press on the New Folder button and enter the information in the Definition section.
For example:

Definition
Displayname Image
|Chicag0 IWL,
Usermame Database
|| IChicagD LI
Connectas

| [~

The Displayname and Image will be displayed in the Connection List.

The Username, Database, and Connect as fields can be used to implicitly add connections to the folder.
For the example above all connections made to the chicago database will implicitly be added to the
Chicago folder. You can use * and ? wildcard characters for the Username and Database fields.
Specifying sys* for the Username will implicitly add all connections for usernames that begin with sys.
If you leave these fields empty, connections need to explicitly be added to the folder.

Defining a connection

To define a connection, press on the New Folder button and enter the information in the Definition
section. For example:

—Definition
Displayname Image
|scott I@ ellow VI
Usernarme Database
Iscuﬂ Ichicagcl LI
Password Connect as
I“‘“‘“‘" INDrmaI LI
[ Identified externally

The Displayname and Image will be displayed in the Connection List.

The Username, Database, Password, Connect as and Identified externally fields can be used to define
the logon information for the connection. If you leave the Password empty, you will be prompted for
the password whenever the connection is used for the first time in a PL/SQL Developer instance.
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17. Connections, windows, sessions and transactions

PL/SQL Developer provides a multi connection / multi session / multi threading environment.

Multi connection means that you can connect with different accounts to different databases from within
the same PL/SQL Developer IDE instance. All windows can be for different connections, and will show
the connection at the bottom left in the status bar. You can change the connection of a window by
clicking on it and selecting a different connection from the list.

Multi session means that even for the same connection, separate database sessions can be used for the
Test Windows, SQL Windows and Command Windows. Moreover, program unit compilations will also
occur in a separate database session. After all, a compilation is a DDL statement and implicitly commits
the current transaction. This could lead to unwanted effects if it shared the same session with other
windows.

Multi threading means that execution of Test Windows, SQL Windows and Command Windows can
run simultaneously, without blocking each other. The advantage of this is that you can continue doing
other work while long running SQL statements are executing, that you can break or kill a session, that
you can test locking behavior of your program units, and so on.

17.1 The main connection

The main connection is used for all functions in PL/SQL Developer where you do not explicitly select a
connection. For example, when opening a new SQL Window and executing a query, you will implicitly
create a database session for the main connection. The Object Browser will also use the main
connection.

After logging on in PL/SQL Developer you have implicitly set the main connection. The main
connection can be changed by using the Session > Log on function again, or by double-clicking on a
connection in the Connection List. In the Connection List the main connection is displayed in bold.

17.2 Window connections

All windows can be for different connections, and will show the connection at the bottom left in the
status bar. You can change the connection of a window by clicking on it and selecting a different
connection from the list:

i - + Compiod atlly

17.3 Session mode

Multi threading implies that you need a multi session environment. After all, the Oracle Server can only
execute one statement at a time for any given database session. Things can only run simultaneously if
they run in different sessions. Not all development environments allow for an unlimited amount of
sessions, so that a preference can be set (see chapter 20.2) that controls the amount of sessions that
PL/SQL Developer will use. This preference is called the Session mode, and can have one of the
following values:

. Multi session - Each Test Window, SQL Window and Command Window will have its own
session, and another session will be used for compilations. This is the most flexible setting, and
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will obviously lead to the largest amount of database sessions. Another possible disadvantage is
that updates in Window X will only be visible in Window Y after they are committed.

. Dual session - The Test Windows, SQL Windows and Command Windows belonging to the same
connection will share one session, and another session will be used for compilations.
Disadvantage of this mode is that only one window can execute at a time for a given connection.

e Single session - All windows and all compilations for the same connection will use the same
session, making transaction management difficult. The debugger is disabled in this mode. Only
use this setting if you are restricted to using one database session.

17.4 Execution in Multi session or Dual session mode

When you execute a Test Window, SQL Window or Command Window in Multi session or Dual
session mode, the Break button on the toolbar will be enabled so that you can break execution at any
time. A break may not always be successful, for example in case of a locking situation. In that case you
can resort to the Kill item in the Session menu, if you are privileged to do so.

If you move the mouse cursor of a currently executing window, its shape will change to indicate that it
is executing and you cannot make any modifications to the contents of that window.

After execution is finished, the Commit and Rollback button will be enabled if a transaction has been
started. In Multi session mode, each window has its own session, and therefore also has its own
transaction. The Commit and Rollback button will reflect the transaction status of the topmost window.
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18. Browsing objects

When you are developing a program unit in an Oracle database, it will always access other database
objects. After all, if this would not be the case the program unit has no right to be in this database at all.
To write such a program unit, you need to know exactly how these other database objects are defined.
Therefore, questions like the ones listed below will be very familiar to an Oracle programmer:

e  What is the data type of this column?

What is the primary key of this table?

What exactly was the name of that packaged function?

What is the default value for this parameter?

Which conditions cause this trigger to execute?

Which objects call this function I'm working on?

. Et cetera...

All this information is available in the Oracle dictionary and accessible from within PL/SQL Developer
by using the Object Browser.

18.1 Using the Object Browser

You can make the Object Browser available by selecting the Object Browser item in the Tools menu.
The Object Browser shows all base object types in the database for the main connection that are
relevant to developing program units. You can navigate through this tree view in the same way that you
use the Explorer in Windows to navigate through folders. Opening the Tables folder displays all tables
that are accessible by the current session. Opening a specific table folder shows all relevant properties
of this table. Opening the Foreign keys folder under a table displays all foreign keys for this table, and
so on. The Recent objects folder contains all objects that you have recently used in PL/SQL Developer.

Eizz EEES  \Whenever you open a folder, the information queried from the

E® =G dictionary is read into memory to make subsequent accesses as

| cuemenT s> =l quickly as possible. To force the Object Browser to re-guery this
2 q yasp ] query

o information after something has changed, you need to select the
modified object and press the Refresh button at the upper left side

(B Recent objects 1 . . .
&-@8 Recycle bin of the window. You can also refresh an object by selecting the
-3 Functions corresponding item from the popup menu. To refresh the entire
& Procedures Browser, press the Ctrl key when pressing the Refresh button.
[0 Packages
"g ?ackage bodies You can drag and drop objects from the Object Browser into the
es . . . . . . . e
=0 T,‘:Ee bodies workspace. This will bring up an editor with the obJec_t definition.
g Triggers You can set a preference to control exactly what function should
Java sources
E o e be performed (see chapter 20.12).
E guﬁe”‘ui;“’bs You can also drag and drop an object from the Object Browser
2 Queue tables into an editor. Th_is will bring up a popup menu, whose contt_ants
[ Libraries —1 depend on the object. You can select to copy the name (prefixed
-0 Diractories by the owner if necessary), properties, description, and other
E-23 Tables

relevant text into the editor, at the location where you drop it. If
you drag and drop a folder into an editor, all object names in the
folder will be copied. These object names will be comma
separated. You can set a preference to control if the object names
are placed on one line or on multiple lines (see chapter 20.13).

553 Primary key

= wa PK_DEPT By pressing the right mouse button on an object icon, a context
=& Colurmns sensitive popup menu appears that allows you to perform other
L.[@ DEPTNO - o A - :
& Unique keys functions on this object. The functions from this popup menu are

o[ Foreign keys =l described in the following paragraphs.
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You can select multiple objects by using the Control or Shift key during selection. If multiple objects
are selected, the object popup menu will show only those items that are applicable to all selected
objects, and the drag and drop function will work on all objects simultaneously.

You can press Ctrl - and Ctrl + to quickly align the width of the Object Browser with the contents.

The Object Browser preferences (see chapter 20.12) allow you to define which folders are visible, and
in which order they are displayed. It also allows you to define the maximum number of objects that can
be visible in the Recent objects folder. Furthermore you can define the double-click action for a browser
object. By default this will expand the corresponding node, but you can also define that this will bring
up the object definition editor, or the properties window.

Filtering and searching objects

To limit the number of object in the Object Browser, you can use the User selector and Filter selector at
the top of the Object Browser. You can also search for specific objects by name.

When selecting a user, only the objects owned by that user will be displayed. Select <CURRENT
USER> to see only the objects owned by the currently connected Oracle user. Select <ALL USERS> to
see objects owned by any user. Note that this can degrade performance when opening a folder.

Select a filter to limit the objects to those that meet specific criteria. The filter also defines the sort order
of objects within a folder. See chapter 18.2 on how to create your own filters.

To search for an object by name, enter part of its name in the search text field and press Enter. Only the
currently opened folders will be searched.
Creating a new object

To create a new program unit, table, view, sequence, or synonym, right click on such an object or on the
root folder of this object type and select the New item from the popup menu.

Using the New function for a program unit will create a new Program Window. The initial contents are
taken from a specific template, as described in chapter 26.

Views can be created in a SQL Window. The initial contents are taken from a specific template, just like
with program units.

Tables, sequences and synonyms will be displayed in a specific editor window. The table, sequence and
synonym editors are described in detail in chapter 9.
Duplicate an object

You can duplicate a table, sequence or synonym by selecting the Duplicate item from the popup menu.
This will invoke an editor window with all properties of the selected object, except for the name. This
can be useful if you want to create a similar table to perform some tests on.

Copying an object or folder

To copy the name of an object or the names of the objects in a folder, select the Copy comma separated
item. This will place the name(s) on the clipboard. You can set a preference to control if the object
names are placed on one line or on multiple lines (see chapter 20.13).

Viewing object properties

To view the properties of a specific object select the Properties item from the popup menu. The actual
properties you see depend on the object type and version of your Oracle Server.
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Property l\/a\ue

b OWINER PSCOTT
CONSTRAINT_NAME | EMP_MGR_FK

: CONSTRAINT_TYFE R

|| TABLE_NAME ERP

| |R_OWNER SCOTT
R_CONSTRAINT_MNAME EMP_PK

| |DELETE_RULE WO ACTION

: STATUS ENABLED

| |DEFERRABLE NOT DEFERRABLE

| |DEFERRED IMMEDIATE

| |vALIDATED WALIDATED

| |GENERATED USER NAME

| |[LAST_CHANGE 12-12-1999 16:12:38

The properties are displayed in a modal window that you can place anywhere on the screen. You can
keep a property window visible (it will stay on top of other windows) and continue editing in another
window. You can additionally roll-up and roll-down the window by pressing the button on the upper-
right of the window. This way you can easily make space for other things, and keep the properties
available.

Viewing object descriptions

Tables, views, functions, procedures, packages, types and methods can be ‘described' in a way familiar
from SQL*Plus by selecting the Describe item from the popup menu. The description will be displayed
in a modal window like the previously mentioned property window.

For tables and views all columns and their respective properties are displayed in a property window. For
functions, procedures and methods, the parameters and their properties are displayed. For packages, the

functions, procedures, variables, types, variables, constants and exceptions are displayed. For types, the

methods and attributes are displayed.

MName Type Mullable | Default Cornments

EMPNO - MUMBER(4) The 4 digit number of the employee
ENAME WARCHARZ(10) Y The last name of the employee

JOB WARCHARZ(Y) v 'CLEREK! The job of the employee

MGR NUMBER(4) s The nurber of the manager

HIREDATE DATE s truncisysdate) The date onwhich the employes was hired
SAL NUMBER(7.2) The salary afthe emplovee

COMNM NUMBER(Z.Z) Y The commission of the employee
DEPTHND  NUMBER(Z) e The 2 digit nurnber of the deparment

You can select rows, columns or ranges of cells in a description window. To select rows or columns,
just click on the row heading or column heading and drag the mouse pointer to highlight the selection.
To select a specific range of cells, move the mouse pointer over the left edge of a cell until its shape
changes, press the mouse button, and drag the mouse to highlight the selection. The selection can be
copied or printed. To make a comma delimited copy of the selected cells, right-click on the window and
select the corresponding item from the popup menu. To export the description to a CSV, TSV, HTML
or XML-file, select the corresponding item from the Export submenu. To print the contents of a
description window, select the Print item.

By double-clicking on a cell in a description window, the contents of the cell will be copied into the
editor of the topmost window.

To sort the rows in a description window, press the heading button of the column on which you want
the rows to be sorted.
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Viewing an object definition

All object types have some kind of definition. To view this definition, you can select the View item
from the popup menu. This item is available for all program units, views, tables, sequences and
synonyms. If you select the View item for a table element such as a column or index, it will display the
table definition and navigate to the selected element.

Program units will be displayed in a Program Window, views will be displayed in SQL Window, and
tables, sequences and synonyms will be displayed in a specific editor window. The table, sequence and
synonym editors are described in detail in chapter 9.

Editing an object definition

You can edit an object definition straight from the database by selecting the Edit item from the popup
menu. You can disable this feature through a preference, as described in chapter 20.2.

Renaming an object

Tables, views, sequences and synonyms can be renamed by selecting the Rename item from the popup
menu. If you are using Oracle 9.2 or later you can also rename columns. A dialog will appear with the
old name, which you can modify and apply.

Dropping an object

Sometimes it is necessary to drop an object. It may have become obsolete, or must be changed from one
type to another (e.g. from a function to a procedure). To accomplish this, just select the Drop item from
the popup menu.

Browsing a related object

Most objects have either referencing or referenced objects. By selecting the Browse item you can
quickly locate a related object in the Object Browser.

Recompiling an object

Objects often reference other objects in the database. Whenever these referenced objects change, the
referencing object can become invalid. In this case a red mark is displayed in the icon of this object. To
recompile an invalid object, select the Recompile item from the popup menu. If compilation succeeds,
the mark disappears. If compilation fails, you can view the errors by selecting the View item from the
popup menu.

Adding an object source to an editor

The source file of a program unit can be added to a Program Window or Test Window by selecting the
Add source to editor item.

For a Program Window, the source will be added on a new page after the current program unit. This
way you can create a Program File that contains several program units that already exist in the database.

For a Test Window, the source will be added after the currently selected source during a debug session.
This way you can include a source in the Test Window and subsequently set or remove breakpoints
before actually stepping into the program unit.

Adding debug information to an object

If you want to view or set variable values during a debug session, the object that contains these
variables needs to contain debug information. You can manually add debug information by selecting the
Add debug information item. This menu item has a checkmark that indicates whether the object already
contains debug information. The debugger preference section contains an option to automatically add
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debug information when a program unit is compiled, in which case you only need to use this item for
program units that you do not have in development.
Viewing and setting PL/SQL Conditional Compilation Flags

Use the PL/SQL CCFlags menu item to view or set the Conditional Compilation Flags of a program
unit:

x|
Name WValue +
}| debug true
trace false B
log_level 6 ¢
*

Close |

On this screen you can see the current flags of the program unit. You can also change the values of
flags, rename flags, add new flags, and delete existing flags. Press the Apply button to apply these
changes to the database object. Note that this will cause an implicit recompilation of the program unit,
and can cause it to become invalid.

Recompiling referencing objects

When you alter an object that is referenced by other program units or views, these referencing objects
will become invalid. Recompiling them will make them valid or will bring any incompatibilities to
light, which can easily be accomplished by selecting the Recompile referencing objects item. This will
bring up a Compile Invalid Objects Window, which will immediately be executed. More information
about this tool can be found in chapter 21.3.

Testing a program unit

To test a program unit (a standalone function or procedure, a packaged function or procedure, or an
object type method) you can use Test Scripts, which are described in detail in chapter 5. A Test Script
will generally contain a simple function or procedure call. You need to set input parameters and view
output parameters and function results after executing the Test Script. From the Object Browser you can
select the Test item to create such a Test Script.

Querying tables and views

To view the data in a table or view, select the Query data item from the popup menu. A SQL Window is
created with a select statement for the table or view currently selected in the Object Browser. If you
have the AutoExecute SQL Window preference enabled, the select statement will immediately be
executed.

Editing table data

If you want to edit the data in a table, you can select the Edit data item when the table is selected in the
Object Browser. A SQL Window will be created with a select statement that includes the rowid. If you
have the AutoExecute SQL Window preference enabled, the select statement will immediately be
executed. The SQL Window is immediately in edit mode after the records are fetched.
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Exporting tables

To export the definition and data of a table, select the Export data item. This will bring up the Export
Tables tool for the selected table. See chapter 21.4 for details.

Enabling and disabling triggers and constraints

Triggers and constraints can be enabled or disabled from within the Object Browser by selecting the
Enable or Disable item from the popup menu. Disabled triggers and constraints are displayed grayed
out.

Running a job
For jobs, submitted through the dbms_job package, you can explicitly run it by selecting the Run item
from the popup menu.

Enabling and disabling enqueuing and dequeuing

For queues you can enable and disable enqueue and dequeue operations by selecting the corresponding
item from the popup menu. A checkmark before the menu item indicates whether the operation is
currently enabled.

Adding an object to a user defined folder

To add an object to a user defined folder (see chapter 18.3), select the Add to folder item and
subsequently select a folder from the submenu.

Restoring or purging an object

If you are using Oracle10g or later, you can restore or purge tables that you have previously dropped, if
this feature is enabled in the database. From an object in the Recycle bin folder you can select Purge to
permanently drop the table and its data, or you can select Restore to restore it under the original name or
under a new name,
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18.2 Object Browser Filters

You can define filters that determine which objects are visible in the system folders of the Object
Browser, and in which order these objects are displayed. A select list is located at the top of the Object
Browser that allows you to quickly switch between the various filters.

Object Browser Filters can be defined by selecting the Object Browser Filters item in the Tools menu or
by pressing the Filters button above the Object Browser. You can modify, create and delete filters in
this dialog:

* Define Browser Filters x]
All objects i
Al non-systern objects
My objects ¥3
b —
iy imvalic objects &
All objects modified today
Demo Objects (scotti@chicago) ¥

Definition

Description IMy objects + sys.packages I Default

gserl (User@Database)

where clause | Order By clause I

awener = user =
or (owner = 'SY5' and object_type = 'PACKAGE")

Cancel |

A filter is made up by the following properties:

. Description.
This description shows up in the select list at the top of the Object Browser.

. User.
Defines for which Oracle user this filter is valid. If you leave this field empty, the filter will be
valid for all Oracle users. If you specify a user and database (e.g. scott@chicago), the filter will
only be visible if you are logged on as this user and database.

. Default.
If you check this option, the selected filter will be the activated when you start PL/SQL
Developer. You can define a default filter for each user. The default filters are displayed in bold.

e Where clause.
A filter defines a select statement on the all_objects (or dba_objects) view. The where clause can
be used to restrict the result set of this select statement. You can use the following columns:
. owner - the owner of the object
. object_name - the name of the object
. object_type - the type of the object (TABLE, VIEW, PACKAGE, and so on)
. status - the status of the object (VALID or INVALID)
. created - the date/time that the object was created
. last_ddl_time - the date/time that the object was most recently compiled
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. Order by clause.
Use the columns from the all_objects view to order the objects in the Object Browser.

18.3 Object Browser Folders

The folders of the Object Browser can be customized in several ways. You can change the order of the
folders in the Object Browser, the color of each folder, a folder hierarchy, and you can hide specific
folders based on your current connection.

You can also define your own folders and populate them with objects. You can either explicitly add
specific objects to a folder, or define a query to populate it, or a combination of both. The query will be
executed when the folder is opened in the Object Browser.

Browser Filters can be defined by selecting the Object Browser Folders item in the Tools menu or by
pressing the Folders button above the Object Browser. You can modify, create and delete folders in this
dialog:

¢ Define Browser Folders _|olx]
Recent objects a
Recycle bin a
Invalid objects ¥a
PLfSQL Program units B
Functions s
Packages
Procedures LI +
Definition
Type IUserDefmed Falder LI Calor Ia Red j ¥ wisible
Description IInVaIid ohjects
Connection I (User@Database)
EE"BNI LI Clear
I Suppress owner
Where clause | Orderﬂyclausel ijemsl
status = 'INVALID' =
El
QK | Cancel Help |

At the top of this dialog you see all folders and their hierarchy. A red color indicates a system folder, a
black color indicates a user defined folder. Some restrictions apply to system folders.

To the right of the folder list you have 4 buttons available to add a new folder at the position of the
currently selected folder, to delete a folder, or to move it up or down in the list. The order in the Object
Browser is the same as the order in this list.

At the bottom you can change the definition of the currently selected folder:
e  Type — Shows the type of the folder: User Defined or System.

. Color - Select the color of the folder. Subfolders of objects in this folder will inherit the same
color.
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Visible — Disable this option to make the folder invisible in the Object Browser. This can be used
to hide specific system folders, and overrides the Connection option.

Description — The description of the folder in the Object Browser. Cannot be changed for system
folders.

Connection — Defines for which Oracle users this folder will be displayed. If you leave this option
empty, the folder will be displayed for all Oracle users. If you specify a user and database (e.g.
scott@chicago), the folder will only be visible if you are logged on as this user and database. You
can use ? and * wildcard characters to match multiple users. For example *@prd for all users in
the prd database.

Parent — To hierarchically place a folder within another folder, you can select its parent from the
list. To clear the parent, press the Clear button.

Suppress owner — When enabled, the Object Browser will not display the owner of the objects in
this folder. This is primarily useful for folders where the owner is known from the context (for
example: “Scott’s tables and views”).

Where clause — The where clause can be used for query based folders to restrict the selection of
objects. In the example above, the where clause is set to status = ‘INVALID’ to populate the
folder contents with all invalid objects.

Order By clause — The order by clause can be used for query based folders to define the sort
order of the selected objects.

Objects — For manual folders you can define list of objects. You can place an object on each line
in an owner.name format. For example: SCOTT.EMP. Note that it is usually more convenient to
add an individual object from the Object Browser by right-clicking on it and selecting Add to
folder from the popup menu.

The where clause and order by clause can include any SQL expression and any column from the
all_objects view. This works the same as for Browser Filters. See chapter 18.2 for more details.

Note that filters do not affect the object contents of user defined folders.



PL/SQL Developer 9.0 User’s Guide 123

19. Browsing files

If you frequently access source files and scripts from a limited set of locations (e.g. project directories,
tool directories, and so on), you can use the File Browser for quick and easy access. Instead of opening
a file selector to open or save files, you can access them directly from PL/SQL Developer’s work area:

2¢ PL/SQL Developer - scott@chicago o [=] ]

File Project Edit Session Debug Iools Macro Documents Reports Window Help

B E-Ea s s malaaa- B eaw @@
8- @ | Sas al-e
: :
Objects Fﬂas‘ #F Command Window - DemoBuild.sql _|ol x|
Dialog Editor |
Sl A=l SET TERMOUT ON B
Dﬁ_&eptEmp Project PRCMET Building demonstration tables. Please wait.
& Data SET TERMOUT OFF
(2 Documents
: DemoBuild.sql DROP TABLE EME;
DemoDrop.sql DROP TABLE DEFT;
[E] Department bdy DROP TABLE ECNUS;
Departmentspe DROP TABLE SALGRADE:
+[E DeptEmp.pdd DROP TABLE DUMMY;
i-[E] Employee.bdy
. E] Employee. spc CREATE TABLE EMP
(2 Research Project (EMPNO NUMBER (4) NOT NULL,
7 (11 Exported Scripts ENRME VARCHAR2(10),
#- 3 Utilities JOB VARCHAR2(9) ,
o Temp MGR NUMBER (4) ,
HIREDATE DATE,
SAL NUMBER(7, 2),
COMM NUMBER(7, 2), =
== O [ECH [TRM [FDB [VER [APR [HDG [T/C [u » [ 7

|Find

b I BN,

From the File Browser tree you can access files and directories from user-defined locations on the local
computer or on the network. You can quickly open, save, rename, and delete files here.

You can use the File Browser as a docked or floating tool. See chapter 28 for more information about
dockable tools. By default the File Browser is located on the second tab page of the docking area of the
Object Browser.

& Ty e gm ke
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19.1 Setting up the File Browser

When the File Browser is first displayed, it will initially be empty. To populate the File Browser, you
must first define one or more File Browser Locations. To do so, select File Browser Locations from the

Tools menu, or press the Locations button at the top of the File Browser. The following screen will
appear:

2¢ Define File Locations _ o] x|
Research Project E
Exparted Scripts far}
Utiliies —
Temp
+

—Definiti

Path

IS splstDeptEmp =

¥ Include subdirectories

Include file fiter [8.9. *sql; *omd]

Exelude file fiter

[fies.info; =~

Description Calar
IDEptEmp Froject |a Fed Ll
Parent
LI Clear I
o |

Each location you define here is displayed in the root of the File Browser tree. For each location you
can define the following properties:

Path — The local or network path where the files and directories are located. The File Browser tree
will display files and directories from this starting point.

Include subdirectories — When enabled, subdirectories from the path will be displayed in the File
Browser tree and can be traversed.

Include file filter — One or more file filter expressions to explicitly include in the File Browser
tree. Separate multiple filter expressions with a semi-colon (e.g. *.sql; *.cmd). If this property is
omitted, all files will be included.

Exclude file filter — One or more file filter expressions to explicitly exclude in the File Browser
tree. Separate multiple filter expressions with a semi-colon (e.g. *.tmp; *.dat). If this property is
omitted, no files will be excluded. By default this property will exclude files.info and *.~*. The
first excludes a PL/SQL Developer system file that contains file state information, and the second
excludes PL/SQL Developer backup files.

Description — The description of the location that is displayed in the File Browser tree.
Color — The color of the icon of the location and its subdirectories in the File Browser tree.

Parent — The parent location of this location. When selected, this location will not be displayed in
the root of the File Browser tree, but as a sub location of the parent location.

You can create, delete and sort the locations by using the corresponding buttons to the right of the list.
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19.2  Using the File Browser

After you have defined your File Browser Locations, the File Browser will display all your files,
subdirectories and sub locations in a tree view. Double-clicking on an file will open it in the work area
in edit mode. Right-clicking on a file will show the following popup menu:

Files EEE

Objects Filesl'.'-,'indn'.'-lisl gf' Command Window -
¢ F = & Dialog Editor |

=23 DeptEmp Project SET TERMCUT CN

+-(@ Data
(@ Documents
DemoBuild.sg

DemoDrop.sg
Departmentbc Open as y |F7

PROMPT Building «
SET TERMOUT OFF

Departments ) ;
DeEtEmp pddF e Wth"' E’E.’S
Employee bdy ‘Open in Explorer... LGR!I
‘2] Employes spc Rename...
[0 Research Project Create fil... PMY,
(0 Exported Scripts  Create subdirectory...
-3 Utilities Delete EMP
& Temp (4)
Save window in "DeptEmp"... 2 (1(
Save window as "DemoBuid.sql" 9),
Info I
. -
Properties... 12,

| |f‘OM'M- “f'"MRFF (7. 2

. Open — If the current item is a file, it will be opened in edit mode. If the current item is a directory
or location, the tree view node will be expanded.

. Open as — Shows a submenu where you can open the current file as a Program Window, SQL
Window, or Command Window.

. Open with — Open the file with any program.

. Open in Explorer — Opens the Windows Explorer for the selected file or directory.

. Rename — Rename the current item.

. Create file — Create a new file in the current location or directory.

. Create subdirectory — Create a new subdirectory in the current location or directory.
. Delete — Delete the current file or subdirectory.

. Save window in “name” — Saves the contents of the current (topmost) window in the currently
selected directory or location. This allows you to quickly save the contents at the selected location,
regardless of its origins (newly created, from the database, or from elsewhere on the file system).

. Save window as “filename” — Saves the contents of the current (topmost) window as the
currently selected file. Note: this will replace the contents of the current file.

. Info — This submenu shows the full path, timestamp, and size of the current file.

. Properties — Shows the properties of the file or directory. The properties dialog additionally
allows you to set attributes and permissions.

Read-only files will be marked with a red sign in the file icon (Department.spc and Employees.spc in
the example above).

If files are created, deleted or renamed by other tools than PL/SQL Developer, the File Browser will
automatically update its contents.
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20. Preferences

The Preferences tool allows you to set various preferences for PL/SQL Developer. When you select this
item, the following dialog appears:

| =10]x]

I_@’ Default Mark

u R
[ Session Mode
Output ® Multi session
Trace (" Dual sesion
Profiler
Logan Histary " Single session
User Interface 2 |

Logoff with open transaction
Ask hd

Window Types A

Tools -
Files v .| [~ Check connection
Other = ]
Oracle Home (empty is autodetect)
| =
L eTe library (empty is autodetect)
| =

'| [~ Force OCI7 mode on OCI8

oK I Cancel | Apply |

At the left you can select a preference page from one of the 6 categories (Oracle, User Interface,
Window Types, Tools, Files, and Other).

At the top you can select a preference set, which defines a set of preferences at a certain level. By
default you will define personal preferences for your Windows user (in the screenshot above for the user
Mark), but you can also define personal preferences for a specific Oracle connection. Whenever you use
such a connection to logon to the database, the corresponding preference set will be used. Furthermore
your system administrator can define default preferences at a global level and at Oracle connection
levels. For detailed information about preference sets, see chapter 20.34.

Below the preference sets you see the preferences for the currently selected preference page (in the
screenshot above for the Oracle — Connection page). For each preference you will see the current value.
A green indicator to the left of the preference indicates that the value is set in the current preference set.
If the indicator is black, the value is inherited from a different set (hold the mouse cursor over the
indicator to view the preference set name). To revert a preference to its inherited value (in other words:
remove it from the current preference set), you can click on the green indicator.

The following chapters will describe each preference page in detail.
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20.1 Oracle — Connection

]

Session Mode
@ hulti session
(~ Dual sessian

" Single session

Logoff with open transaction
Agh VI

| [~ Check connection

B Oracle Home (empty is autodetect)

| ||

O librany (empty is autodetect)

| -

'| [~ Force OCI7 made on OCIE

Multiple Connections

.| [+ Allow multiple connectians

. [ Store recent histary

[~ Store with password

Session mode.
Controls how many separate database sessions PL/SQL Developer will use. This feature is
described in detail in chapter 17.

Logoff with open transaction.

When a session is logged off and this session has an open transaction, the default action is to
commit that transaction. Through this preference you can define that such an open transaction is
rolled back, or that you will be asked for confirmation.

Check Connection.

When this option is enabled, PL/SQL Developer checks every 60 seconds if your database
connection is still alive. If your session is killed or the server is shutdown, PL/SQL Developer will
automatically logoff.

Oracle Home.

By default PL/SQL Developer will use the Primary Oracle Home on your PC. You can define the
Primary Oracle Home with the Oracle Home Selector (a standard Oracle utility). You can force
PL/SQL Developer to use a specific Oracle Home by selecting one from this list.

OCI Library.

PL/SQL Developer will use the most recent version of SQL*Net or Net8 that is installed. If this
version of SQL*Net or Net8 causes problems, you can force PL/SQL Developer to use another
version. The DLL name will be something like ora72.dIl (SQL*Net 2.2), ora73.dll (SQL*Net 2.3),
oci.dll (Net8 8.1.x), and so on. These DLL's are located in Oracle's bin directory.

Force OCI7 mode on OCI8.

Some releases of Net8 (8.0.3 and 8.0.4) have some bugs that might cause problems in PL/SQL
Developer. Setting this preference will cause the more solid SQL*Net 2 functions of Net8 to be
used instead. One example of a Net8 bug is that it reports incorrect parameter modes when
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describing procedures and functions. Disadvantage of this preference setting is that you can't
query BLOB, CLOB and BFILE columns and that wrapped packages cannot be described.

Allow multiple connections.

When enabled, PL/SQL Developer allows multiple connections from the same instance. When
disabled, changing the connection will implicitly disconnect all other connections and will also set
the main connection accordingly.

Store recent history.

When enabled, the recently used connections from the Recent folder of the Connection List will be
stored when exiting PL/SQL Developer, and will be restored when restarting it. When disabled,
the Recent folder will be empty every time you start PL/SQL Developer.

Store with password.
When enabled, the recent connection history will be saved with password.

20.2 Oracle — Options

.l [V &llow editing of database source

.l IV Ask to save edited database source

.l ¥ llow compilation of read-only source files

.l [¥ Confim commit & rolback

| I Use DBA Views if available

P W tutomatic statistics LI

Select... |

.l ¥ Uricode enabled

.l [v Check for client & server character set mismatch

Add column alias list for Yiew DDL

Auto x

Allow editing of database source.
This option controls if the source of a program unit or view can be edited directly from the Object
Browser, or that it requires that it opened from the file system.

Ask to save edited database source.

If you edit a program unit from the source that is stored in the database dictionary (by right-
clicking on the program unit and selecting Edit from the popup menu), you can prevent that you
are asked to save these modifications to a file by disabling this option. If you have edited a
program unit that was previously opened from the file system, you will always be asked to save
these changes.

Allow compilation of read-only source files.

If a source file is read-only, it cannot be compiled when loaded into a Program Unit Window. This
preference is useful when using a Version Control System, which often leave a read-only copy of
a source file in a working directory. Such a copy must not be compiled, as this might interfere
with the work of other project members.

Confirm Commit & Rollback.

Whenever you commit or rollback a transaction by pressing the corresponding buttons, you will
be asked for confirmation. Disabling this option will immediately commit or rollback without this
confirmation.
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. Use DBA views if available.
PL/SQL Developer will try to use the DBA views (dba_objects, dba_triggers, and so on) instead
of the ALL views (all_objects, all_triggers, and so on) if this preference is set. The DBA views
might expose more information than the ALL views if a developer has certain system privileges.

e  Automatic statistics.
This option controls if a statistic report is to be generated for every executed SQL Statement and
Test Script. If you disable this option, the statistic report will be empty. By pressing the Select...
button, a list opens up with all statistics available in the database that you are currently connected
to. You can select which statistic you wish to include in a statistic report. If you do not have
access to the dynamic performance tables, the Select... button will be disabled.

. Unicode enabled.
When selected, Unicode data will be fetched as such from the Oracle Server, and displayed as
Unicode text. When disabled, Unicode data from the server will be converted to the character set
of the Oracle Client, in accordance with the NLS_LANG key of the Oracle Home Registry.

. Check for client & server character set mismatch.
This option will check if the client character set and server character set are compatible. For
example, if your server character set is UTF8, and your client character set is WESMSWIN1252,
you cannot use UTF8 specific characters in your SQL or PL/SQL code.

e Add column alias list for View DDL.
When enabled, a column alias list will be added when extracting the DDL for a view. When
disabled, PL/SQL Developer will attempt to determine if an alias list is required.
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20.3 Oracle — Compiler

PL/SGL Optimize level
2

®| PL/30L Code type

Interpreted -

PL{Scope identifiers

Hone hd

PL/SAL Conditional Compilation Flags

" Name ‘Value | +
| | DEBUG 1 -
| |LOG_LEVEL 3
] o

PL/SAL Warnings

Action [Exception | &
| B Error | severe

Warning = performance
| |Disabled * informational
| |Disabled = 6000.6001
* =

44 W

PL/S0L Substitution Yariables

" Name | Value |+
| | Schema SCOTT _
| |Prefix  PROD
al

This preference page allows you to control various options for the PL/SQL Compiler of the Program
Window. See the Oracle Database Reference guide for more information about these options.

. PL/SQL Optimize level.
Specifies the optimization level that will be used to compile PL/SQL program units. The higher
the setting of this parameter, the more effort the compiler makes to optimize PL/SQL program
units.

PL/SQL Code type.

When set to Interpreted, PL/SQL program units will be compiled to PL/SQL bytecode format.
Such modules are executed by the PL/SQL interpreter engine.

When set to Native PL/SQL program units will be compiled to native (machine) code. Such
modules will be executed natively without incurring any interpreter overhead.

PL/Scope identifier.

This option controls the compile time collection, cross reference, and storage of PL/SQL source
code identifier data. When set to None, this disables collection of identifier data. When set to All,
this enables the collection of all source code identifier data.

PL/SQL Conditional Compilation Flags.
In this section you can define the default conditional compilation flags for each compilation. You
can use any name, and can use an integer value, a boolean True or False value, or Null. For more
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information about conditional compilation, see the PL/SQL Language Reference Guide. If you
leave this section empty, the default flags for the database instance will be used. Press the Reset to
default flags button to get the default flags for database instance.

PL/SQL Warnings.

In this section you can define how the compiler treats specific warning exceptions or specific
severity categories. For each exception number or category you can define if it is Disabled (no
warning message), treated as a Warning (successful compilation with a warning message), or
treated as an Error (failed compilation with a error message). You can specify multiple exception
numbers, separated by commas.

Note that the order of the warnings is relevant: items at the bottom of the list take precedence over
items at the top. Therefore you should first specify actions for the categories, and then actions for
specific exceptions.

PL/SQL Substitution Variables.

If your Program Files include substitution variables as used in SQL*Plus (prefixed with an
ampersand), you can define the values of these variables here. Note that substitution variables are
only useful when working with program files, since the resulting source in the database will only
hold the substituted values after compilation.

20.4 Oracle — Debugger

IE

[ Show variable values in a popup

[v¥ Step over SYS ohjects

[ Update watches after each step

[¥ Update call stack after each step

[v Add debug infarmation when compiling

NEYER: add debug info for cannections (useri@dh):

ALWiAYS add debug info for connections {user@db)

MNEWVER add debug info for objects ([owner.]name)

=]

Show variable values in a popup.
If you disable this preference, variable values will not automatically be displayed in a popup when
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you move the mouse cursor over its name in the Test Window. Instead, you must select the Set
Variable item from the popup menu after right-clicking on the variable name.

Step over SYS objects.

If you have privileges to view sources of SY'S objects, the debugger can step into these program
units if you disable this option. Usually you do not want to do so, therefore this option is disabled
by default.

Update watches after each step.

If you disable this option, you can manually refresh the watches by pressing the Update watches
button on the debug-toolbar of the Test Window. Doing so may speed up debugging performance
on slower configurations.

Update call stack after each step.

If you disable this option, you can manually refresh the call stack by pressing the Update call
stack button on the debug-toolbar of the Test Window. Doing so may speed up debugging
performance on slower configurations.

Add debug information when compiling.

When this option is enabled, each compilation in PL/SQL Developer will automatically add debug
information, so that variable values can always be viewed and set during a debug session. If you
disable this option, you can manually add debug information from the Object Browser.

NEVER add debug info for connections.

For this list of connection matches, debug information will never automatically be added,
regardless of the “Add debug information when compiling” preference. This can be useful if you
want to make sure that you never add debug information to production databases, or for certain
users. You can use the familiar user@database syntax, where you can use the * and ? wilcard
characters (e.g. sys@* for the sys user on any database).

ALWAYS add debug info for connections.

For this list of connection matches, debug information will always automatically be added,
regardless of the “Add debug information when compiling” preference. This can be useful if you
want to make sure that you always add debug information to development databases, or for certain
users.You can use the familiar user@database syntax, where you can use the * and ? wilcard
characters (e.g. *@devdb for the all users in the devdb database).

NEVER add debug info for objects.

For this list of objects debug information will never be added. Some Oracle Server versions can
cause errors when adding debug information in specific situations. You will typically see ORA-
00600, ORA-03113 or PLS-00801 errors during compilation. If this problem occurs, you can add
the corresponding object to this list (owner.name) until Oracle provides a fix.

20.5 Oracle — Output

®| ¥ Enablec

.| [« Clear betore execute

= Buffer size

|1EIEIUU Zl

Enabled.

In SQL Windows and Test Windows, calls to dbms_output.put_line will be buffered and displayed
after execution of the script. This preference can be overruled on the output page of each
individual SQL Window and Test Window.
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. Clear before execute.
Before executing a SQL Window or Test Window, the current output page will be cleared. This
way, the output page will always contain just the output of the last execution.

. Buffer size.

The size in bytes of the dbms_output buffer. If more than this number of bytes is output during
one execution, an exception will occur. Set the value to 0 for an unlimited buffer size.

20.6 Oracle - Trace

- Availahble Columng Selected Columns
Ewentkind Carmment
Ewent sequence Ewventtime
Exception J Unitnarne
Procline Unitline text
Frocname
Proc pararns il
Proctype
Unitline J
Unit type

El

These preferences control the Trace page of the Test Window (see chapter 5.11). You can control which
columns from the trace table should be displayed, and in which order.

20.7 Oracle — Profiler

Available Colurmng Selected Calumns
Average time Unit
Maxirmum time Line
inirnum tirme Total tirme
Ocrurrences
Text
»
«
®| Time units
" Seconds
® Milliseconds
" Microseconds
.| [~ Show 0 occurrences
. Graphicaltime display
60% A

These preferences control the Profiler page of the Test Window (see chapter 6.3).

Columns.
Controls which columns from the profile table should be displayed, and in which order.
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Time units.
Defines the unit of the Total time, Maximum time, Minimum time and Average time columns.

Show 0 Occurrences.
Determines if a reported source line with 0 execution occurrences will be displayed.

Graphical time display.

The Total time column will display a graphical representation of the relative time. You can control
the brightness of the color of this bar, or make it invisible.
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20.8 Oracle — Logon History

Definition
n

|7 Store histary History size Display size
[V Store with passward i 30

- Sorting

® Lastused
" Database
" Usemame

Fixed Users

- >chicaga :I Here you can listall users
scottftiger@chicago you want always to be visible
sys(@chicago as sysdba. inthe dropdown list,
>detroit
scott/iger@detroit Enter users in user/passw@dhb style.
sys@detroit as sysdba
larry@detroit

H

.‘ [V Keep fixad users groupad and unsortad

.‘ |— Add fixed users to the history when used

oy

for}

scoft
sys as SY'SDBA

If you enable the Store History preference, PL/SQL Developer will store the username, password and
database information in the Logon history. When you restart PL/SQL Developer later, the logon dialog
allows you to quickly select a previously used account:

Usemame Iscutl J
Password I e
demo
Database I h
chicago *
Connect as INDrmaI - scott@detroit

sys@detroit

Ok | Cancel |

For security reasons you may not want to store passwords in the history, even though PL/SQL
Developer encrypts them. This would imply that anyone could connect to the database with your
accounts if they have access to PL/SQL Developer on your PC. In such a case you should disable the
Store with password option. The History size and Display size preferences control how many
connections will be stored (the oldest one will be removed from the history), and how many will be
displayed on screen. The Sorting option controls how connections are sorted in the selection list.

Note that even if you have selected to store passwords in the logon history, you can still prevent this by
holding down the Control key when pressing the Return key or the OK button during logon. This way
you can prevent that passwords of privileged accounts (e.g. SYS or SYSTEM) can be recalled.
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You can additionally define a number of fixed accounts in the Fixed Users section, with or without
password. These fixed accounts will always be displayed and will never automatically be removed. You
can additionally define submenu items for these fixed users by adding >menuname. In the example
above, a submenu is created for chicago and detroit:

>chicago

scott/tiger@chicago

sys@chicago as sysdba

>detroit

scott/tiger@detroit

sys@detroit as sysdba

larry@detroit

In this case a submenu was created for a database, but you can create any kind of category you like. For
example Development, Test, Production.

If the Keep fixed users grouped and unsorted option is enabled, the fixed users are displayed in a
separate section from the history, and will not be sorted. If Add fixed users to the history when used
option is enabled, selecting a fixed user during logon will also add it to the history.

In the History section you can see which users were added to the history as a result of a logon in
PL/SQL Developer. To delete a specific item, select it and press the Delete item button next to the list.

20.9 Oracle — Hints

Unused Declarations B
Variables ol

Constants ~

Types |z

Parameters ~

Exceptions ~

Unused Assigned Yalues

Enabled ~

Dumry Wariahle Prefixes |Dummy

Errors

Campare with null | o2l

Compare with ernpty string | o2l -

m

aming Conventions

" |Element _ |Prefix [1stchar |Allowed chars  [Suffix | Description +
¥ Parameter  =lp_ Any  lAny = must startwith 'p_' | =
¥ Fackage =l self MNone =l None [ rust be 'Self
V¥ PLSOLType =T Any  =lany [ rust startwith T'

[ =] [ =l

Compiler Hints
You can enable and disable each individual hint, and control other properties of hints when appropriate.
An explanation of each hint and property is displayed below the hint list.
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Naming Conventions

In this list you can define naming conventions that will be checked when a program unit is compiled, or
when the Show Compiler Hints function is invoked. A hint will be displayed for each element in the
program unit source that does not meet these naming conventions.

For each naming convention you can define the element type (parameter, variable, and so on), the
required prefix for the element type, the possible values for the first and subsequent characters (after the
prefix), the required suffix, and a description for the hint that should be displayed when the naming
convention is not met.

The description should be in the form as displayed in the example above. The actual hint message will
be <Element> <Name> <Description>. For example: Parameter ‘StartDate’ must start with ‘p_’.

If an element must meet one of multiple naming conventions, then you can simply add multiple lines for
the same element type. The descriptions of all lines will be displayed, separated with ‘or’. For the
example above the parameter hint message will be:

Parameter 'StartDate' must start with 'p_' or must be 'Self'

= program Window - Edit source of function DAYSBETWEEN@CHICAGO =lof x|
&) DaysBetween |
| (Faanete o] [Forameter I

create or replace functien DaysBetween(StartDate in date,
F.ndDate in date) return integer is

begin
return (EndDate - StartDate):
end DaysBetween;

=& [240 [Campled with warrings Y
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20.10 User Interface — Options

.‘ ¥ Autosave username

r‘ ¥ Autosave desktop

.‘ ™ Uss internal HTML viewer

.‘ ™ HTHML help window : "stay on top"*

.‘ ™ Use multiow tabs

.‘ I™ Show complete file path in window titles

.‘ ¥ Use projects

.‘ ¥ Position messagebones near mouse pointer

.‘ ¥ Show file dialags with details visw

i Motify end of lang running queries
Delay [5) Sound file

E—l &l
DSA Diclogs. Shows a list of dislogs that have the "Don't Show this message Again” option checked
98- “V'ou can delete lines for the meszages pou want to enable

e Autosave username.
This option can be checked to automatically save the username of each PL/SQL Developer

session. When you re-start PL/SQL Developer later, the last username will be default in the logon

dialog.

e  Autosave desktop.
When this option is enabled, all files that were opened when you stop PL/SQL Developer will
automatically be reopened when it is started again. A currently opened Command Window or

Explain Plan Window, which are not associated with a file, will also be restored. Furthermore, the

dimensions of the main window and Object Browser will be restored.

. Use internal HTML viewer.
By default PL/SQL Developer will use an internal HTML viewer to display the HTML help

documentation. If you have Microsoft Internet Explorer 4 or later, you can disable this option and
use Microsoft’s HTML components instead. This will give you some extra features in the popup
menu, and will inherit preferences made in Internet Explorer.

HTML help window: “stay on top”.

If the option is enabled, the HTML Help window will stay on top until you close or minimize it. If
it is disabled, the HTML Help window will appear as a separate task, with its own button on the
Windows task bar. This way you can bring PL/SQL Developer main window or the Help window
to the front whenever you need it.

Use multi-row tabs.

If a window contains multiple tab pages, this preference controls whether these tab pages can be
divided over multiple rows in case of an overflow. If this option is disabled, 2 scroll buttons will
appear in case of a tab overflow situation. This currently only applies to the Program Window.

Use complete path in window titles.
By default, only the filename is displayed in a window title. If this option is enabled, the complete
path will be displayed.

Use projects.

The Project main menu item will only be visible if this option is enabled. Disable it if you are not
using projects, so that it does not take up any space in the main menu. For more details about
projects, see chapter 14.
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. Position message boxes near mouse pointer.
When enabled, message boxes will be positioned near the mouse cursor when displayed, so that
you can quickly reach a button. When disabled, message boxes will always be centered on the
screen.

e  Show file dialogs with details view.
When enabled, file open and save dialogs will always start with the Details view. When disabled,
the default view style will be used.

. Notify end of long running queries.
If a query in the SQL Window or Test Window takes a long time, you can use this preference to
get a notification when the query finishes. You can control the minimum delay after which a
notification will be given, and you can also define the sound file that will be played. For queries
that take less than the given delay, no sound will be played.

. DSA Dialogs.
Whenever you select the “Don’t show this message again’ option on a message box, an entry will
be added to the DSA section in your preferences. If you subsequently want to re-enable this
message, press the DSA Dialogs button to edit this section. This will bring up a text editor that
allows you to remove the corresponding line.
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20.11 User Interface — Toolbar

B Available Buttons Selected Buttons
MNew Bar - [3-Mesw -
Separator = Open
] Save as J Save (Chrl+3)
& saveal Separator
&5 Close il 2 Print portrait ||
ﬁ' Close all B Print landscape
%Prim Setup J Separator
iy Page Setup 2 Undo {Cirl+Z)
Clear _I C4 Redo (Shift+Crl+2)
Select All (Ctrl+A) Separator
& Selection Uppercase & Cut{Ctr+)
ab Selection Lowercase Copy (Chl+C)
K Apply Syntax Case R Paste (Ctrl+v)
# . Replace (C+F) Separator
(21 Findl raatehine mair (Chlehd LI &8 Find 8 Banlara (Mirl+F LI
B Button spacing (pixels)
12 Zl
Fesetto Default... | Resetto Classic... |

You can control which buttons should be visible, and in which order. Use the Separator item to separate
groups of related buttons. The New Bar item can be used to create a new toolbar below the previous
toolbar.

The Reset to Default button resets the toolbar to its default state. The Reset to Classic button resets the
toolbar to the PL/SQL Developer 3 layout. Use the Button spacing value to control the spacing between
each button.
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20.12 User Interface — Object Browser

IEximurm recent objects

fo b4

Ohjecttype Double-click action
IDefau\t LI IExpand!CDIIapSe j
Drag & Drop action
I\fiew ﬂ
B Default user selection Usger selactor where clause for sys.all_users view

|<CURRENT USER> ;I username like 'DEV' or usemarne like 'TST3%|

.| [~ Show datatypes

.| v Smaath refresh

.| [ Canfirm recampile

4 Filtars... # Folders...

These preferences control the appearance and behavior of the Object Browser (see chapter 18).

Maximum Recent objects.
Controls how many objects will be visible in the Recent objects folder. The least recently used
object will be removed when more than this number of objects would be displayed.

Double-click and Drag & Drop actions.

Controls which action will be performed when you double-click on an object in the Object
Browser, or when you drag & drop it from the Object Browser onto the workspace. You can
specify a default action, and override or inherit this default action for each object type from the
list.

Default user selection.
Controls whether the <current user> or <all users> is the default user selection.

User selector where clause.
Allows you to define a where clause for the query that populates the user selector. The query is
performed against the all_users view, so you can reference any column from that view.

Show data types.
When this option is enabled, the data types of columns (tables and views), attributes (objects) and
parameters (functions and procedures) will be displayed in the Object Browser.

Smooth Refresh.

On some systems this option may slow down the Object Browser’s refresh operation (e.g.
changing the Object Browser Filter, logging on as a different user, and so on). If this is the case
you should disable it, though this may lead to some screen flickering when the Object Browser is
refreshed.

Confirm Recompile.

When this preference is enabled, recompiling a program unit in the Object Browser will result in a
success or failure message. When it is disabled, you will only see a message when compilation
fails.
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The Filters (see chapter 18.2) button and Folders (see chapter 18.3)button will invoke the
corresponding dialog.

20.13 User Interface — Editor

®| = Mere

" Automatic Step [chars] |2 Z

= Smart

®| ™ Backspace unindents

Tabs & Wrapping
.| I Smart kab Tab SIZE|2 Z

= smartfil
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®| T wirsplines

®| I~ Alow curson ater end of fine Visible margin [0 [24]

.l ™ Show Special Characters by default

Syntax Highlighting
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5
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AutoReplace
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Indent

None.
The editor will not indent when pressing the enter key, and will always go to the first character on
the next line.

Automatic.
The editor will automatically indent after pressing the enter key, to the same indent position as the
preceding line.

Smart.

Same as Automatic, except when the previous line starts a new block (e.g. DECLARE, BEGIN,
FOR, LOOP, and so on), in which case an extra indent will be inserted. These block words can be
configured through the SmartIndent.txt file in the PL/SQL Developer installation directory.

Step (chars).
The number of characters that the editor will indent when indenting or unindenting a selection.

Backspace unindents.
When enabled, pressing the backspace key will unindent to the previous indent position when
appropriate. When disabled, pressing the backspace key will always delete one character.

Tabs & Wrapping

Smart tab.
Will cause the editor to tab to a position relative to the previous line.

Tab size.
Determines the number of characters that a tab will use.

Smart fill.
The editor will replace spaces by tabs if possible.

Use tab character.
When disabled, only spaces will be used for tabs and indents.

Wrap lines.
Lines that are wider than the window width will be continued on the next line.

Allow cursor after end of line
When enabled, you can place the cursor after the end of a line. When you insert text there, the line
will be padded with spaces first.

Visible margin.
Will display a vertical line at the indicated position. 0 = disabled.

Show special characters by default.
When enabled, special characters like spaces, tabs and returns will be displayed. When disabled,
you have to explicitly enable it from the Edit menu.

Syntax Highlighting

This group of preferences control the syntax highlighting that is used in the editors. You can enable or
disable syntax highlighting, and define the style and color of keywords, comment, strings, numbers and
symbols (:=, =>, ||, and so on). For keywords you can additionally control if they should be converted to
uppercase, lowercase or capitalized. You can also define a custom syntax highlighting, and define the
words that should be highlighted. Pressing the Custom Keywords button will bring up an editor that
allows you to define these words.
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AutoReplace

When enabled, you can define words that are automatically replaced with a replacement text. For
example, if you define the word wo with the replacement text “when others then™, you can simply type
wo to insert that text.

Pressing the Edit button allows you to edit the file with words and replacement texts. On each line in
this file you can enter a word=replacement text specification. For example:

wo=when others then
rs=rollback to savepoint

You can also reference a template as replacement text. For example:
wh=Loops\While loop.tpl

In this case the While loop template from the Loops template subdirectory will be invoked, allowing you
to use variables and cursor placement for the replacement text.

The Definition file field allows you to specify which file is used for the AutoReplace definitions.

Other

e  Allow Folding.
When enabled, the PL/SQL Editor of the Program Window will allow you to fold and unfold code
sections, as described in chapter 22.14.

. Folding on by default.
Specifies if code folding is on by default when opening or creating a Program Window.

. Display line numbers.
Check this option to make line numbers visible in the left margin. The Interval property controls
the interval between each displayed line number. Use the Font and Size to alter the appearance of
the line numbers.

. Show line status.
When enabled, the editor will show a yellow mark in the margin for changed lines, and a green
mark for new lines.

. Highlight edit line.
Controls if the line where the text cursor is located is highlighted.

e Wrap to start / end of file when text is not found.
When using the find function, the search will continue at the start of the file (when searching
forward) or the end of the file (when searching backward) if the search text is not found.

. Allow variable width for fixed width fonts.
This option allows you to correctly display double-width characters (e.g. Japanese) with fixed
width fonts. It can also be used for fixed width fonts that are wider in bold style than in regular
style. If you are using such a font, you can use this option if you see truncated characters.

o Highlight parentheses.
When enabled, the editor will highlight the parenthesis pair when the cursor is located at the
opening or closing parenthesis.

. Highlight color.
Determines the color of all highlights such as parentheses, variables, and so on.

e Search hit color.
Determines the color of the search hits found by the search bar.
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. Paste comma separated items on one line.
Controls if multiple items selected in the Object Browser or in a Description Window are pasted
into an editor on one line or on multiple lines.

20.14 User Interface — Fonts

=
Selest =-Tables
DEPT
Bko [ ~EMP
- Views
Sequences
Grid
Sekct. | EMPNO [ENAME |
Bk [ |1 Smith
2 7826 Jones

| ¥ Include fort style with Copy

legtr |
n —_—
Select... [begin ‘when showing 5Special Characters
a 1= sysdate;
Bka [ |ona; Space = (183 Z c
Tab = |155 Z >

Line break = |182 Z q

.l ¥ Include fort style with Copy

[]
| Main Font...

The Fonts preferences control the browser font, editor font and the font used in the various grids like in
the SQL window, the property windows, and so on. By pressing the Select button you can change the
name, style and color of the font. You can also set the background color (Bkg) for each font. For the
Grid and Editor font you can additionally specify whether the font style is included when copying text
to the Windows clipboard. When disabled, it will be copied as plain text.

You can also set the main font for all dialogs.
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20.15 User Interface — Code Assistant

® ¥ Automatically activated

" Delay ms)
500
" Coding Sl
¥ Use original case if possible
" ¥ Descrbe Users
¥ Tables IV Functions
W Views V¥ Frocedures
¥ Sequences V¥ Packages
¥ Tupes

[ Describe Contert
Minimum characters
2

.‘ ¥ Describe standard functions (e.g. ta_char]

™| ¥ Show variable and type declarations in a popup

The Code Assistant automatically displays information about database objects as you type their name
(see chapter 22.3). This preference page allows you to define the behavior of this feature.

e  Automatically activated.
The Code Assistant can automatically be invoked after a certain delay (see below). You can also
choose to manually activate the Code Assistant through a function key.

. Delay.
The number of milliseconds that the editor will wait before it displays the Code Assistant List.

. Coding Style.
Controls how selected items are inserted into the editor when you select them:

. Smart — The Code Assistant will look at the described object to determine the style.

. Init Caps — The first character of each word (separated by an underscore) in capitalized.
. Lowercase — All characters are converted to lowercase.

. Uppercase — All characters are converted to uppercase.

. Use original case if possible.
When this option is enabled, the Code Assistant will determine the case of the identifier from the
source that is stored in the Oracle Dictionary if possible. This applies to all program units and their
elements (parameters, types, and so on) and to view columns, and overrides the Coding Style
preference described above. If the original case cannot be determined, the Coding Style will be
applied.
You may want to disable this feature for performance reasons.

. Describe users.
Determines if the objects owned by a user are listed when you type a username followed by a
period. If this option is enabled, you can additionally define which object types you want to
include in the list.

. Describe context.
Determines if the Code Assistant should describe the context of the current user, editor, and
program unit.
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Minimum characters.

Determines how many characters of a word need to be typed before the context description can
automatically invoked. Note that you can always invoke the Code Assistant manually, even if the
number of characters have not been typed.

Describe standard functions.
By default the Code Assistant will describe standard functions such as to_char, add_months, and
so on. If you are very much familiar with these functions, you can disable this option.

Show variable and type declarations in a popup.
When enabled, holding the mouse cursor over a variable or type in a Program Window will
display the declaration in a popup.

20.16 User Interface — Key Configuration

™

ltem IKey |ﬂ
Edit/ Redo Shift+Cirl+ 2

Edit / PL/S0L Beautifier

Edit / PL/S0L Beautifier Options _I
Edit/ Cut Ctrl+x

Edit/ Copy Ctrl+C

Edit / Paste Ctrl+'/

Edit { Append

Edit / Clear

Edit/ Select All Ctrl+A

Edit/ Recall Staternent Cirl+E

Edit/ Special Copy

Edit/ Selection / Indent Cirl+

Fdit ! Salactinn ! | Inindant Cirlel | LI

Press the shortcut key vou wantto assign

Press [Esc] to clear an item Resetto Default |

On this page you can define your own key configuration for all functions in PL/SQL Developer. Just
select the function in the list, and press the key combination that you want to use for this function. To
clear a hotkey for a specific function, select it from the list and press the Esc key.
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20.17 User Interface — Appearance

Language

I[none] LI

Background Gradient
[v' Enabled

v “erical

|_ Diefault colors

= Colorl
B Color2

Connection Indicators

Match (user@database) Color
*@proddb
sys@*

[ =

]

I_ Settoolbar indicator
@ Leftaligned
(" Right aligned
|_ Setwindow indicator
[~ Setapplication background calar

v Faded disabled buttans
{requires B4k colors or more)

[~ Display buffering
{flicker free display. but slower performance)

[+ Autocompleta dropdown lists

Fesets the docking windows to the default configuration

] (to quickly reset the layout)

Language.
If you have a multi-language version of PL/SQL Developer, you can select a language here. All
captions and messages will subsequently be displayed in that language.

Background Gradient.
Allows you to define the color and gradient of PL/SQL Developer’s workspace. If you do not
want to use a gradient, but just a single color, set Color 1 and Color 2 to the same value.

Connection Indicators.

These options allow you to provide some visual indication when PL/SQL Developer is using
specific connections. You can define a number of connection matches in user@database format,
and associate a color with it. This color can subsequently be associated with a left or right aligned
toolbar indicator, an indicator on the window and in the window list, or with the application
background (overriding the background gradient).

A connection match can contain the * and ? wildcard characters. In the example above, the editor
background and right aligned toolbar indicator will be red when connected to the PRODDB
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database with any user. It will be yellow when connected as SYS to any database. The first item in
the list will take precedence, so the indicators will be red when connected as SYS to the PRODDB

database.

. Faded disabled buttons.
When enabled, disabled buttons are displayed with faded colors. When disabled, the standard
grayed out appearance is used for disabled buttons. For 256 color displays, disabled buttons are
always grayed out.

. Display buffering.
The screen will show less flickering when moving or resizing windows, but the display
performance may be slightly slower.

e Autocomplete dropdown lists.
When enabled, edit fields with dropdown lists will automatically be completed with a matching
item from the list.

. Reset docking.
Resets the docking windows to the default configuration.

20.18 User Interface — NLS Options

Date
Idd—MMryyyy

" User defined
" Windows format
" Dracle format

Time

bk s
" User defined
& windows format

Numbers
Decimal Symbol Digit Group Symbol
€ User defined

£ Windows format
" Oracle format

On this page you can define the date, time, and number formats that will be used in PL/SQL Developer.

Date format

. User defined.
An explicitly defined date format, following the same rules as the Windows regional settings.

e Windows format.
The format as defined in the Windows regional settings.

. Oracle format.
The format as defined by your Oracle environment (NLS_DATE_FORMAT).
Time format

. User defined.
An explicitly defined time format, following the same rules as the Windows regional settings.
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e  Windows format.
The format as defined in the Windows regional settings.
Number format

. User defined.
When selected, you can explicitly choose a decimal symbol and digit group symbol.

e Windows format.
The format as defined in the Windows regional settings.

e  Oracle format.
The format as defined by your Oracle environment (NLS_NUMERIC_CHARACTERS).

20.19 Window Types — Program Window

.l ™ Allow compilation whils running

.l [ Safe compilation [using temparary compilation objsct)

.| [ Backgiound compilation

.| [~ Save before compilation

.l [ lgnore unrecognized PL/SGL

.l [V Show code contents

.l [V Hot track code contents

.| [¥ Show code hierarchy

.| [¥ Hot track code hisrarchy

.l ¥ Highlight variables

.l v Highlightif. loop, case and block keywaords

.l [v Show compiler hints after compilation

= Error backaround -— Example text j
B Eror text begin
[ Hot track highlighting select * from emp;
s := "Hello World'; =

¥ Save windows state (position, size, bookmarks, )
" Save in same directory as program file
" Save in relative path

' Savain absolute path

| =]

These preferences affect the behavior of the Program Window (see chapter 4).

e Allow compilation while running.
In Multi or Dual session mode you are technically able to compile program units while you are
running Test Scripts or SQL Scripts. This might lead to locks, which can be prevented with this
preference.

e  Safe compilation (using temporary compilation object).
When enabled, each compilation is first tested by using a temporary compilation object. When this
test compilation succeeds, the actual object is compiled. This can be useful if you are compiling
objects in an environment where invalid objects can cause problems.

. Background compilation.
When enabled, compilation is performed in a background thread, using a separate session. This
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way you can continue other work while the compilation occurs. It will lead to an extra database
session for each Program Window though. Note that this preference is only effective if the Session
Mode preference (see chapter 20.1) is set to Multi Session.

e Save before compilation.
If you want to ensure that the database object and the source file on the file system stay in sync,
you can enable this option.

. Ignore unrecognized PL/SQL.
When enabled, the Program Window will ignore all SQL that does not start with “create or replace
<program unit type>". Other SQL or SQL*Plus commands in the program file will be ignored.

e  Show code contents.
This preference controls whether the Code Contents pane will be displayed. See chapter 22.12 for
more details.

. Hot track code contents.
Controls whether the PL/SQL code in the editor will automatically be highlighted when the mouse
moves over an item in the Code Contents pane.

e Show code hierarchy.
This preference controls whether the Code Hierarchy pane will be displayed. See chapter 22.13 for
more details.

e  Hot track code hierarchy.
Controls whether the PL/SQL code in the editor will automatically be highlighted when the mouse
moves over an item in the Code Hierarchy pane.

. Highlight variables.
When the cursor is located on a variable, all occurrences of this variable are highlighted. This
makes it easy to see where a variable is used and what the impact of a change might be. If this
option is disabled, you need to use the Find matches item from the Edit menu.

. Highlight if, loop, case and block keywords.
When the cursor is located at an if / then / else / elsif /end if keyword, a loop / end loop keyword, a
for / loop / end loop keyword, a while / loop / end loop keyword, a case / when / then / else / end
case, and declare / begin / end keywords. If this option is disabled, you need to use the Find
matches item from the Edit menu.

e Show compiler hints after compilation.
Compiler hints provide information about unused declarations, unused assignments, potential
errors, and warnings. When this preference is enabled, these hints will automatically be displayed
after compilation, below the compilation errors (if present). If you disable this preference, you
have to explicitly select the Show Compiler Hints item from the Tools menu or the toolbar.

. Error background.
Select the color of the background of the text of a compilation error.

. Error text.
Select the color of the text of a compilation error.

. Hot track highlighting.
Select the background color of highlighted text for code contents hot tracking, code hierarchy hot
tracking, and if, loop, case and block keywords.

. Save window state.
When enabled, the position, sizes, bookmarks, color marks, and substitution variables of a
Program Window are saved in a separate .pfi file and restored when the file or database object is
subsequently viewed or edited again. The location of these files can also be specified.
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20.20 Window Types — SQL Window

.| ™ AuteCornmit SAL

.l [~ &utoCommit posted records

.l [V AutoExecute queries

= | [ AutoSelect statement

.| [V Ask to save new windaws

.l ™ Linked guery in news window

= | ™ MNumber figlds to_char

. | ™ Date fields to_char

¥ Show dictionary info in result gid

.l ™ Show gutter (line numbers)

Initial empty editor ines
3

L]
| MNul value cell colar

T Altemate row color
¥ Enabled

Records per Page

= Automatically determined
" Fixed

100 E

= Allrecords

b aximum result set size (0 is unlimited)
100 2 ME

®| Quety By Example

™ Caseinsensiive
™ Automatic contains
™ lgnore time fraction

Number Lapout

" Left aligned

£ Right aligned

" Foimatted

= Formatted with thousand separatar

These preferences affect the behavior of the SQL Window (see chapter 7).

AutoCommit SQL.
This option controls if DML statements executed in a SQL Window are automatically committed.

AutoCommit posted records.
This options controls if records posted through the result grid are automatically committed.

AutoExecute queries.

If this option is enabled, a SQL Window that is created when selecting Query Data or Edit Data
for a Table or View object will immediately be executed. If this option is disabled, you can
modify the generated select statement before executing it.

AutoSelect statement.

If you have more than 1 SQL statement in the SQL Editor (separated by semi-colons), the SQL
Window will automatically select the statement where the cursor is currently located before
execution. This way you don’t have to explicitly select the statement yourself.

Ask to save new windows.
When you close a SQL Window that was just created, you will normally be asked if you want to

PL/SQL Developer 9.0 User’s Guide
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save it to a file. If you disable this option, this confirmation will be omitted. If you have modified
a previously opened SQL file, you will always be asked to save these changes, regardless of this
preference.

. Linked query in new window.
When this preference is set, executing a linked query (see chapter 7.4) will create a new SQL
Window. Ifit is not set, the linked query will be executed in the current SQL Window.

. Number fields to_char.
When this preference is enabled, number fields will be converted to character values on the server.
The NLS parameters of the session will determine the format of the values. PL/SQL Developer
will not perform any additional number formatting or validation.

. Date fields to_char.
When this preference is enabled, date fields will be converted to character values on the server.
The NLS parameters of the session will determine the format of the values. PL/SQL Developer
will not perform any additional date formatting or validation, and the date picker will not be
available when editing date fields.

. Show dictionary info in result grid.
When enabled, the following dictionary info will be displayed in the result grid:

e  The column data type, optionality, and comment will be displayed on the status line.

e Alookup list will be displayed for columns with a check constraint that checks for specific
values (e.g. col in (valuel, value2, ...))

e A Lookup list will be displayed for columns with a foreign key constraint to small tables of
less than 1000 rows.

e  Show gutter (line numbers).
When enabled, the SQL Editor will display line numbers and line status in the gutter to the left of
the editor.

. Initial empty editor lines.
When executing a Select statement in the SQL Window, the result pane will appear and take up
space of the SQL Editor. This preference controls the minimum amount of lines that will remain
in the SQL Editor, regardless of the number of lines of the Select statement.

. Null value cell color.
This color will be used to indicate null values. This makes null values easier to recognize for
values with only blanks, and values that are not directly displayed in the grid (e.g. LOB’s and
Longs).

e  Alternate row color.
If enabled, this color will be used to visualize alternate rows in the result grid.

. Records per page.
This preference determines how many records are initially retrieved for a select statement, and
each time you press the Next Page button in the result grid of a SQL Window:

e Automatically determined — The size of the result grid determines how many records are
retrieved.

. Fixed — The number of records specified are retrieved.
e  Allrecords— All records are immediately retrieved when the query is executed.

. Number layout.
This preference controls how number columns are displayed:
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Left aligned — Values are displayed left aligned, without any formatting.
Right aligned — Values are displayed right aligned, without any formatting.

Formatted — Values are displayed right aligned, with a format that corresponds to the
precision and scale of the field.

Formatted with thousand separator — Similar to the previous option, but will also include a
thousand separator (e.g. 1,277.65)

e Query By Example.
These preferences control the default behavior of the SQL Window during QBE mode (see
chapter 7.3):

20.21

Case insensitive — Query values of character fields are treated case insensitive.
Automatic Contains — Character fields only need to contain the query values.

Ignore Time fraction — The time fraction of date fields is ignored if the query value does not
contain a time fraction.

Window Types — Test Window

‘ .| [~ AutoCommit after Execute

. AutoCommit after execute.

This

option controls if executed Test Scripts are automatically committed.

20.22 Window Types — Plan Window
" Aveilable Columns Selected Caolumns
Access predicates a Object owner
CPU cost Ohject name

Distribution J Cost

Filter predicates Cardinality
Id Bytes
10 cost il
Objectinstance

Objectnode J
Ohjecttype

Operation

Optimizer ﬂ
Options

QOther

hereg -]

These preferences control which columns of the plan table should be displayed in the Plan Window (see

chapter 6.1), and in which order they should appear.

20.23 Tools — Differences

Executable

Parameters (%1 and %2 will be replaced by filenames)

On this preference page you can select the external difference tool for the Compare User Objects tool
(see chapter 21.10). Use the following directives to specify parameters to ignore case or white space:
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. <lgnoreCase=on|off>

This directive will use the on or off expression if case needs to be ignored or not.
. <lgnoreWhiteSpace=on|off>

This directive will use the on or off expression if white space needs to be ignored or not.
For example, for ExamDiff you can use the /i parameter switch to ignore case and /!i to be case
significant, and you can use the /w parameter to ignore white space and /!'w to be white space

significant. These switches need to be specified after the filename parameters. Therefore the parameter
list for ExamDiff would look as follows:

%l %2 <lgnoreCase=/i|/!'i> <lgnoreWhiteSpace=/w|/1w>

When 2 files need to be compared case sensitive while ignoring white space differences, the resulting
parameter list would be:

c:\temp\filel.sql c:\temp\file2_.sql /!'i /w

20.24 Tools — Data Generator

" Dats Fomat

Commit every..
0

Delay (mSec)
il

Mumber of items
10.20

User Definitions

| Itern |\/a\ue \
%

This preference page allows you to define a global set of defaults for the Data Generator tool. These
defaults can be overruled for each data generator definition. For more details about the meaning of these
preferences, see chapter 21.9.
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20.25 Tools — To-Do List

n Priorities
1-High :I
2 - Medium
3 - Low
E
= Categories
Fix ;I
Optimize
Finish
Test
Fienview
[
| awners
John -
Bill _I
Caroll
El

These preferences control the values in the Priority, Category and Owner selection lists in the To-Do
Item editor. For the priorities it can be useful to prefix each value with a number, so that the list can be
sorted by priority. See chapter 15 for more details.

20.26 Tools — Recall Statement

|
Maximum size (statements)

200

Directory for recall file (PLSRecall.dat)
[ uwINDOWS Application DatetPLEOL Developery &]

On this preference page you can define the maximum number of statements in the statement recall
buffer, and the directory where it should be stored. See chapter 22.4 for more details.
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20.27 Files — Directories

e  Program files
Defines the starting directory when opening or saving Program files. If you leave this directory
blank, you will always start in the directory you opened or saved a Program file the last time.

e Test scripts
Defines the starting directory when opening or saving Test scripts. If you leave this directory
blank, you will always start in the directory you opened or saved a Test script the last time.

e SQL Scripts
Defines the starting directory when opening or saving SQL scripts. If you leave this directory
blank, you will always start in the directory you opened or saved a SQL script the last time.

e Report files
Defines the starting directory when opening or saving Report files. If you leave this directory
blank, you will always start in the directory you opened or saved a Report file the last time.
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Command files
When open a command file from the menu or by typing @file, this directory will be used by
default. If you leave this directory blank, the working directory will be used.

Macros
This directory will be used to store your macro library. If you leave this directory blank, the
Macro subdirectory in the PL/SQL Directory will be used.

Templates
This directory will be used to store program file templates. If you leave this directory blank, the
Template subdirectory in the PL/SQL Directory will be used.

Plug-Ins
This directory will be used to search for Plug-Ins. If you leave this directory blank, the Plugin
subdirectory in the PL/SQL Directory will be used.

Projects
Defines the starting directory when opening or saving Projects. If you leave this directory blank,
you will always start in the directory you opened or saved a Project the last time.

Standard queries
Defines the directory where standard queries are stored. If you leave this directory blank, standard
queries will be stored in the application data directory of your profile.

OFS Locations
Defines the OFS Location Directory File (ofs.Idf). The OFS Manager button allows you to launch
the OFS Manager to view or edit this file. See also chapter 30.1.

20.28 Files — Extensions

| DESKIap 05K

|
| Default sl
|
| Others
Report Files
|
| Default |rep
|
Others
Test Scripts
|
Default [tst
|
Others
Command Files
|
Default |pdc
|
| Others
Register Filetypes =

On this page you can define the default extensions of all file types. When saving or loading such a file,
the default extension is assumed if you do not specify an extension in the file dialog. For each file type
you can additionally specify 'other' extensions, which will be displayed in the file dialogs as well.
Separate multiple extensions with a comma.

By pressing the Register Filetypes button you can associate these default extensions with PL/SQL
Developer. Double-clicking a file with such an extension in the Windows Explorer will automatically
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launch PL/SQL Developer. A dialog will appear that allows you to select which extensions you want to
associate with PL/SQL Developer.

20.29 Files — Format

Linebreaks when saving files

® ‘Windows format (cr/lf)

" Unix format ()

(™ Unix format for the following locations only:

Encoding

@ Autodetect (ANS| or UTFE)
(" Allways UTF8

.‘ [ Exportwith smart quotes

.‘ v Exportto Excel with QL statement

The Linebreaks option controls how lines are terminated in text files. The can either be terminated in
Windows style by CR/LF character pairs, or in Unix/Linux style by a single LF character. You can
additionally specify that files are in Unix format on specific locations, and in Windows format
otherwise. You can specify multiple directories on separate lines, and select a directory by pressing the
Add location button (...). Note that not only files saved in this directory are formatted in Unix style, but
also all files saved in subdirectories below this directory.

The Encoding option controls if files are always saved in Unicode UTF8 format, or if PL/SQL
Developer tries to determine whether a file contains Unicode characters or not. If it contains Unicode
characters, the file is saved in UTF8 format. If all characters are ANSI, the file is saved in ANSI format.

The Export with smart quotes controls how values are exported in CSV format. When disabled, all
values are enclosed in quotes. When enabled, only those values that require them are enclosed in quotes.
This are values that contain comma’s or quotes.

The Export to Excel with SQL statement option controls whether or not the SQL statement will be
included on a separate Excel page when a query result is exported in Excel format.

20.30 Files — Backup

- (Existing files are saved with a ™ preceding the extension)

(" Disabled
® Savein same directory
(" Save in relative path

IBackup

(" Save in absolute path

Recovery
(The contents of all editwindows are stored)

l_ Sawve on execute

¥ Save ontime interval

10 Z Minutes

This preference page contains options for backup and recovery of your source files.
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Create backup files

Before PL/SQL Developer saves a file, the original file will be saved to a backup file before overwriting
it. This backup file will have the same name, and the extension will be prefixed with a ~ character (e.g.
employee.pck will be saved to employee.~pck). This way you will always have one generation of
previous files.

All file dialogs that allow you to open a file, will have a “Backup files (*.~*)” filter that allows you to
easily open a backup file.

Recovery

PL/SQL Developer can store all open files to a temporary location on certain events. In case of a severe
problem (e.g. power failure, software crash, and so on), PL/SQL Developer allows you to recover these
files when it is subsequently started. You can specify the following events:

. Save on Execute.
All open files will be stored in a temporary directory before you execute a Program Window, Test
Window, Command Window, SQL Window or Report Window.

e  Saveontime interval.
All open files will be stored in a temporary directory at the specified time interval.

20.31 Files—- HTML/XML

B Charset Encoding

(& Default
o =

- Heading

-
4 b

ML

x

Charset Encoding
(@ Default

cl =

Heading

-
4 s

These preferences allow you to control the HTML and XML output that is generated by the Report
Window and the Export functions:

e  Charset encoding.
Allows you to define the character set encoding of the HTML or XML document. This should
correspond to the character set of your Oracle environment, so that the data is interpreted
correctly.
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Heading.
This text will be inserted into the <HEAD> section of an HTML file, or into the standard XML
header of an XML file.

20.32 Other - Printing

.‘ [~ Show print dialog

.‘ [~ Printline numbers

.‘ [~ ‘Wrap lines while printing

- l_ Print black fwhite

o Print background

.‘ [ Print SOL text in SQL window

o~

.‘ [¥ Printlines

.‘ [ Inverted heading

s

.‘ [~ Caption

.‘ [~ Date

ﬁ

.‘ [~ Page numbers

General

Show print dialog.
When pressing the Print button, the print dialog will be displayed first.

Print line numbers.
Will display a line number before each line when printing SQL or PL/SQL source code.

Werap lines while printing.
Lines that are wider than the page width will be continued on the next line.

Print black/white.
All printed output will be black and white. Disabling this option will create output with colors or

gray levels.

Print background.
When enabled, the background color will be printed.

Print SQL text in SQL Window.
Determines if the SQL text is printed before the query results when printing the contents of a SQL
Window.

Grid

Print lines.
Determines if the lines of a grid are printed.

Inverted heading.
Determines if the heading of a grid is printed with inverted color.
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Header

. Caption.
When enabled, each page will have the file type and file name printed on the left side of the
header.

Date.
When enabled, each page will have the current date and time printed on the right side of the
header.

Footer

. Page numbers.
When enabled, the center of the footer will contain the page number.

20.33 Other — Updates & News

*| Check Online Updates interval-
i Application Start

% Daity

1 Weekly

£ Monthly

= Manually

= Never (disabled)

Check Now... | |Latest Update: 22-09-2006

Check Online News interval:
 Application Start

% Daity

 Weekly

 Morthly

" Manually

" Never (disabled)

Check Now... | |Latest News: 18032007

| I Enabled
Address Paort
| Jeo
Usemame Password

™ Ask for password

Allows you to control if and when PL/SQL Developer checks the Allround Automations web site for
updates and news about PL/SQL Developer. If you disable this option, you can explicitly check for
updates and news by pressing the corresponding option or though the Check Online Updates and Check
Online News items in the Help menu.
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20.34 Preference sets

As mentioned in chapter 20, you can define preference sets at multiple levels. To define a preference,
press the Configure preference sets button next to the preference set selection list. The following dialog
will appear:

Preference Set il

# Personal Preferances |g’ Default Preferencesl
Default John

Order admin dat

~Definition
Description
Order admin databases [+ Enabled

Connections | Preferences
“@dev_oa ;I

“gtst_na
“@prd_oa

[

oK I LCancel Help

The Personal Preferences are defined for the current Windows user (in this case John). The Default
Preferences can be defined by the system administrator, and provide default preferences for all
Windows users, either at a global level or at a connection level.

Personal preferences

By default all users will have a Default <user> preference set. This is the preference set that you will
access by default. To create an additional preference set for one or more Oracle connections, press the
New button to the right of the preference list. Now you can enter a description and add one or more
connections. For each connection you can use wildcards to match multiple users or databases. In the
example above, a Order admin databases preference set has been defined by John for the dev_oa,
tst_oa, and prd_oa databases. Whenever John connects to one of these 3 databases, this preference set
will be used. If a preference is not defined within this set, the corresponding preference will be used
from the default user preference set.

Default preferences

A system administrator can define global default preferences for all users and all connections, and can
additionally define a default preference set for one or more connections. To do so, switch to the Default
Preferences tab page, and press the New next to the preference list. If you do not enter any Connections,
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the new preference set will define the default preferences for all users. If you do enter one or more
connections, the preference set will define the default preferences for these connections.
Preference set precedence

If a preference is defined at multiple levels, the most specific level will take precedence:

1. Personal connection preference set (highest precedence)

2. Personal windows user preference set

3. Default connection preference set

4.  Default global preference set (lowest precedence)

Preference set files and directories

A preference set is stored in a single file in the Preferences subdirectory in the PL/SQL Developer
installation directory. Within this preference directory, the personal preferences are stored in a
subdirectory with the name of the Windows user. For example:

C:\Program Files\PLSQL Developer\Preferences\John

The default preferences are stored in the Default subdirectory. For example:

C:\Program Files\PLSQL Developer\Preferences\Default

If you install PL/SQL Developer on a file server, you must provide read/write access to the Preferences
directory, and read access to the Preferences\Default subdirectory. Alternatively, you can provide the

PREFPATH command-line parameter to specify the directory for the user preferences:

plsgldev.exe prefpath=u:\userdata

If Windows user John uses PL/SQL Developer, his personal preference sets will be stored in
u:\userdata\john. Default preferences are always stored in the Preferences\Default subdirectory within
the PL/SQL Developer installation directory.

To ensure that all users use a similar preference path, you can set this parameter in the params.ini file
(see chapter 32.4).
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21. Tools

Several tools are available in the Tools menu. These tools are described in this chapter.

21.1 Object Browser

The Object Browser tool is described in detail in chapter 18. In the Tools menu, you can show or hide
the browser by selecting the Object Browser item. You can also define Object Browser Filters from this
menu, which are also described in chapter 18.

21.2 Find Database Objects

This tool allows you to find database objects based on specific criteria such as the object name, type,
owner, or status, as well as additional full text search criteria for the DDL source of the objects:

* Find Database Objects ol x|
r—Full Text Search
Search
Text to find ;I |_I
Ereal:
[ Caze sensitive IV ‘wihole words only ™ Regular expressions Ll
—Object Criteria
Browsser Filker I ;I
Ouwner|[<CURRENT LISER> x| Name Dz |
Statusl LI Load... |
Created after| [ 28-12-2005 x| Before| 21052005 =~ Save... |
Modified after| I 25-12-2005 x| Before| T 25122005 x|
—Object Type:
V' Functions ¥ Type Specifications v Queues vV Sequences
IV Procedures V' Type Bodies vV Tables V' Syronyms
¥ Package Specifications ¥ Triggers ¥ Wiews ¥ Libraries
V¥ Package Bodies v Java source V' Materizlized Views
All | MNone | Inwert |
[Name _ | Type __| Compiled <]
—E CURRENT_EMPLOYEES WIEW 28-12-2005 15:55:42 |
26-11-2005 14: 5
01-11-2005 14:31:47
B2 DEPT TABLE 21-12-2005 16:32:58 |

You can enter search criteria in the 3 top sections of this form.

Full Text Search

The options in this dialog are more or less equivalent to the Find dialog in the text editor, and allows
you to search case insensitive, search for whole words only, and search with regular expressions. If you
omit the full text search then all objects that match the other criteria will be returned.

Object Criteria

Here you can enter the following criteria:

. Browser Filter — Limits the objects according to the criteria of the selected filter.
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. Owner — The owner of the object. You can use a SQL wildcard characters (e.g. sys%). The
default value is <CURRENT USER>, which will limit the search to objects for the currently
connected user.

. Name — The name of the object. You can use a SQL wildcard characters (e.g. %common).
. Status — Limits the search to valid or invalid objects.

. Created after/before — Limits the search to objects created after and before the specified date.
Use the checkbox to the left of the date field to enable or disable these criteria.

. Modified after/before — Limits the search to objects modified after and before the specified date.
Use the checkbox to the left of the date field to enable or disable these criteria.

Object Types

Here you can select the range of object types that you want to include in your search.

Search results

After pressing the Search button the search operation is performed in the background and the search
results list will be filled.

If you right-click on the search results you will see the popup menu of an object. The first item in this
popup menu is Locate text, which opens the source in a Program Window, and will immediately take
you to the first occurrence of the search text. You can also invoke the Locate text function by double-
clicking on the item in the search results.

To save the search results you can right-click on them and select an appropriate format from the Export
submenu item in the popup menu.
Saving frequently used search criteria

To save frequently used search criteria, you can press the Save button and enter a directory and
filename. You can recall these search criteria later you can press the Load button.

21.3 Compile Invalid Objects

With this tool you can easily recompile all invalid objects in the database. When you select it, a dialog
is displayed that shows all invalid objects:

= Compile Invalid Objects _|o il
B oo
[Name [ Type __[Carmpiled |
| WV EMP WIEWY 18-07-200414:59:31
i DEPARTMENT PACKAGE 27-06-2004 15:21:44
@ EMPLOYEE PACKAGE 27-06-200414:43:28
&% EMP_DELETE | TRIGGER

EMP_INSERT TRIGGER 18-06-2004 15:41:55

&
3 DEPARTMENT PACKAGE BODY 27-06-2004 15:21:44

EMFLOYEE PACKAGE BODY| 27-06-2004 14:43:28

4 PLS-00201: identifier NULLS' must be declared
4 PL/S0L: Statement ignored
LI

Note that the currently active Browser Filter controls the invalid objects that are included. The bottom
section of the dialog will display any compilation errors that have previously occurred for the currently
selected object.
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To recompile the objects, press the Compile invalid objects button on the toolbar or Execute on the main
toolbar. The dependencies of the objects will be analyzed to determine in which order compilation
should occur. The icons at the left of the object list will indicate which objects were successfully
compiled. The compilation error section will be updated after compilation is completed.

To refresh the list of invalid objects, press the Refresh object list button on the toolbar. This will update
the list with all currently invalid objects.

In the object list you can right-click on an object to access its popup menu.

21.4 Export Tables

The Export Tables tool allows you to export one or more table definitions and their data into a file, so
that you can import the tables later. After starting the Export Tables tool, you can select the tables you
wish to export, choose an export method (Oracle Export, SQL Inserts, or PL/SQL Developer), and set
various options that apply to the export method:

=10|x]
y i B

2 BONUS TABLE 15-10-2007 11:36:01

B DEPT TABLE 16-02-2011 16:07:15

B EMP TABLE 16-02-2011 16:07:58

B8 NOTES TABLE 11-02-2011 13:54:35
EH SALGRADE TABLE 15-10-2007 11:36:01

Oracle Export | S0L Inserts | PL/SAL Deve\oper'

[V Compress [V Grants Buffer size (KB)
[~ Consistent v Indexes 4

v Constraints v Fows ‘here clauss
[v Direct [~ Triggers

Expor Executable
|C:\Orac\e\product\ﬂ 2.0client_Tihin\exp.exe (= I o

¥ Zip
Output file IC\ExpDridata\demD dmp =3 I Export |

|~ scott@olll [ y

The export function analyzes the foreign key dependencies that may exist between the tables, and places
the tables in the correct order in the output file.

Oracle Export method

The screenshot in the previous chapter shows the options of the Oracle Export method. This method lets
you specify the options that you can supply on the command line of Oracle’s export utility (see the
“Oracle Server Utilities guide), and will subsequently launch it to perform the export. The Export
Executable field allows you to select a specific version of Oracle’s export utility. By default the most
recent version from the current Oracle Home will be used.

Use the Zip option to automatically zip the output file in order to save disk space. For the example
above the C:\exportdata\demo.dmp file will be created, which will then be added to the zip archive
named C:\exportdata\demo.dmp.zip. The original demo.dmp file will subsequently be deleted.

After the export is finished, a new Log tab page will be visible. This page contains the logging that was
created by the export utility.

Advantages of this method are the speed and the portability of the output file. After all, you can import
it anywhere with Oracle’s import utility.
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SQL Inserts method

"Oracle Export 30L Inserts |PuSQL Developer'

[ Dropiahles [V Disahle fareign key constraints
[~ Create tables [~ Include storage
| Truncate tables [ Include privileges
v Delsts recards Commit every 100 Z’ recards (0 = newer)
[¥ Disable tiggers ‘here clausel
[+ zip
Output file IC\expDridata\demD sql EI Export

This export method creates a standard SQL script with insert statements and (optionally) DDL
statements to recreate the table definition. The tab page contains the following options:

Drop tables — The generated SQL script contains statements to drop the tables before they are
recreated and loaded. The Create tables, Truncate tables, and Delete records options are disabled
in this situation, and have an implicit value.

Create tables — The generated SQL script contains statements to create the tables before they are
loaded. This includes constraints, indexes and grants.

Truncate tables — The generated SQL script uses truncate table statements to empty the tables
before they are loaded. This option is faster than the Delete tables, but cannot be used if foreign
key constraints exist.

Delete records — The generated SQL script uses delete statements to empty the tables before they
are loaded.

Disable triggers — The generated SQL script disables all triggers of the tables before they are
loaded, and enables them afterwards. This can improve performance, and can sometimes be
necessary if the triggers contain checks that are not applicable to the import process.

Disable foreign key constraints — The generated SQL script disables all foreign keys of the tables
before they are loaded, and enables them afterwards. This can be necessary for self-referencing
foreign keys. Foreign keys between different tables will not lead to conflicts, because the tables
are exported in a correct order. Disabling foreign keys can also improve performance.

Include storage — The generated SQL includes the original storage information such as tablespace
names and initial sizes for table creation statements. These may differ across databases, so this
may not always be appropriate.

Include privileges — The generated SQL includes the grants of the object privileges to other users
and roles. When the objects are recreated in a different database, these users and roles need to
exist for obvious reasons.

Commit every — Controls how many records will be inserted in the generated SQL script before a
commit is executed. If this value is zero, all inserts will be committed at once at the end of the
SQL script. For large export files and small rollback segments it will be necessary to supply an
appropriate value here.

Where clause — Only records that match the where clause will be exported. The where clause must
be applicable to all selected tables!

Advantages of this method are the portability of the SQL script, and the possibility to edit the results
with a text editor.

Use the Zip option to automatically zip the output file in order to save disk space. For the example
above the C:\exportdata\demo.sql file will be created, which will then be added to the zip archive
named C:\exportdata\demo.sql.zip. The original demo.sql file will subsequently be deleted.
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PL/SQL Developer method

Where clause ||

Oracle Exportl S0LInserts PL/SOL Developer

[v Compress file
[ Include storage
[ Include privileges

Cutput file Ic:\exportdata\demo.pde EI Expart |

This export method creates a custom, compressed PL/SQL Developer export file with the table
definitions and data. The tab page contains the following options:

Where clause — Only records that match the where clause will be exported. The where clause must
be applicable to all selected tables!

Compress file — Disabling this option will disable the compression. This can lead to improved
performance if the data cannot be very well compressed (e.g. for long raw or BLOB data that is
already compressed in the database).

Include storage — The generated SQL includes the original storage information such as tablespace
names and initial sizes for table creation statements. These may differ across databases, so this
may not always be appropriate.

Include privileges — The generated SQL includes the grants of the object privileges to other users
and roles. When the objects are recreated in a different database, these users and roles need to
exist for obvious reasons.

Advantages of this method are the greatly reduced file sizes of the export files, the fact that all options
are deferred to the import phase, and that you can easily select tables during import.
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21.5 Import Tables

The Import Tables tool allows you to import table definitions and data from a file that was previously
exported with the Export Tables tool described in the previous chapter. Just like with the Export Table
tool, there are 3 methods to import tables, each with its own file format.

Oracle Import method

Oracle Import | SQL Inserts | PL/SQL Develaper |

[v Analyze Buffer size (KB} |3[| ZI

[~ Commit
|7 Constraints

[
[+ Grants ToUser I LI
2| e

=1olx|

From User I

[¥ Ignare Import Executable |D:\Ora9[l1\b|n\IMP.E><E
[ Indexes
|7 Fiows
|_ Show
Impom‘ileIC:\exportdata\demo.dmp EI Import |

| Y

This method uses a dump file created by the Oracle export utility, and launches Oracle’s import utility
to import the data. You can specify various options, each corresponding to a command line option of the
import utility (see the “Oracle Server Utilities™ guide). The Import Executable field allows you to
select a specific version of Oracle’s import utility. By default the most recent version from the current
Oracle Home will be used.

After the import is finished, a new Log tab page will be visible. This page contains the logging that was
created by the import utility.
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SQL Inserts method

Oracle Import S0L Inserts | PL/S0L Developer |

[~ Use Command "Window

[v' Use SOL*Plus

SOL*Flus Executahle

ID:\Orac\e\Oragm\bin\sqlplus.exe EI o

=1ofx|

Impom‘i\e|C\exp0rtdata\demo.sql EI Import |

4

This method executes the SQL script that was generated by the Export Tables tool. You can choose to
launch SQL*Plus to run the script, or use an internal Command Window. For the SQL*Plus alternative

you can select a specific SQL*Plus executable. By default the version from the current Oracle Home

will be used.
PL/SQL Developer method

B

Oracle Imponl S0L Inserts  PL/SOL Developer |

=1ofx|

[~ Droptables

[ Createtables

[ Truncate tables

[ Delete records

[v" Disahle tiggers

[V Disahle foreign key constraints
Caornrmit every

m records

(0 = newver)

Impom‘i\eIC\exportdata\demo.pde EI Import |

4

After selecting an import file that was previously exported using the PL/SQL Developer method, you
can select to import one or more files from the list. The following options can be specified:

. Drop tables — Drop the tables before they are recreated and loaded. The Create tables, Truncate

tables, and Delete records options are disabled in this situation, and have an implicit value.

. Create tables — Create the table before it is loaded. This includes constraints, indexes and grants.

. Truncate tables — Truncate the tables before they are loaded. This option is faster than the Delete

tables, but cannot be used if foreign key constraints exist.
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. Delete tables — Delete all records in the tables before they are loaded.

. Disable triggers — Disables all triggers of the tables before they are loaded, and enable them
afterwards. This can improve performance, and can sometimes be necessary if the triggers contain
checks that are not applicable to the import process.

. Disable foreign key constraints — Disables all foreign keys of the tables before they are loaded,
and enable them afterwards. This can be necessary for self-referencing foreign keys. Foreign keys
between different tables will not lead to conflicts, because the tables are exported in a correct
order. Disabling foreign keys can also improve performance.

e Commit every — Controls how many records will be inserted before a commit is executed. If this
value is zero, all inserts will be committed at once at the end of the SQL script. For large export
files and small rollback segments it will be necessary to supply an appropriate value here.

21.6 Export User Objects

To export the DDL (Data Definition Language) statements of all objects of a user, you can use the
Export User Objects tool. This way you can easily recreate the objects for another user, or in a different
database. After selecting Export User Objects from the Tools menu, all objects of the current user will
be presented in a grid:

& Export User Objects of JONES - o] x|

MName Type Compiled _I
| B8 BONUS TABLE 14-07-2009 14:17:00
B8 DEPT TABLE 14-07-2009 14:27:03
B EMP TABLE 14-07-2009 14:19:39
EE SALGRADE TABLE 14-07-2009 14:17:01

By DEPTNO_SEQ SEQUENCE 14-07-2009 14:17:01
By EMPNO_SEQ  SEQUENCE 14-07-2009 14:17:01

ifi) DEPARTMENT PACKAGE 14-07-2009 14:27:40
i) EMPLOYEE PACKAGE 14-07-2009 14:28:39
& EVEN FUNCTION 14-07-2009 14:17:01

% DEPARTMENT PACKAGE BODY  14-07-2009 14:27:40
&% EMPLOYEE PACKAGE BODY | 14-07-2009 14:29:06

User [JONES =l
[ Include Privieges ' Single file
V' Include Storage " File per object
V' Include Owiner " File per object / spec & body in a single file

Dutputfilel @I Expart | Wiew |

After selecting an output file, you can press the Export button to export the objects. If no specific
objects are selected in the grid, all objects will be exported. You can select objects by clicking on them,
and using the Control and Shift keys to select multiple objects and ranges of objects.

The output file isa SQL script that is compatible with Oracle’s SQL*Plus, and with PL/SQL
Developer’s Command Window. After the export operation you can press the View button to open the
generated file in a Command Window.

-

By selecting a different User, you can export objects owned by another user if the privileges of your
current user allows it.

The Include Privileges option can be enabled if you want to include the grants of the object privileges to
other users and roles. When the objects are recreated in a different database, these users and roles need
to exist for obvious reasons.
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Similarly you can enable the Include Storage option to include the storage information such as
tablespace names and initial sizes. These may differ across databases, so this may not always be
appropriate.

The Include Owner option controls whether objects are prefixed with the owner (e.g. SCOTT.EMP
instead of EMP) in the resulting output file(s).

The Single file and File per object and File per object / spec & body in a single file options control
whether a single SQL script is created that contains the DDL for all objects, or if each object should be
exported to a specific file with the object name as filename, and .sqgl as extension. In case of a package
or type you can optionally choose to get the spec & body in one file. The output file will contain a series
of calls to these object specific files. All files will be written to the directory of the output file.

21.7 Text Importer

With the text importer you can import ASCII files into the database. Most line oriented formats like
comma and tab separated fields are supported. The importer will try to determine the file format
automatically, so most of the time you don’t need to define anything, just select the file, select a table,
and that’s it.

When you open the text importer and load a text file, you will get something like the following:

* Text Importer - emp.csv =10 x|
B-8 0@ =
Data fram Textfile | [rata to Oracle |

"EMPNO" , "ENAME™, "JOE", "MGR", , "SAL", "CCMM" , "DEPTNO" -
"7369", "SMITH", "CLERK", "7302", ,"800,00", "™, "20"

"7499", "ALLEN", "SALESMAN", "7698", ,"1600,00", "300, 00", "30"
"7521", "HARD", "SALESMAN", "7698", ,"1250,00", "500, 00", "30" o
"7566", "JONES", "MANAGER", "7839", ,"2975,00", "™, "2Q"

"7654", "MARTIN", "SALESMAN", "7698", ,"1250,00", "1400,00", "30"

"7698", "BLARE", "MANAGER", "7839", ,"2850,00","", "30" ~

Configuration
G ] - o Field Start

Fieldl (+0.."."] EMPNO
Fieldzaunt Quote character F::hjg %ig ‘% ENAME ¥ Relative position [0] vlj
8 Z] I j' Fieldd (+0..".") JOB " Absolute position
i Comment line i = Character
¥ End at line-end Ficlh [+ ""] SAL
v Name in header > Field? [+0. ::::] COMM —Field End
¥ Skip empty lines Irnport fines: Fieldd (+0.."") DEPTNO " Length
I‘I . I ¥ Character [] vI

Result Preview

EMPNO [ENAME | JOB [MGR [HIREDATE [SAL  [COMM [DEPTNO | -
7369  SMITH  CLERK 7902 800.00 20

7489  ALLEN |SALESMAN 7698 1600.00 | 300.00 |30

7521  WARD |SALESMAN 7698 1250,00 500,00 |30

7566 JONES |MANAGER 7839 2975,00 20

7654 MARTIN |SALESMAN 7698 1250.00 | 1400.00 30
7698 BLAKE |MANAGER liji 2850.00 30 ﬂ

| mpart | Impart to S erpt | Close | | emp.cav loaded, 1KB Help

The importer loads the first 100 lines from the file, this raw data is shown in the top “File Data” section.
The middle section allows you to make the definition of the text file. The bottom “Result Preview” has
a grid with the data as it would be imported.
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The toolbar has buttons to select a text file, or paste text from the clipboard. Files can be of virtually
unlimited size, they are not read entirely into memory. The “New” button will clear everything in the
text importer. The open and save definition buttons allow you to re-use the definition.

If you want to import the text into a new table, press the Create table button. This will invoke the Table
Definition Editor with a column definition that matches the configuration.

The configuration is auto determined as soon as you load a file, but if this is not correct, you can create
of modify this yourself. Set the Fieldcount to the correct number, and select a field from the field list to
define a field definition. In the file data section, the specified field data is highlighted, allowing you to
check if the field definition is correct. You have the following options to configure the text import
definition:

General — Fieldcount

The number of fields per record.

Gereral — End at line end

Indicates that the record data ends at the end of a line.

General — Name in Header

Indicates if the first record holds the fieldnames.

General — Skip empty lines

When enabled, empty lines in the text file will be skipped.

General — Quote Character

Indicates the string delimiter, usually double or single quotes.

General — Comment line

Here you can select a character or the characters that indicate a comment line in the text file.
General — Import lines

The first and last lines in the text file that will be imported. If you leave this empty, the entire file
will be imported.

Field Start — Relative Position

The field starts at a relative position to the end of the previous field. 0 indicates that the field starts
where the previous field ended.

Field Start — Absolute Position

This indicates that the field starts at a fixed position.

Field Start — Character

This indicates that the field starts with a specific character. This is relative to the end of the
previous field.

Field End — Length

Indicates that the field has a fixed length.

Field End — Character

Indicates that the field end with a specific character.

For standard comma separated files (csv) all fields will have a relative start position of 0, end the field
end character should be a comma. The line end (cr/If or If or cr) will also indicate field end, so for the
last field on a line, the end character doesn’t matter.
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When you have a correct file definition, you need to select an Oracle table and indicate which text fields
should be imported in which Oracle fields. You can do this on the second tab page:

& Text Importer - emp.csv N [=1E
-2l & 08 |
Datafiom Teatfile  Data to Oracle I

Owiner Table Initializing S cript

[scatT =] Jewe =] [ CearTatle || -
Commit every... & Overwrite dulicates Finalizing Script

L i lgnore duplicates _I
Fields

Fieldl EMPNO -» EMPMHO

Fiell2 ENAME > ENAME gl HEDATE =

Field2 JOB -+ JOB 'I

Ficldd MGR > MGH el | B

Ol HINEDATE = HIFEDATE Create 5L

Field6 SAL -» SAL

Field? COMM - COMM SQL funetion [To_datel#. DWW ]
Fieldd DEPTMO -» DEPTMO

additional Oracle processing, for example: substii, 1, 20)

Result Preview

EMPNO [ENAME | JOB [MGR [HIREDATE [SAL  [COMM [DEPTNO | -
7369  SMITH  CLERK 7902 800.00 20

7499 ALLEN | SALESMAN 7698 P SEl 1600.00 30000 30

7521  WARD |SALESMAN 7698 1250,00 500,00 |30

7566  JONES | MANAGER 2975,00 20

7654 MARTIN |SALESMAN 7698 1250.00 | 1400.00 30
7698 BLAKE |MANAGER 7839 [gRvsgbtii 285000 30 ﬂ

Impart | Impart to Script | Close | | emp.cav loaded, 1KB Help

The top section has some general import parameters. The “Fields” section allows you to associate text
file fields and Oracle fields. The bottom section is the result preview for your information.

You can set the following general preferences:

e Owner/ Table
The Oracle table (or view) you want to import the data to. After selecting a table, the importer will
try to determine the field and field types automatically. This will only work if the text file has a
header.

e  Clear table
When enabled, the all records in the table will be deleted before the import.

e  Commitevery...
Indicates after how many records you want to do a commit. If you set this to 0, all data will be
committed at the end of the entire import.

e Overwrite Duplicates
A duplicate record will be updated in the database. Duplicates are based on the primary key
value(s) of the table.

. Ignore Duplicates
Duplicate records will be ignored.

. Initializing Script / Finalizing Script
These scripts will be executed before / after importing the text file. You can use any SQL
command or PL/SQL Block, separated by semi-colons or forward slashes.
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In the field definition you see a list with fields from the text file. For every field you can set the
following:
e  Field
The Oracle field you want to associate with the text field. You can leave this empty if you don’t
want to import this field.
. Fieldtype
The basic fieldtype: String, Number or Date.
. SQL function
This option allows you to define additional SQL processing. For date fields a to_date function is
added automatically. This is a very powerful option, allowing you to convert the imported data.
Basically, you can enter anything that can be processed by Oracle. You can add a # to indicate the
data. The “Create SQL” button will fill this field with a to_date function for date fields.
When the definition is complete, you can decide to save it. The toolbar has buttons to save and load
definition files. The text importer will remember which definition file was used for which text file, and
the definition file will be loaded automatically the next time you open the same text file.

You have two import buttons, “Import” and “Import to Script”. The first option will start importing the
data into the selected table. The second option will create an SQL script with insert statements.

21.8 ODBC Importer

The ODBC Importer tool allows you to import data from any ODBC data source into an Oracle table:

22 ODBC Importer _Iolx|
| =
Data fiom ODBC | Data to Oracle I
User / System DEH W
Wzer Hame. I—
Bazswond I—

Lonnect Disconnect |

" Import Queny Result

Table / Query

Wiew Data |

Result Preview

EMPMO EMAME | JOB [MGR HIREDATE (SAL [COMM| DEFTMO ﬂ
73690 SMITH  CLERK 7902.0 1960-12-17 00:00:00 500.0 0.0
74990 ALLEN  SALESMAN 76380 1981-02-2000:00:00 1600.0 300
75210 ‘WARD  SALESMAN  7695.0 1981-02-22 00:00:00 1250.0 30.0
75660 JOMES MANAGER | 7639.0 1961-04-0200:00:00 2975.0 200 Bl

Import | [mport to Seript | Close | | Help

On the first page of the ODBC Importer you need to select the ODBC data source, and optionally
provide a user name and password for this data source. You can subsequently connect, after which the
table list will be populated with all tables from the data source. Selecting a table will populate the Result
Preview pane. Instead of selecting a table, you can also provide a query by selecting the Import Query
Result option and entering a query text. This can be useful if you want to limit the rows or columns, or
if the results come from more than one table.
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After entering the source specifications, you can switch to the Data to Oracle tab page to select the
destination table and to specify the column mapping:

%2 ODBC Importer —|ol x|
a1

Data fiom ODBC Data toDracle |

Owner Table
|scart x| [emPLOVEES = I Clear Table
Commit every... = Dvenaite duplicates

100

= lgnore duplicates

EMFND - EMPND .
ENAME > ENAME ] 08 =]
Fieldiype [ (5 ing) =

MGR > MGR

HIREDATE - HIREDATE Freate S0l |

SAL > SAL

COMM > COMM S0L function | |

DEPTHO -» DEPTNO additional Oracle processing, for example: substr(. 1, 20)

Result Preview

EMPNO ENAME | JOB MGR. [HIREDATE [SAL [COMM]DEPTMO] i’
73690 SMITH 7902.0/ 1980-12-17 00:00:00| 600.0 0.0
74930 ALLEN I 7593.0/ 1951-02-20 00:00:00 1600.0 30.0
75210 WARD 7688.0) 1951-02-22 00:00:00 1260.0 30.0
75660 JOMES 7638.0/1981-04-02 00:00:00 2875.0 20.0 Bl

Import | Impart to Seript | Close | ‘ Help

In the General section you can select an owner and a table into which the records should be imported.
You can also select if you want to clear the table before the import, select a commit interval (0 =
commit at end) and to ignore duplicate rows or to overwrite them.

In the Fields section you can map fields from the ODBC data source (left) to columns in the Oracle
table (right). For each column you can additionally supply a SQL function. For example, if you want to
convert a string field to uppercase, enter upper(#). The hash sign will be replaced by the field data for
each record, and the resulting expression will be supplied in the insert statement.

After completing the field mapping, you can press the Import button to import the data into the Oracle
table. If you hold down the Ctrl key while pressing this button, an example insert statement will be
displayed so that you can verify the field mapping and SQL functions you specified.

To reuse this import definition later, you can press the Save Definition button on the toolbar. This
definition can be opened later by pressing the Open Definition button.
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21.9 Data Generator

The data generator allows you to create demo and test data. This can be helpful to test applications and
see how they perform with large amounts of data. You find the Data Generator under the Tools menu.

Basically, the definition consists of one or more tables, the number of records you want to generate, and
the field data definitions. The buttons on the top left allow you to open and save a definition.

2 Data Generator - DeptEmpDemo.gd _ o il
& DEPTDEMO | EMPOEMO |
Cwner Table Mumber of records
» | |scoTT | |DEFTDEMO | |5
ol = |
Name [Type [size [Data [Master
¥ DEFTNO NUMBER =20 =l sequence(ld. 10) -
|| DNAME VARCHAR? = 14 =|[AG.5) -
# | |Loc WARCHARZ ~ 13 4| UpperCase(Tity) =
£ = § -
=
=
3
for}
B
|
2B Definition | Options | Result
-
i V7

Above you see the supplied deptemp demo that creates data for deptdemo and empdemo tables, similar

to the well-known dept and emp tables. You will find the following items on this page:

e  Table - The name of the table.

. Number of records — The number of records you want to generate. This can be a number, but also
arange like 10..100.

. Name — The field name.

. Type — The data type of the field.

. Size - The field size (when appropriate). For number fields this will be scale, precision.

. Data — The definition of the data for a field (see below).

. Master — If this table is the detail of another table, you can set the master. For every generated
master record, the specified number of detail records are generated.

You can use the “Add existing table” button to add an existing table. You can also drag & drop one

from the Object Bowser.

Data definition

The data definition determines the generated data. If you want to create simple characters, you can enter
character definitions between square brackets: [data]

Data can be a mix of the following pre-defined sets:

a: a..z (lowercase characters)

A: A..Z (uppercase characters)

@: A..Z and a..z (all characters)

#: A.Z and a..z and 0..9 (all characters and numbers)
*: #33..#126 (all ASCII characters)

0: 0..9 (all numbers)

1:1..9 (all numbers except 0)

9: 0..9 (all numbers)
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For example:
[Aaa00] to generate strings like: Gxe21, Liy05, etc.
You can also add literal text between single quotes.
For example:
[AA - 1000] to generate strings like: CX-4903, SY-1044, etc.
Space characters in the definition are ignored, unless they are within quotes.

If you want a character repeated a number of times, you can add the number after the character between
brackets (n). You can also add a random number (min..max).

For example:
[Aa(5..15) ' Aa(8..20)] for results like: "Masfae Qwwecdsadif"

Literal text in the definition does not have to be enclosed in brackets. In other words, ['hello] and 'hello’
are equivalent. Text entered without quotes is interpreted as a function.

The are several special functions available:

. Signal(Min, Max, Delta, Noise)
Returns technical measurement data (like temperatures). Min and Max determine the range, Delta
the maximum change, and you can also add some noise. Example: Signal(-10, 20, 0.1, 0.1)

. Random([Min], Max)
Returns random numbers between Min and Max. If only Max is specified, Min is set to 0. For date
fields you can enter dates for Min and Max.

. Sequence(Start, [Inc], [WithinParent])
Returns sequence numbers, starting with Start, and incrementing with Inc (which is 1 by default).
For a detail table you can additionally specify the WithinParent keyword to indicate that the
sequence should be reset for each parent record.

. List('item'(weight), 'item'(weight), ...)
Returns randomly one of the specified items. A weight can be added between brackets to allow
specific items to occur more often than others.
For example: List('CLERK'(50), 'SALESMAN'(30), 'MANAGER'(10))

e List(select statement)
Like the previous List function, but the items are returned by the SQL select statement. You can
use bind variables to refer by name to previously generated values.
For example: List(select empno from emp where deptno = :deptno) will create a list for all
managers in the department with the currently generated deptno.

e SQL(expression)
Returns the given SQL expression. This can include standard SQL values, operators and functions,
as well as user-defined functions. The expression can also be a select statement that returns
exactly one column and one row. You can use bind variables to refer by name to other generated
values.
For example: SQL('Department ' || :deptno)

e Text([Style], MaxCharacters, [WordsPerLine, LinesPerParagraph])
This function returns text. The optional Style parameter can be Lorumlpsum (default), English,
German or Japanese. It can also be a character set like [aA], in which case words are generated
from the specified set.
MaxCharacters determines the maximum size of the generated text, and the optional
WordsPerLine, and LinesPerParagraph determine the size of a line and a paragraph. The specified
size can be a number or a range (min..max).

. File(path, path, ...)
Randomly selects a file from the given paths, and inserts the contents. Allows you to enter binary
data (like images) into the database. The path can have wildcards like d:\images\*.bmp.
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You can change the text results of the previous functions by using the following functions:

. Uppercase()

. LowerCase()

. InitCaps()

For example: InitCaps( List(select ename from emp) )

There are also several predefined data sets available to generate more or less real data. You can use the
following definitions:

Firstname — General list of first names

Lastname — General list of last names

Company — Company names (random list of existing companies)
Addressl — Address line 1

Address2 — Address line 2

ZIP - ZIP code

City — City

State — State

Country — Country

Email (related to Firstname, Lastname and Country)
There are also some example user-defined data sets available

. Components.Code — General article items: Article code

. Components.Description — Article description (Computer parts)

. Components.Price — Article price

. Elements.Name — Chemical elements (name)

. Elements.Symbol — Chemical elements (symbol)

These data sets can be found in the DataGenerator\UserData directory as elements.txt and
components.txt. You can add you own sets if you want. Simply add a comma-separated file where the
first line holds the description between square brackets. You can use data from your file by specifying
filename.description like the two examples.

Al the functions and data mentioned above can be added together, for example: Random(10..99) + '-' +

[A(4)]

The + is optional, but there should at least be a space as separator.
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Options

The options tab page allows you to set some preferences specific to the data generator definition. You
can specify a date format (as used for example by the Random function). You can also specify after how
many records you want a commit (set to 0 to commit once when finished). The delay preference is only
useful in some real-time testing where you want data inserted at a specific speed.

* Data Generator - DeptEmpDemo.gd : _ o]

Date Format Commit ewery.
|dd—mmw |1 iln} M

Delay (mSec)
0

User Definitions | Initialization Scnptl

ltem \Va\ue
H 09AF
h 0.9a.1

=
r

E

@ B &

Definition  Options | Result

- y

The “User Definitions” section allows you to define or override character sets used in the [data]
definition. The Item is always a single character, and the Value is one or more space separated ranges of
characters like: A..Z a..z 0..9 #200..#220. For example: to define a hexadecimal character set, you could
specify H as the item, and 0..9 A..F as the value.

The “Initialization Script” section allows you to specify SQL statements that should be executed before
the data is inserted into the database. Typically, this would be a statement to create the tables, or to
truncate the tables, to select a rollback segment, and so on. Multiple statements need to be separated by
semicolons.

General options that will be used by default for all data generators can be defined by pressing the
Preferences button on the left. See chapter 20.24 for more details. These preferences will be overruled if
the corresponding preference in the data generator definition is also set.

Generating Data
There are three buttons available on the bottom left to generate the actual data:

e  Startatestrun— This will generate the data and display the results in a grid on the Result tab page.
You can export these results in various formats by right-clicking on the grid.

e  Create data as SQL — Generates the data as a SQL script. This will only work if you don’t add data
from files with the file function.

e  Create data in DB — Generates the data into the Oracle database.
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21.10 Compare User Objects

After making changes to table definitions, views, program units, and so on, it may be useful to
propagate these changes to another database user. This maybe another development environment, or a
testing environment. To compare the objects of your development user with another user, you can use
the Compare User Objects function in the Tools menu. This will bring up the following dialog:

Selection | Options | Differences |
‘Name _|Type _|Compiled _|

2 BONUS TABLE 15-10-2007 11:36:01

F DEPT TABLE 21-04-2011 16:22:13

B EMP TABLE 21-04-2011 16:21:53

H SALGRADE TABLE 15-10-2007 11:36:01

B DEPTNO_SEQ SEQUENCE 21-04-2011 16:16:10

=y EMPNO_SEQ SEQUENCE 21-04-2011 16:16:29

i DEPARTMENT PACKAGE 14-12-2009 13:37:39

f EMPLOYEE PACKAGE 21-04-2011 16:23:05

g DEPT_BEFORE_INSERT TRIGGER 26-11-2008 15:12:35

UserISCO'IT j

JONES@CHICAGO e

’=|' scott@chicago I

On the Selection tab page you can select the objects you wish to compare. If you want to compare
objects owned by a different user than the currently connected user, you can select it from the User
selection list. After making this selection, you can press the Target Session button, to select the user and
database that you want to compare. This will enable the Compare button, which you can press to start
the compare operation.

On the Options tab page, you can set the following options:

4" Compare User Objects of SCOTT _|o|x]
'Selection Options |D\ﬁerences|

[ Include storage in generated DOL for new objects

||

Target schema:

| Ignare case in PLASOL code
[ Ignore white space in PL/SOL code
|— Ignore comments in PLSOL code

Cormpare

’=| T scoft@chicago I

You can select the Include storage... option to include the storage information such as tablespace names
and initial sizes for new objects. These may differ across databases, so this may not always be
appropriate.
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The Target schema can be set if the objects in the target session are owned by another user than the
target user that is connected.

The Ignore case in PL/SQL code will ignore case differences that do not affect the meaning of the code.
Case differences in string expressions will not be ignored, because they are significant.

The Ignore white space in PL/SQL code will ignore differences in spaces, tabs and linefeeds that do not
affect the meaning of the code. Differences in string expressions will not be ignored, because they are
significant.

The Ignore comments in PL/SQL code will ignore all differences in comments.

When the compare operation is finished, the dialog will switch to the Differences tab page, which will
show a list of all objects that are different:

Selection | Gpiions Differences |
‘ Name _| Type _| Compiled _|
=5 DEPT TABLE 21-04-2011 16:22:13
EMP____|TABLE 21-04-2011 16:21:53
% EMPLOYEE PACKAGE BOL21-04-2011 16:23:05
rem Differences be n SCOTTE@CHICAGO and JONES@CHICAGO, creat [=
rem Press Apply bu 1, or run in Command Window or SQL*Plus c
_________________________ v
-—— Ch -
,,,,,,,,,,, ]
-- Add/modify © s £

alter table EMP modify job default null;
alter table EMP modify hiredate default null;

| | i
"=~ scat@chicagn |

This list is sorted in order of dependency. Below the list of different objects of the target user, you see
the SQL that needs to be executed to make these objects equal to the corresponding objects of the
current user. If no object is selected, the SQL of all objects is displayed. If one or more objects are
selected, only the SQL for the selected object(s) is displayed. In the example above, the default values
for the JOB and HIREDATE columns of the EMP table are cleared in the target schema.

The Show Differences button will show a visual line-by-line difference of the old and new source file of
an object. This can be useful to view the changes made in Program Units, or can help you determine
why a specific DDL statement was generated for other object types. The Configure External Difference
Tool button allows you to configure the difference tool should be used. By default the ExamDiff utility
will be used, for which a Pro version is available (See the About item of ExamDiff’s Info menu). See
also chapter 20.23.

You can now press the Apply SQL button to execute this SQL in the target session. You can
alternatively save the SQL in a file by pressing the Save SQL button, or you can copy it to the clipboard
by pressing the Copy SQL button.

When objects are compared, the following properties are ignored:

e  Storage — Properties such as the next extent and pct free of tables and indexes are not considered
relevant for comparison.

. Constraints with system generated names — These constraints will have different names for the 2
users, so they cannot be compared. If a table is new in the target session, these constraints will be
generated though.
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e  Table creation properties — Properties that would require the recreation of the table are ignored.
e  Table data — To export table data, use the Export Table function (see chapter 21.4).

e Sequence values — The current value of a sequence is considered data.

21.11 Compare Table Data

After inserting, updating and deleting records in one or more tables during development, it may be
useful to propagate these changes to the same table owned by a different user. This may be a
propagation from a development to a test database, or to a production database, or to another project
member.

To do so, you can use the Compare Table Data tool from the Tools menu. This will bring up the
following dialog:

& Compare Table Data of JONES o [=]E3|

Selection IUpl\Unsl D\Iferance&'
[Name _[Type _[Compiled |
| EE BONUS TABLE | 14-07-2003 14:17:00
EE DEPT TABLE | 14-07-2003 14:27:03
B EMP TABLE | 14-07-2009 14:19:39
BB SALGRADE TABLE  14-07-2009 141701

User [JONES B3|

Target Session | (Mot connected) L — |
T

On the Selection tab page you can select the table(s) you want to compare. If you want to compare
tables owned by a different user than the currently connected user, you can select it from the User
selection list. After making this selection, you can press the Target Session button, to select the user and
database that you want to compare. This will enable the Compare button, which you can press to start
the compare operation, but you can also go to the Options tab page first:

<" Compare Table Data of JONES _ ol x|

Selection  Optians ID\fferancesl

Action:
I nserts
v Updates
v Deletes

Commit every I‘\UU E records
Iode | G enerate script hd
Target schema -

™ Include owner in SEL

Compare |

1
On this page you specify various options for the compare process.
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Actions — You can select the various actions you want to be performed in the target session. If, for
example, you omit the Delete action, only inserts and updates will be performed.

Commit every N records — Controls after how many records a commit will occur. If you specify
0, only one commit will occur at the end of the process.

Mode - Select Generate script to generate a SQL script with inserts, updates, deletes and commits.
You can save this script later and run it in the Command Window or in SQL*Plus. Select Update
database to immediately apply the changes in the target session.

Target schema — If the tables are located in a different schema than the user of the target session,

you can specify this schema here. The target user will need the necessary privileges on the
selected tables in the target schema.

. Include owner in SQL - This option us only useful in script mode, and will prefix the table

names in the generated SQL with the owner. Doing so will allow you to connect as a different user

later when you run the script, and still apply the changes in the correct schema.

After selecting the appropriate options, you can press the Compare button to start the compare process.

After completion, the Differences will be displayed:

& Compare Table Data of JONES _|of x|

Selechnnl Options  Differences |

DELETE FROM DEFT T WHERE DEPTHO = 97: :I n
UPDATE DEFT T SET DNAME = 'SRLES'

WHERE DEFTNC = 30;
INSERT INTO DEFT T (DEPTNC, DNAME, LOC) ¢

VALUES (50, 'SHIPPING', 'CHICRGO'):
COMMIT: j

In update mode, this tab page will merely display the total number of inserted, updated, and deleted
records for each table.

In script mode, you can review all differences and save the resulting script by pressing the Save SQL to
file button to the right. Note that you can limit the script to specific tables by making a table selection in
the upper pane. You can also copy the SQL to the clipboard or apply the selected changes in the target

session by pressing the corresponding buttons to the right.
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21.12 Event Monitor

The event monitor allows you to capture and view dbms_pipe messages or dbms_alert signals generated
by program units in other sessions. Just specify the event type (Alert or Pipe), the name(s) of the alert or
pipe, and press the Start button.

The following screenshot shows an Event Monitor that waits for an alert named ‘DEPT’ or ‘EMP’:

EventtypelAIert 'I Ewvent name(s) Ideptemp Stap |
Event on DEFT at 15-01-2Z001 17:47:48 n
dept 70 inserted
Event on DEPT at 15-01-2001 17:48:18 Sy

dept S0 inserted

Event on EMP at 19-01-2001 15:05:2z2

emp 9564 inserted

L
—I y

Whenever such an event occurs, the name of the pipe or alert and the timestamp is written to the output
page, followed by the information of the event:

. Pipe: all items of the message are displayed
e Alert: the value of the message parameter of the dbms_alert.signal call is displayed

For alert events you can specify multiple names, separated by colons. For pipe events you can specify
just one pipe name.
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21.13 Sessions

The Sessions tool displays all sessions in the database instance you are currently connected to:

ol x|
2wl G| F [aesions -
Usemame_lSid_lSenal#_lSlatus _IMachine_lPrngram _|Mndu\e _IAv:tiDn _|Lngnnt\me _I
| |AsA 9 295 INACTIVE AAPZEDD  AAA exe 28-12-2005 15:63:.08
545 13 338 ACTIVE  AAAIEND  plsgldev.exe | PLSOL Developer Main session 28-12-2005 16:34:35
> ACTIVE] & ""'"’__— |
S5 1o 476 W Window - Object Privilege
Enable SQL Tréte
Disable SQL Trace
Refresh list
Copy
Print
1 »
Export > ||
Cursors | SOL Text | Statisties | Locks | ——
|Saddr _lUsername_lAddress_lHashva\ue_lSqltext _l
ﬂ58213048 SCOTT BECI2CD0 30117043398 select™from emp

In the upper half of the window you see information about the sessions, such as the username, the sid
and serial number (which identify the session), the status, and so on. You can sort the session list by
clicking on the header button of a column. For example: to quickly find all active sessions, click on the
header button of the status column.

You can also select a Session Filter from the toolbar to limit the session list to a specific selection of
sessions, or to limit the columns displayed. A filter can also define the order of the session and the
columns.

If you right-click on a session, this will bring up a popup menu with the following items:
. Kill — Allows you to kill the selected session.

. Enable SQL Trace — Enables SQL Trace for the selected session. This option will be disabled if
your Oracle Server version does not support this feature, or if you do not have privileges on the
dbms_system package.

. Disable SQL Trace — Disables SQL Trace for the selected session.

. Refresh list — Refreshes the session list.

. Copy — Copies the session list to the clipboard.

. Print — Prints the session list.

. Export — Export the session list in CSV, TSV, HTML or XML format.

The Refresh, Kill, Enable SQL Trace and Disable SQL Trace functions are also accessible through the
toolbar at the top of the window. The toolbar additionally includes an Auto refresh button. When
pressed, the session list and session information will periodically be refreshed. You can define the
refresh period by right-clicking on the button.

The bottom half of the window contains several tab pages with information about the selected session.
The information on these tab pages can be refreshed, copied or printed by right-clicking on the list and
selecting the corresponding item from the popup menu. For more information about the individual
columns displayed in the lists, see the “Oracle Server Reference™ guide.
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You can create, modify or delete the Session Queries for the session list and the session detail tab pages.
To do so, press the Define Session Queries button on the toolbar. This will bring up the following
dialog:

* Define Session Queries 10| x|
Filters |DE[ai|g|
Al sessions &
sessions &
4
—Definiti
LCaption IActive sEgsoNs
Query |select * from visession ;I
where usemame is not null and status = 'ACTIVE
order by logon_time, sid
E
Carcel

At the top you can switch between the Filters and Detail queries. The filters control what is displayed in
the session list, and the details control what is displayed on the detail tab pages.

At the right side you see four buttons to create a new query, to delete a query, or to move a query up or
down in the list. When you create or modify a query you must supply the following information:
Filters

The Caption shows up in the filter selection list in the toolbar.

The Query is the select statement that fetches the session information for the main session list. You can
use this query to:

1. Limit the sessions displayed (e.g. only the active sessions).
2. Define the order in which the sessions are displayed.
3. Define which columns are displayed, and in which order.

Details

The Caption shows up on the tabs of the detail tab pages. The position in the list determines the tab-
position in the session window.

The Query is the SQL select statement that fetches the session information. This select statement should
usually contain the :sid bind variable, which will contain the sid of the selected session when the query
is executed. You can use any of the columns of the v$session view though, such as the :username,
:sql_address, or :sql_hash_value. If your query leads to an error at run time, it will be displayed on the
corresponding tab page after execution.

To concatenate the value(s) of multiple rows of a session detail query, you can use the /* concatenate */
hint in the SQL text. For example:

select sql_text from v$sqltext_with_newlines
where address = hextoraw(:sql_address)

and hash_value = :sql_hash_value

order by piece

/* concatenate */
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The sql_text column of all rows returned by this query will be concatenated, and displayed as one value
in the session detail grid.

21.14 User Defined Tools

You can define your own tools for integration in the PL/SQL Developer IDE. These tools can be added
as menu items to start external applications or to perform SQL or PL/SQL scripts in the database for the
current session. You can configure parameters so you can pass a filename and connect-string to the
application.

A good example of this would be SQL*Plus. You could add a menu to start SQL*Plus and with the
appropriate settings you could let SQL*Plus log on and even let it execute the currently opened file.

Another example is a tool to set the NLS settings to a specific set of values. You can create a script to
execute the correct “alter session” statements, and add this script to the menu from where it can be
invoked for the session of the SQL Window, Test Window and so on.

To configure the external tools, you’ll have to select the Configure Tools menu item in the Tools menu.
The following dialog will appear:

# Tools Configuration il

s
] Met Configuration Assistant ﬁ
[¥] Short Date Farmat ]
[¥] Long Date Format —

rDietail

General |Menu | Button | Opjlnnsl

Description IS&OL Plus

Twpe IExtemaI LI
Executable/Script |D 4 Oraclet 8014 hint sglplusw exe Elj
Parameters I#:nnned (D#file Elj
DefaultPath [#dir | j

Ok I Cancel | Execute Help

The four buttons on the right allow you to insert and delete items, as well as to move items up or down
in the list. If you hold down the ctrl key when you press the insert button, the new created item will be
copied from the currently selected one.

The Execute button can be used to execute the selected tool. If you hold down ctrl when this button is
selected, a message will popup containing information (with replaced parameters) about what would
have been executed.

The list shows all configured tools and the bottom half shows the configuration of the selected tool. The
configuration is split into three sections:

. General — to define the executable/script that is to be run and its parameters
. Menu - to define the place where the corresponding menu-item should appear
. Button - to define a button image and description for the toolbar

. Options — for some additional tool settings
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To explain the external tool configuration we will add a SQL*Plus menu to PL/SQL Developer as an
example.

The General Tab

The first thing to do after you have created a new item with the insert button, is to define the tool type.
If you select External, the tool will be launched as an external application. This is applicable for
SQL*Plus. If you select Session, the tool will run a SQL script for the current session when the tool is
invoked.

Next you will need to enter a description in the General tab page. The description is the name that will
be displayed in the menu and in the list. You can enter an & in front of the character you want as a
shortcut key (S&QL*Plus to get SQL*Plus). If you enter — as a description, a separator line will be
displayed.

The third crucial thing is the filename of the program or script to execute. For external tools you can
enter any executable file or even documents if you wish, in which case the associated application will
be started. The browse button opens a file dialog allowing you to look for files. Most Oracle tools are
located in Oracle’s bin directory and SQL*Plus can be found at <oracle_home>\bin\sqlplusw.exe.

These three steps are enough to get SQL*Plus to work from a menu. You can additionally define
parameters to be passed to the application and you can define a default path. You can use the default
path as an alternative to a full path for the executable or file parameter. For SQL*Plus you could add a
connection string (#connect) and a link to a file to execute (#file).

The little button with the down arrow on the right allows you to pick a variable that you can be inserted
in any of the fields. These variables are all related to the current connection and opened file. They will
be replaced by corresponding information when the tool is executed. The following variables are
supported:

Variable Meaning

#file Represents the filename (without path) of the file in the current window
#path The filename with path

#dir The directory of the file in the current window

#object The selected browser object (e.g. SCOTT.EMP)

#otype The selected browser object type (e.g. TABLE)

#oowner The object owner (SCOTT)

#oname The object name (EMP)

#connect The full connect string of the current PL/SQL Developer connection (e.g. scott/tiger@demo)
#username The username

#password The password

#database The database

It turned out that SQL*Plus didn’t like a full path with possible spaces as file parameter, that’s why #dir
is specified as default directory so only the filename had to be passed to SQL*Plus.
Session tools

For session tools you need to specify a SQL script which can contain multiple SQL statements or
PL/SQL blocks. SQL statements can be separated by semicolons or slashes, PL/SQL blocks need to be
terminated with a slash. This is the same syntax as in SQL*Plus.

Example 1 — Germany.sql:

alter session set nls_language = "german”;
alter session set nls_territory = "germany”;

Example 2 — SpecialRole.sql:
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begin

dbms_session.set_role(role_cmd => "special_role identified by &Password®);
end;
/

Note that you can add substitution variables to the script to make it even more flexible. You will be
prompted for these variable values when the tool is invoked. When the SpecialRole script above is
invoked, you will be prompted for the password.

If you want to use any of the specified parameters in the script, you must use &1, &2 and so on. The
number indicates the order of the parameter on the command-line. You will not be prompted for these
command-line substitution variables.

The Menu Tab

By default all configured tools are added at the bottom of the Tool menu. If you want to create them
elsewhere or even in their own main menu, you can use the menu tab page:

rDetail

General Menu |Eium:|n I Oppunsl

hain menu ITDU\S

Submenu IOracIe Tools

Ll L L

Sub-sub menu I

(" Below " Above (% AtEnd

If you want your tool menu item to be created in a specific main menu you can select one from the Main
Menu edit list or you can enter a new menu name if you want to create a new main menu.

If you have entered a Main Menu, you can use the Sub Menu and Sub-sub Menu to indicate the exact
location where you want to create your new menu item.

You can use the three radio buttons (Below, Above & At End) to specify where the new menu should
be placed relative to the specified menu. If you specify a new (sub) menu, you should always select ‘At
End’ because ‘Below’ and ‘Above’ only have a meaning if you refer to an existing (sub) menu.

Example 1:

Main menu Tools

Sub menu Oracle tools
Sub-sub menu

Location AtEnd

This will create an Oracle tools sub menu in the Tools main menu. If you were going to add multiple
Oracle related tools, a specific submenu might be a good idea.

Example 2:

Main menu Oracle
Sub menu

Sub-sub menu

Location At End

This will create an Oracle main menu. You should probably only create a new main menu if you are
using the tools regularly and you want them ‘close-by’.

If you want to add your tool as first item in the Tools menu you should enter:

Main menu

Tools

Sub menu

Preferences...

Sub-sub menu
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[ Location [ Above |
This will create a menu above the existing Preferences menu item.

The Button Tab
You can define if and how an external tool should be included on the toolbar:

rDetail

General | Meny  Buttan | Options |

[ Toolbar button

Description ILaun:h SOL*Flus

Image &% [ SALPlusbmp

e  Toolbar button
When this option is enabled, the external tool can be included on the toolbar.

. Description

The description will be displayed as a hint when you hold the mouse cursor over the toolbar
button. If you leave this description empty, the description of the external tool (as displayed in the
menu) will be used.

. Image

Press the image button to select a Windows bitmap file (*.bmp) for the toolbar button. The size of
this image should preferably be 20 x 20 pixels. Note that PL/SQL Developer will always load the
bitmap file from the original location, so you should not remove or rename this file without also
changing the corresponding external tool.

PL/SQL Developer comes with a number of standard bitmap files that you can choose from. These
files are located in the Icons subdirectory in the PL/SQL Developer installation directory. This is
the default directory of the image selector.

The Options Tab

The Options tab page allow you to make the following settings:

r—Detail

generall Menu I Button  Options |

[T Save Window Window Types

™ st for Tool I”" Program \window
o _ [T SEL Window

—Requirements——— | [~ Test Wwindaw

[ Active Connection [ Command Windaw

[ Browser Object ™ Beport Window

. Save Window

When this option is set, the active Window will be saved before the tool is executed. You should
probably do this when the tool gets the file as a parameter and you want to be sure it uses the
current data.

. Wait for Tool
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When enabled, PL/SQL Developer will wait for the tool to finish. This can be useful if you have
an external program that modifies a source file. When this tool is invoked with this option, the
contents of the current window will be refreshed with the modified source file. This will typically
be combined this with the Save Window option.

Active Connection

If the tool is only useful if PL/SQL Developer is connected (if you pass the connect string as
parameter), you should set the Active Connection setting. This will disable the menu if PL/SQL
Developer is not connected.

Browser Object

Set this option if the tool works on selected objects in the Object Browser

Window Types

If the tool requires a specific window, you can specify these in this section. If one or more are
selected, the menu will only be enabled if the active window type is specified.

21.15 Test Manager

To perform regression testing for your Oracle stored program units you can use the Test Manager. It
allows you to define a Test Set, which is a collection of Test Scripts with input variable values and
required output. It additionally allows you to specify required performance:

£ Test Manager - DeptEmp.ts =10l x|

I

&-2d 8 B

Definition |Run |

Test script |S.\ms\TEBISE\S\DeptEmp\DEp\NamE tst ﬁl
Description [Deptame(7439)
Mew session [
Enabled [
Performance seconds
0 |Variable name ‘Global |Input value |0ulput value
|»| ¥ | p_empno - 7499
Variables |_™ | result r SALES
F |2
s

| scott@chicago - |

For this example the Test Set consists of 3 Test Scripts. For the selected DeptName.tst script the
p_empno variable will get the value 7499 on input, and after execution the result variable value must be

SALES.
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Running a Test Set will quickly reveal if the tested program units still function correctly and/or with the
required performance:

[0l x|
N oa-E B

Definition  Fun |

| ‘ Description ‘ Result ‘
@ DeptName(7499) Variable result: required "SALES", actual "Sales"

- DeptName(7369)
MgrName(7782)

|

Input variable wvalues -~

p_empno = "7369"
result = ""

Output variable values

p_empno = "7369"
result = "RESEARCH"

DEMS_OUTPUT e

20-04-2011 13:01:31 - Department RESEARCH fetched for employee 7369 LI
|~ scofi@chicago - _ |

All failed Test Scripts will have a red indicator and will be placed at the top. In this case the
DeptName(7499) script failed, because the specification required that the result is “SALES” instead of
the actual ““Sales” value.

This Log pane below the results will show the input values and output values of each variable. If a
selected Test Script generates dbms_output, it will be displayed in the Log pane as well.

Creating a Test Set

To create a Test Set, select the Test Manager item from the Tools menu. An empty Test Manager screen
appears, for which you can create new Test Scripts or add existing Test Scripts. At the top of the Test
Manager you see a list of Test Scripts, where you can add scripts to the set, remove scripts from the set,
or change the order of the scripts. At the bottom you see the definition of the selected script.

Before creating a new Test Script, it is a good idea to save the Test Set by pressing the Save Test Set
button on the toolbar. All new Test Scripts will be created in the same directory as the Test Set by
default, and it may be a good idea to use a separate directory for each Test Set, so that all related test
assets can be managed from this single directory.

Adding a Test Script to the Test Set

There are 2 methods to add a Test Script to the Test Set:

1. Drag & drop a procedure or function from the Object Browser to the Test Manager. A new Test
Window will be opened with a call to this program unit, and variables for all parameters and the
return value. Save the Test Script under a descriptive name, preferably in the same directory as the
Test Set.
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2. Press the New button to the right of the Test Script list. The following dialog will appear:
x|

‘:) Do you want to open a new Test Window to create a Test Script?
.
X

I~ Don't show this message again

Click Yes to create a new, empty Test Script. You will need to manually program the Test Script
and save it before it can be used in the Test Set.
Click No if you want to add an existing Test Script to the Test Set.

After the Test Script is saved, you can specify the definition in the Test Set:

e  Testscript — The filename of the Test Script. This will already by filled in if you have created and
saved a new Test Script. If you want to add an existing Test Script, press the Browse button to the
right of this field.

. Description — A functional description of the script. If you run a single script multiple times with
different input variable values, you should include this in the description as well so that it can
quickly be recognized in the list.

. New Session — Use this option to force a new session for the script, so that it becomes
independent of session state changes from previous scripts. By default all scripts use the same
session.

. Enabled — Use this option to enable or disable the script for the Test Set. Only enabled scripts will
be included in the test run, and disabled scripts will be skipped.

. Performance — The required performance can be specified as the maximum number of seconds
(fractions allowed). If you leave this field empty, the performance will not be tested.

. Variables — For each variable in the Test Script, enter the name, input value, and required output
value. The input value will be passed to the Test Script before execution. The required output
value will be tested after execution. If you leave the output value empty, it will not be tested. To
test for null values, enter the word “null”.

If a variable is marked as Global it will have a global value that will be passed to other Test
Scripts. If a global variable does not have an input value, the global value will be used. After
execution the global value will be updated accordingly.

To test for doms_output, enter “dbms_output” for the variable name, and enter the required text
for the output value.

At the lower left you see 2 buttons that allow you to quickly run and check the selected Test Script, or
to open it in a Test Window for editing.

Duplicating a Test Script

Very often you want to run the same Test Script with different input and output variable values. To
accommodate this, you can select an existing Test Script in the Test Set, and hold down the Ctrl-key
while pressing the New button. The newly created Test Set item will inherit all properties from the
selected item, so that you only need to change the description and variable values.

Running a Test Set

To run a Test Set, press the Run button on the toolbar. The Test Manager will switch to the Run tab
page, and each enabled Test Script will be executed in a separate Test Window. Failures will be
indicated with a red indicator, and will be placed at the top of the list. Successful scripts will have a
green indicator, and will be placed at the bottom of the list.
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To investigate a failure, right-click on the script and select Debug from the popup menu, or double-click
on the script. A Test Window with the Test Script will be created, and the input variable values will be
set accordingly. Now you can debug the Test Script to determine the cause of the error.

Right-click on the test run results to copy them to the clipboard, to print them, or to export them in
various formats.

Running a Test Set from the command-line

You can also run a Test Set from the command line in the Command Window. For example:

SQL> RunTestSet U:\TestSets\DeptEmp.ts D:\Temp\DeptEmp.log

This will run the U:\TestSets\DeptEmp.ts test set and will create a log file in D:\Temp\DeptEmp.log. If
you omit the log filename, a log file with the same name as the Test Set will be created.

The log file contains 3 lines for each Test Script:

Test = <Description of the Test Script>
Result = Success | Failed | Error | Slow | Skipped
Message = <Message of the Test Script run>

This allows you to create a Command File that executes one or more Test Sets. The following script
would run 2 Test Sets and subsequently exit the application:

RunTestSet U:\TestSets\DeptEmp.ts D:\Temp\DeptEmp. log
RunTestSet U:\TestSets\Sales.ts D:\Temp\Sales.log
Exit Application

This script can in turn be called from the PL/SQL Developer command-line. For example:
plsgldev.exe UserlD=scott/tiger@chicago CommandFile=U:\TestSets\RunTests.sql
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22. The Editor

Each window that allows you to edit some SQL or PL/SQL source uses the same editor. This editor has
many special features that can make life a bit easier for a programmer.

22.1 Selection functions

The editor allows you to perform various functions on a selection of text. These functions are available
from the Selection item in the Edit menu, and are only applicable if you have made a text selection. You
can assign a function key to these functions through the Key Configuration preferences.

. Indent / Unindent
The number of characters depend on the editor preferences. The Tab and Shift-Tab keys are
always assigned to these 2 functions if a selection exists.

. Lowercase / Uppercase

. Comment / Uncomment
Uses /* and */ to quickly comment a selection.

e  Apply Syntax Case
If you have set the Editor Keyword Case preference to Uppercase, Lowercase or Init Caps, then
this function will apply this style to all keywords in the selected text.

. Sort
The lines of the selection will be sorted in ascending order. If you invoke the sort function again,
the selection will be sorted in descending order.

. Color mark
Applies the current marker color to the selection (see also chapter 22.11).

22.2 Column selection

You can select a text column by holding down the Alt key when you make a selection:

sSaL |Output | Statistics'

create table ENF e

[HUMBER. (7,2 ,
[HUMBER. (7,2 ,
[MUMBER [ Z )

tablespace USER DATL
pctfree 10
poctused 40 LI

]
—IRE Yy
You can copy, paste, cut, delete, uppercase, lowercase, (un)indent, and (un)comment this selection as

usual. If you use the Apply Syntax Case function, and a keyword crosses the column boundary, it will
not be processed.
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22.3 Code Assistant

The code assistant is a very powerful feature that provides help as you type your SQL or PL/SQL code.
When for example you type dbms_alert. and hesitate for a little while, the editor will display a list of
elements in the dbms_alert package:

and dept.deptno = emp.deptno;

cbms_alert.
end if; miEswait constant a
return(result| .ot defaults procedure =
exception register procedura ==
when no_data | omove pracadure
end; removeall  procedure ﬂ
¥

As you continue to type the name of the doms_alert procedure, the list will be reduced. If for example
you type an r after doms_alert., only the register, remove and removeall procedures will still be present
in the list. When you press enter while the Code Assistant is visible, the name of the currently selected
item will be inserted into the source. You can also use the arrow keys to navigate through the Code
Assistant and select the desired item. Pressing the Escape key will remove the Code Assistant.

The Code Assistant will provide assistance for the following object types:

Object type Elements

Package Procedures, functions, types, variables, constants and exceptions
Function, Procedure Parameters, inserted with named notation (param =>)

Table, View Columns

Sequence nextval and currval

User Objects owned by the user

Cursor variable

Fields of the select statement of the cursor

Record type variable

Fields of the record type

Table%rowtype variable

Columns of the table

Object type

Attributes (for default constructor)

Object type variable

Attributes and methods

Object type column

Attributes and methods

Collection variable

Collection methods (first, next, limit, and so on)

:new and :old The columns of the table or view of the current trigger
Self The attributes and methods of the current type
@ A list of database links

The Code Assistant can also help you type the names of object (tables, packages, and so on), keywords
and PL/SQL identifiers that have meaning within the current context. If, for example, you type pro ina
SQL Editor and hesitate, the keywords procedure and profile will be displayed by the Code Assistant,
along with any database object name that starts with pro. The context depends on the currently
connected user (which determines the available object names), the type of editor (which determines the
available keywords), and the program unit you are editing (which determines the available PL/SQL
identifiers). The database object names that are included for this context list are fetched when you first
make a connection to the database. The queries that are executed are defined in the CANames.sql file in
the PL/SQL Developer installation directory or in the %APPDAT A%\PLSQL Developer directory. You
can change these queries as needed.
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The Code Assistant can be automatically and/or manually invoked, and the delay time before the Code
Assistant automatically becomes active after typing an object name can be defined by a preference.
Furthermore you can define if you want to describe a user, and if so, which object types you want to be
included. The context description and the minimum number of characters that need to be typed before it
can be activated can be configured as well. All these preferences are described in chapter 20.15.

22.4 Recalling statements

Whenever you successfully execute a statement in a SQL Window, Command Window, or Report
Window, this statement is stored in the global statement recall buffer. You can recall the most recently
executed statements in the editor by selecting Recall Statement from the Edit menu, or by pressing Ctrl-
E. This will bring up a selection list like this:

| Tme ____ |User IStatement |4
26-10 142916 tt | select®fram emp

26-10-2001 14:29:.09 scott | update emp set sal = round(sal)

28-10-2001 14:268:43 scott | update emp set sal = round(sal. 2)

268-10-2001 14:27:35 scott | select®from emp twhere tdeptno =10

28-10-2001 14:27:29 scott | select™from emp twhere tempno is null

28-10-2001 14:26:47 scott  select™from deptt

26-10-2001 14:25:47 | sys select*from dba_role_privs p where p.grantee="PUBLIC

28-10-2001 14:25:28 | sws select™from dha_rale_privs pwhere p.grantee = 'SCOTT'

28-10-2001 14:24:39 scatt | grant select, references on emp to pukblic

: 26-10-2001 14:24:19 scott | analyze table dept compute statistics LI

The statements are displayed in order of execution, with the most recent one displayed first. In the list
you see the time, the user, and (part of) the statement text. You can now select a statement and double-
click it (or press Enter) to insert it at the cursor position in the editor from where the list was invoked.

Note that statements that include passwords are not placed in the global statement recall buffer for
security reasons.

You can sort the list by time, by user or by statement text by pressing the corresponding buttons in the
header of the list. To display just the statements that were executed by the currently connected user,
right click on the list and select the Current user item from the popup menu. In the same popup menu
you can switch back to All users, and you can delete a statement or copy the statement text to the
clipboard.

To find a specific statement you can invoke the find function by using the corresponding function key
(default Ctrl-F), or by right-clicking on the list and selecting Find statement from the popup menu. The
find function will start after the currently selected statement, and will continue at the first statement if it
has not found a match.

Furthermore the popup menu contains functions to delete the selected statement from the list, to copy it
to the clipboard, or to export the entire list to a CSV file.

The recall buffer can hold up to 200 statements, which will be stored in the application data directory of
your windows profile. You can change this statement limit and the directory through the preferences
(see chapter 20.26).
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22.5 Special Copy

If you are using PL/SQL Developer to write SQL and PL/SQL code that you subsequently want to use
in other tools, such as a 3GL programming language, it may be that you need the code in a slightly
different format. Let us assume that you wrote and tested a SQL statement like this in PL/SQL
Developer:

select deptno, sum(sal) mgr_sal from emp
where job = "MANAGER™

group by deptno

order by mgr_sal desc

If, for example, you want to use this statement in Borland Delphi, you may need a format like this:

SQL := "select deptno, sum(sal) mgr_sal from emp" + #13#10 +
“"where job = ""MANAGER""" + #13#10 +
"group by deptno® + #13#10 +
"order by mgr_sal desc”;

For this purpose you can use the Special Copy function from the Edit menu or from the popup menu
after right clicking on a selection in an editor. This function has a submenu, which shows all special
copy formats that are defined. After selecting a format, the converted code is stored on the clipboard, so
that you can paste it in the editor of the corresponding tool.

The special copy formats are defined in the SpecialCopy subdirectory in the PL/SQL Developer
installation directory. You can change the pre-defined copy formats, or add new copy formats. Simply
add a text file with a .copy extension that contains a variable for the first line of the PL/SQL code
(<line_1>), the last line of the PL/SQL code (<line_N>) and a variable for all other lines (<line_*>).
The example for Borland Delphi is as follows:

;PL/SQL Developer SpecialCopy definition for Borland Delphi
;<line_1> for first line

;<line_*> for all other lines

;<line_N> for last line

SQL := "<line_1>" + #13#10 +
“<line_*>" + #13#10 +
"<line_n>";

The first line needs to be preceded by the assignment to the SQL variable, and needs to be followed by a
CR/LF pair. The last line does not need the CR/LF pair, but needs to be terminated by a semi-colon. All
other lines merely need to be followed by CR/LF.

You can omit <line_1> and <line_n> if they are the same as <line_*>.

In some languages you need to use escape sequences for special characters. For example, in C++ you
would use \t for a tab character (ASCII code 9). To define these escape sequences, use the #define
keyword:

#define char(9) = \t
#define \ = \\
String('<line_1>\n") +
String('<line_*>\n") +
String('<line_n>");

You can additionally use “#define compress” to indicate that you want to remove all redundant blank
characters from the result (spaces, tabs, and linefeeds).
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Note that the name of the .copy file will be included in the menu, so you should use a descriptive
filename.

22.6 Context sensitive help

Most programmers frequently access reference information on the functions that they are using in their
programs. To find this reference information as quickly as possible, placing the cursor on a keyword in
the source text and pressing F1 will search for this keyword in Oracle’s online manuals.

You can read chapter 31 for more information about PL/SQL Developer’s Help system.

22.7 Database object popup menu

When your program accesses a database object, you very often need to get some information from this
object, or you want to manipulate it. You may want to know its description or its properties. For a table
or view you may want to query or edit the data. For a function or procedure you perhaps want to test a

certain scenario.

If you right-click on an object name in the editor, you will see the same popup-menu that you see when
you right-click on it in the Object Browser. Therefore, all relevant functions for this object are
immediately available from within the editor.

22.8 Explain Plan

To invoke an Explain Plan Window for a SQL statement in an editor, select the text of the statement,
right-click on it, and select the Explain Plan item from the popup menu. If no text is selected, the entire
source will be taken to the Explain Plan Window. If the SQL statement contains PL/SQL variables, you
must alter the statement in the Explain Plan Window as described in chapter 6.1.

22.9 Macros

The editor has a powerful macro function that allows for quick and easy macro recording and playback,
which can be used to automate a specific repetitive task.

A recorded macro can be stored in the Macro Library to be executed later. Macros in the library will
usually be some recurring repetitive task (like swap assignment: a := b; -> b := a;), or may contain code
snippets. For example: why continuously look up how a cursor type must be declared when you can
type it once and record for later use?

To record a macro, press F11 or select the Record item in the Macro menu of the Tools menu. The
toolbar now displays a flashing recorder icon, indicating that you are currently recording a macro. All
keyboard strokes are recorded for playback, which implies that you should not use the mouse during
macro recording. By pressing F11 again, macro recording is ended. Pressing F12 will playback the
macro.
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To store the currently recorded macro in the Macro Library, select the Library item in the Macro menu.
This will open the Macro Library dialog:

2 Macro Library

ment ™

El ]
Open/Close log file

4-»||;§~|;ﬁ*|£

¥ Macros as main menu item

Definition | keys |

Desctription ISWﬁp assignment

[v Addto menu

|7 Toolbar buttan

Description ISWap assignment on the current line

Image g]l Swap.bmp
K | Cancel | Select Help

Press the New button to add a new macro with the currently recorded definition. You can enter a
description for the macro and indicate whether it should be included in the Macro menu. This way you
can make some macros easily available, and you can additionally assign a function key to each macro
through the Key Configuration preferences. If the Macros as main menu item option is checked, the
Macros menu is located in the main menu. If it is not checked, it will be located under the Tools menu.

When the Toolbar button option is enabled, the external tool can additionally be included on the
toolbar. The corresponding Description will be displayed as a hint when you hold the mouse cursor over
the toolbar button. If you leave this description empty, the main description of the macro (as displayed
in the library and in the menu) will be used. Press the Image button to select a Windows bitmap file
(*.bmp) for the toolbar button. The size of this image should preferably be 20 x 20 pixels. Note that
PL/SQL Developer will always load the bitmap file from the original location, so you should not
remove or rename this file without also changing the corresponding macro. PL/SQL Developer comes
with a number of standard bitmap files that you can choose from. These files are located in the Icons
subdirectory in the PL/SQL Developer installation directory. This is the default directory of the image
selector.

On the Keys tab page you can view and change the keyboard actions for the macro.

To execute a stored macro, open the Macro Library and double-click on its name. The selected macro
can now be executed by pressing F12. When you select a macro in the menu, it will immediately be
executed, and it can be re-executed by pressing F12.

22.10 Bookmarks

To mark a location in an editor you can add a bookmark. Simply press Ctrl-Kn (where n is a number
from 0 .. 9) to add a bookmark at the current location. A green bookmark will appear in the gutter, with
the corresponding number. To navigate to this bookmark later, you can press Ctrl-Qn. Alternatively,
you can use the Set bookmark and Go to bookmark submenus from the Edit menu.
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The Bookmark list item of the Edit menu will bring up an global hierarchical display of all editor
bookmarks:

Frogram Window - employee.pck
employes
G @) Lire 17: from dept, emp

Line 16: select dept.dname into result
153 Program Window - Edit source of package DEPARTMENT@CHICAGD
L Department
E Line 8: type TDept is dept%iowtype;

In this tree view you can see the windows, editors, and lines where a bookmark is located. Clicking on a
bookmark will bring the window and editor to the front, will navigate to that bookmark. You can dock
the bookmark list to make it accessible at all times without blocking any other windows.

22.11 Color marks

You can add color marks in an editor to highlight specific sections. To do so, select the text you want to
mark and press the Color marker button on the toolbar:

& -

The background color of the selected text will change to the current marker color:
—— Fetch the name of the manager
select m.ename into result
from emp e, emp m
where e.empno = xa
and m.emphno = e.mgr;

To change the marker color, press the arrow next to the button and select a new color. To clear a color
mark, place the cursor within the marked text without making a selection, and press the Color marker
button.
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22.12 Code Contents

The Code Contents feature is restricted to the Program Editor. It displays the complete structure of a
program unit. This is most useful in large package bodies and type bodies, which can span thousands of
lines of PL/SQL code. The Code Contents are displayed in a tree at the left side of a Program Window:

2 program Window - employee.pck =] 1]
@ Ermployes 8 employes |
4] X | | [Declaration Code section Cade section | [ Statement 2l >|
E423 Declaration = ZTJ] -- Return the name of the manager ;I
_%:—E’:;ziﬁ 28 function MgrName (p_empno in emp.empno%type) return emp.enameitype is
ERGY DeptName 29 result emp.enamettype;
-G8 Marhame 30 begin
Eagsmm?r:;: 31 if p empno is null then
£33 Declaration 32 — 1 is null, return an empty name
() result 33 result :
B ?%d; section o else
4 Condtion == - ager
=23 Code section 36 select m.ename into result _
=) Slatems
j‘ﬂ 37 from emp e, emp m
E‘.a Code secti - where e 1E][Ifl I;O _p empno
B Select | result 1= null; SSmPnO = p_enp
= Statement = and m.empno = e.mgr;
E-{® Exception handler 10 end if;
<> Condition .
353 Code section 41 return (result) ;
-5 Statement 42 exception
[]3 FetchRecord | 43 when no_data_found then return(null);
B (€} InsetRecond . - -
E3-(E) UpdateRecord e end;
F-(F) deleterscord | 15 =l
a2 | 4

The Code Contents keep track of your current location in the source code. As you navigate through the
source code, the selected item will indicate where exactly you are located.

If you move the mouse over an item in the Code Contents, the corresponding source code in the editor
will be highlighted as illustrated above.

Clicking on an item in the Code Contents will immediately navigate to its declaration. Double-clicking
on the item will expand or collapse it. Right clicking on an item will display a popup menu that allows
you to select the corresponding source code in the editor, to cut or copy it to the clipboard, to paste over
it from the clipboard, to convert it to a comment, to expand all child items, or to create a Test Script for
it (if it’s a public program unit).

The contents can be alphabetically sorted by pressing the Sort contents button at the top of the content
pane. Only the main contents will be sorted: parameters, local variables and so on will not be sorted.
The button will stay down, and pressing it again will revert the contents to their original order.

To close the Code Contents you can click on the Close button at the upper right corner. You can also
right click in the editor and select the Contents item to make it disappear or appear, or select the Code
Contents item in the Tools menu.

By default the Code Contents are visible. To change this default you can close the Code Contents in the
current Program Window and select the Save Layout item in the Window menu.
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22.13 Code Hierarchy

The Code Hierarchy is restricted to the Program Editor, and displays the hierarchical structure of the
PL/SQL code at the cursor location. It is located above the editor:

= Program Window - employee.pck =]} 3]
@ Employes € emoloyes |
] Pl=E Cade section | [ 1] [Cade section | [Geleer I
Select
3 Declaration - 2'.!Jj -- Return the name of the —————————— B
_%:—S:;:Esuﬁ 26|80 function MgrName (p_empno i SM lype) return emp.enameltype is
I .Demﬂame 29 result emp.enameitype. Copy
(8 MarName 30 begin sty
S (PS’E‘"'Z‘;;: =] if p empno is null then Delete
& 23 Declaration 32 —— If emp is null, z fE— |y name
(@) result 33 zresult := null; T —
(=423 Code section sald else
7 7@ Conditon 35 —— Fetch the name of t|RNEAPRINFIERES
£=-423 Code section 36| &1 select m.ename into re |
i e Statement
H 37 from emp e, emp m
(=423 Code section P €, v
T2 Select 38 where e.empno = p empno
= Statement 39 and m.empno = e.mgr;
2@ <E:>ceplinn handler sl [ end if:
Condition r .
5-£3 Code section 41 return (result) ;
= Statement 42 exception
B ) FetchRecord | 43 when no_data_found then return(null);
& &) InsetRecond " end:
&) UpdateRecord L
15 {F) deleterscord ] =2 -
=EED Z

In the example above, the cursor is located at a statement within a within an[If
statement within a within a . If you move the mouse over the items of the

Code Hierarchy, the corresponding source code will be highlighted. Clicking on an item will select the
corresponding source code.

If you right-click on an item (as illustrated above), a popup menu will be displayed that allows you to
select the source code, to cut or copy the source code to the clipboard, to paste the clipboard contents
over the item, to delete the source code, or to convert the source code to or from a comment.



206 PL/SQL Developer 9.0 User’s Guide

22.14 Code Folding

Code Folding allows you to show or hide specific sections of PL/SQL code. You could for example fold
all procedures and functions within a package, and unfold just the one that you are interested in. As
another example you can fold structures like loops and if/then/else statements to get a better overview
within a long program unit. In the following example, several functions have been folded, as well as an
if-statement:

= Program Window - cmployee pok =lo|x|
) Evpleyee 8 empicyee |

[Forcien ) [Coge secton ) [F] o
5 3 Declarston c ame of tI I=|
@ Emwflecand 9@ [function DeptName(p empno ]
(@) t_DectRncerd -
#-(§) Denthisme 28
E () Mgrhinme Fil -- Return the name of the man
e '—ig:_::: 288 function MgrName (p_empno in emp.empnoitype) return emp.enameitype is
4.3 Dedamon 29 result emp.enamettype:
[ 20 begin
‘am“mﬂ 31| Af p_ampno is null then ... _
T @ Condoon 41|E if result is null than
[ () Cade nection a2 result := '<Unknowns";
- FetchPecond It end if:
InsenFiecont n
UpdateRiecord 44 return (result) ;
B (E} dedctrencoed 15 axcaption
51 () LockRecord i when no_data_found then return(null):
47 end
48
LE] Fe 1 employee record
50/ function FetchRecord(p_empno in integer) return t EmpRecord is ...
54 =l
=& x| &

To fold a code section, press the minus sign in the left margin of the editor. To unfold it, press the plus
sign in the left margin. You can also right-click in the left margin and select Fold All or Unfold All from
the popup menu. If you move the mouse cursor over a folded line in the editor, the folded section is
temporarily displayed in a separate pane.

22.15 Split Editing

To edit or view 2 separate sections of the same source, you can use the Split Editing feature. Simply use
the mouse to drag the splitter at the top of the editor down:

= Program Window - cmployee pok =lo|x|
) Evpleyee 8 empicyee |
8 x .
3 Declaraten =l
@ t_Empiiecont =
= ®(L2|;N|:: 23 result emp.enanchtype:
E () Mgrhinme B begin . =
EHZ Parameter bt -
(&) p_smpna £l from emp &, emp m =
- f_igdamu £ where o pRo = poe
sk — .
+1 (] Coda sacticn ELINN and m.empno m ¢.mgr;
& @ Exeeption handier | [ and if;
42 Candiion 418 if result is null then
) Cnde nection @ result := '<Unknown>';
Ferchflecord R
InsenRecon LEIN end .\.f:l
UpdateFecord a4 return (result) ;
delrd prncod 45 .xmt‘.on
+i (B} Locklecord
@ i6 when no_data found then return(null);
47 end
48
L Fe 4 1 record
50 8 function FelchRecord(p_empno in integer) zeturn L _EmpRecord is
=1 Taerd n =l
=& e | &

You can now navigate, view, and edit both sections simultaneously.
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22.16 Hyperlink navigation

In your PL/SQL code you very often have references to elements that are defined elsewhere. You can
for example reference a PL/SQL type within the same package body, or within the specification of the
same package, or within another package. The same goes for function or procedure calls, variables,
views, and so on.

To easily find a declaration from within a Program Window, you can move the mouse pointer over such
a reference, hold down the Ctrl key, and press the left mouse button. After holding down the Ctrl key,
the identifier under the mouse pointer will become light blue and underlined, resembling the familiar
hyperlinks in an HTML document:

—— Created : 17-12-1585 17:15:246
—— Purpose ! Lock an emplovee record
procedure lockrecord(p_empno in emp.empnostype) is
dureny wvarchar2(1):
hegin
if p_empno !'= g lastrecord.empno then
select null into dureny frﬁ Emp
where ewpno = p_empno
for update;
end if:
end lockrecord:

If the declaration is located within the same source, PL/SQL Developer will navigate there. After that,

the rest of the program units within the same Program Window will be searched. Then it will search all
other Program Windows that are currently open. Finally, it will try to open a new Program Window or
SQL Window for the object that contains the declaration and will navigate there.

By default hyperlink navigation will locate a declaration in a package or type specification, if
appropriate. To open the package or type body instead of the specification, you can right-click on a
hyperlink.

22.17 Navigation buttons

Whenever you jump to an absolute location from within an editor in a window, PL/SQL Developer will
make a bookmark for the previous location. These bookmarks can be accessed with the Navigate back
and Navigate forward buttons on the main toolbar:

2| 8-ef

@ employes | Program Window Line 9: begin £

Program Windmﬂ Line 43: when no_data_found then return(null);
Program Window*Line 28: function Mgriame(p_empno in emp.empno%type) ret...
F L4 L) T =

aration

mpRecord

3EP‘RECDM subtype t_EmpRecord is emptrowtype:

a?nn;e subtype t_DeptRecord is deptirowtype;

arameter list . .

' p_empna -- Return the name of the d tment

aclaration function DeptName (p empno in emp.empho%type) 1

Cracnlt e U =

Bookmarks will be added when you navigate in the Code Contents, use the Find function, click on a
compilation error, go to the top or end of the editor, use hyperlink navigation, open a new window, and
S0 on.
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22.18 Refactoring

The refactoring function allows you to quickly reorganize your PL/SQL code. It works on the selected
code, or — if no selection is made — on the current statement. Right-clicking on a statement or selection
provides the following refactoring functions in the corresponding submenu:

. Rename item
Renames the current variable, parameter, constant or program unit. Both the declaration and usage
will be renamed.

. Extract procedure
If a program unit has become too large or too complex, you can make a selection and convert it to
a separate procedure. All variables used within and outside of the selection will be converted to
parameters. All variables used only within the selection will be moved from the current program
unit to the new program unit. The selection will be replaced by a call to the new program unit.

. Extract local constant
If a certain expression should be converted to a local constant, you can select it and provide the
constant name. A local constant will be created within the current subprogram, of a type that is
determined from the expression. All occurrences of the expression in the current subprogram will
be replaced by the constant name.

. Extract global constant
If a certain expression should be converted to a global constant, you can select it and provide the
constant name. A global constant will be created within the current package, of a type that is
determined from the expression. All occurrences of the expression in the current package will be
replaced by the constant name.

. Replace assignment with initialization
If a local variable assignment is purely for initialization, you can move it to the declaration of the
variable. You can right-click on a statement or select multiple statements.

If the results of a refactoring action are not satisfactory, you can simply undo it.

22.19 Search Bar

The Search Bar is available from the Edit menu and can be displayed as a floating tool, or docked at the
top or bottom of the work area. In its docked position, it can be permanently available to perform
searches across multiple editors and multiple windows:

Ip_empnd ;I . TN 7 HBE ‘ne"

After entering a search word, you can press the Search button or press Enter. The search results will be
highlighted in the editor(s), and you can press the Go to next/previous occurrence buttons to navigate
the search results. You can press Esc to move the focus from the search bar to the editor. Press the Hide
occurrences button to clear the highlighted search results in the editors.




PL/SQL Developer 9.0 User’s Guide 209

The Search list button will bring up an hierarchical display of the search results:

B3 Program Window - employes.pok
E@ employee
[ -
“end function mgrname(p_empno in emp. empnotype] return emp enametype;
EI@ employes

" funclion deptname{p_empno in emp.empno®type] return dept.dnameXtype is

& it p_empno iz null
~ where emp.empno = p_empno
~ ‘employee ' || to_char(p_smpna]);
-+ funclion marnarmep_smpno in emp.empnatype] return emp. ename?type is
- it p_empno is null then
o where &.8mpho = p_empho
~ ‘emplopee ' || to_char(p_empna]);
=R

Te: indow - DeptName. tst

Editar

: « result = emploves. deptnamelp_empno = :p_empnal;
“end resull = emplopee. deptnamelp_empno => :p_empnal;

E-E
E

In this tree view you can see the windows, editors, and lines where the search results are found.
Clicking on a search result will bring the window and editor to the front, will navigate to the search
result, and will select it. You can dock the search list to make it accessible at all times without blocking
any other windows.

On the search bar you can additionally enable options to search all editors or just the current editor, to
search case sensitive, to search for whole words only, and to use regular expressions.
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23. The Large Data Editor

The Large Data Editor will be invoked whenever you need to view or edit long, long raw, CLOB,
BLOB or BFILE column or variable values. It can additionally be used to edit varchar2 data. The Large
Data Editor will analyze the data, and will attempt to display it in the correct format. It can display
values as text, RTF, XML, HTML, Image (bmp, jpg, gif, tiff and others), and Hex data. Furthermore it
can launch an external application (e.g. MS Word or Acrobat Reader) to view or edit the data.

Invoking the Large Data Editor for an image will result in the following screen:
_iolx]
= LT B

Ted |RTF %ML |HTML Image [Hex | Extemal|

BMP. 525 x 700

1.103.254 Bytes
ok Cancel Help |

The toolbar at the top of the editor includes the following buttons:

e Open - Opens the contents of a file into the editor.

e  Save - Saves the contents of the editor to a file.

. Print — Prints the editor contents in the currently selected format.

e  Cut- Place the editor contents on the clipboard in the currently selected format, and subsequently
clear (null) the editor contents.

e  Copy - Place the editor contents on the clipboard in the currently selected format.
. Paste — Paste the clipboard data into the editor in the currently selected format.
. Clear — Clear (null) the editor contents.

Below the toolbar you can select a tab page for the correct format of the editor contents. Multiple
formats may be applicable for some data. For example, an HTML document can be viewed in HTML
format or in Text format. All data can be viewed in Hex (binary) format.

When making changes to the editor contents in a specific format, you can immediately switch to a
different format to view these changes. For example, when viewing an HTML document you can switch
to Text format to make changes and return to HTML format to view these changes.
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After pressing the OK button your changes will be propagated to the function from where the Large
Data Editor was invoked.

23.1 Editing plain text

The text editor can be used to view or edit any kind of plain text data:

* Large Data Editor - dept.notes | il
= L= i<

Ted  |RTF |WML | HTML |Hex | Extemal|

Lorem ipsum dolor sit amet, consectetuer adipiscing elit -
Nam ante erat, nonummy id, facilisis sit amet, nonummy sollicitudin, eros.
Vestibulum sed dui. Etiam mattis nulla at est. Vestibulum eleifend. Suspendiss¢
diam massa, westibulum eget, tristigque at, eleifend ac, arcu. Morbi dolor. Cra:
et nisl. Donec condimentum ipsum et pede.

Vestibulum rutrum vuolputate ligula

Maecenas ac welit quis dolor tristique pretium. Cras vitae dui non arcu

porttitor dictum. Vivamus lobortis. S5ed tincidunt pellentesgue leo. \’estih'.ll.:m_

tortor. Proin neque mauris, posuere vehicula, volutpat id, sollicitudin id,

elic.

Mauris pulvinar. Aenean facilisis nisl ut mauris. Morbi ultrices, eros vel

mollis auctor, nunc ante eleifend mi, nec iaculis elit turpis id nunc.

Aenean sollicitudin. In hac habitasse platea dictumst. Morbi lorem neque,

dictum ac, ultrices in, adipiscing eget, ligula. Pellentesque habitant morbi =
_>|_I

0K | Cancel

3.949 Bytes

It can also be used to edit XML and HTML text. Switching to the XML or HTML tab page will
immediately show the results of these changes.

23.2 Editing RTF

The RTF editor can be used to view and edit text in Rich Text Format. It allows you to easily change
font type, size, color, style, and alignment:

* Large Data Editor - dept.notes | il
o &8 & i<
Tew  RTF WML | HTML |Hex | Extemal|

ITlmes MNew Foman ﬂ‘lﬁiﬂli Custom ;” L: ] ||?

Lorem ipsum dolor sit amet, consectetuer adipiscing elit =
Nam ante erat, nonummy id, facilisis sit amet, nonummy sollicitudin, eros.
Vestibulum sed dui. Etiam mattis nulla at est. Vestibulum eleifend. Suspendisse
diam massa, vestibulum eget, tristique at, eleifend ac, arcu. Morbi dolor. Cras

et nisl. Donec condimentum ipsum et pede |

Vestibulum rutrum vulputate ligula

Maecenas ac velit quis dolor tristique pretium. Cras vitae dui non arcu

porttitor dictum. Vivamus lobortis. Sed tincidunt pellentesque leo. Vestibulum
tortor. Proin neque mauris, posuere vehicula, volutpat id, sollicitudin id, elit.
Mauris pulvinar. Aenean facilisis nisl ut mauris. Morbi ultrices, eros vel x|

QK Cancel

3.949 Bytes
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23.3 Editing XML

When viewing XML content, the editor will initially switch to the XML tab page:

2 Large Data Editor - xml_documents.xml_text

s H & & B2 @

i
i

#

=[olx]

Tex |RTF %ML |HTML | Hex | Extemal

[#) xhL Document
B4 ROWDATA
25y ROW

Y EMPHO
[ ENAME
-0 JoB

) MGR

) HIREDATE
[ AL

) oMM
. DEPTNO
- ROW
- ROW
w5 ROw
[ ROW

-

|

Aftribute Name

| Atribute VWalue

7369

<EMPNC>7369</EMPNO>

Ok Cancel

2828 Bytes

Here you can see the structure of the XML document in a tree view, and edit individual elements and

attributes.

Pressing the Parse XML button will parse the XML document, and will report any errors. This requires
that you have Net8 8.1 or later, and that the user has access to the SYS.XMLTYPE type or the

XMLPARSER package.

You can press the Format XML button on the toolbar to apply standard formatting rules on the

document.

If you switch to the plain text format tab page for an XML document, then the appropriate syntax
highlighting will be applied.

2+ Large Data Editor - xml_documents.xml_text

E= R

=

Ted |RTF | ML | HTML | Hex | Exteral]

<?xml version="1.0"7>
<ROWDATA>
<ROW>
<EMPNC>7369</EMPNO>
<ENAME>SMITH</ENAME>
<JOB>CLERK</JOB>
<MGR>7902</MGR>

<SRL>800, 00</SAL>
<COMM/ >
<DEPTNHC>20</DEPTNO>

</ROW>

<ROW>
<EMFNO>7435</EMPNO>
<ENAME>ALLEN</ENAME>
<JOB>SALESMAN</JOB>
<MGR>7698< /MGRY

<HIREDATE>17-12-1980«/HIREDATE>

=l

OK Cancel

2.628 Bytes
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23.4 Editing HTML

When viewing HTML content, the editor will initially switch to the HTML tab page:
—lojx|
= & B®

Tex |RTF |xML  HTML |Hex | Extemall

EMPNO |ENAME JOB MGR HIREDATE| SAL |COMM DEPTNO =
7369 SMITH |CLERK 7902 (17-12-1980 |800.00 20
7499 ALLEN |SALESMAN 7698 (20-02-1981 |1.600,00 300,00 (30
7521 'WARD |SALESMAN 7698 (22-02-1981 |1.250.00 500,00 (30
7566 JONES |\MANAGER |7839 |02-04-1981 |2.975.00 20
7654 MARTIN |SALESMAN 7698 [28-09-1981 |1.250,00 1.400,00(30
7698 BLAKE |MANAGER 7839 [01-05-1981 |2.850,00 30
7782 CLARK MANAGER |7839 |09-06-1981 |2.450.00 10
7788 SCOTT |ANALYST ||7566 |09-12-19813.000,00 20
7839 KING PRESIDENT 17-11-1981 |5.000,00 10 —
7844 TURNER |SALESMAN (7698 |08-09-1981 |1.500.00 0.00 30
7876 ADAMS |CLERK 7788 [12-01-1983 |1.100,00 20 _I
o e | 2.041 Bytes Help

This view is always read-only. You can however switch to the Text tab page to view and edit the data in
plain text format, and switch back to the HTML tab page to view the formatted layout.

23.5 Editing images

The image editor will display images in most popular formats, such as JPG, BMP, GIF, and so on. If the
image is larger than the editor can display, the image will be resized to fit. This does not affect the
contents, it is merely a visual effect. Below the image you will see the image format and the image size
in pixels.

To change an image, you can either press the Open button on the toolbar to load it from a file, or copy
the image from another source to the clipboard and press the Paste button. Note that the image format
will change to BMP when copying/pasting via the clipboard! To ensure that the original format is
preserved you should load it from a file.

23.6 Editing Hex data

To view or edit the editor contents in hexadecimal format you can switch to the Hex tab page:
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rge Data Editor - contracts.scan : = |EI il
=2 2 ¥ i) ‘

Tex |RTE |#ML | HTML |imoge Hex | Exemall

-
2550 4446 2D31 2E33 0D25 E2E3 CFD3 ODOA %PDF-1.3.333I0.. j
313% 2030 206F 626Z 0D3C 3C20 0D2F 4C6% 19 0 obj.<< ./Li
6E65 6172 697A 6564 2031 200D 2F4F 2032 nearized 1 ./0 2
3120 0D2F 4820 5B20 3133 3030 2033 3130 1 ./H [ 1300 310
205D 200D 2F4C 2031 3134 3234 3231 200D 1 ./L 1142421
8] 2F45 2031 EGBQ 3738 3331 200D 2F4E 2032 /E 1097831 ./N 2
200D 2F54 2031 3134 313% 3233 200D 3E3E /T 1141523 L»>
200D €56E 646F €26 0D20 2020 2020 2020 .endobi.
2020 2020 2020 2020 2020 2020 2020 2020
2020 2020 2020 2020 2020 2020 2020 2020
2020 2020 2020 2020 2020 2020 2078 7265 xre
660D 3139 2034 3320 0D30 3030 3030 3030 f.19 43 .0000000
3031 3620 3030 3030 3020 €E20 0D30 3030 0Oleée 00000 n .000
3030 3031 3230 3720 3030 3030 3020 €E20 0001207 00000 n ﬂ

jol % Cancel |
1142 422 Bytes

On the left you see 8 columns with words (16 bits) of hexadecimal data. On the right you see the text
representation of the hexadecimal data. You can edit both the hexadecimal and textual representation.

If you right-click on the hex editor you can select a different column layout.

23.7 Invoking an external viewer or editor

For many large objects that are stored in the database it may be necessary to invoke an external viewer
or editor. For example, if a BLOB column contains the contents an Acrobat PDF file (Portable
Document File), it will be necessary to invoke the Acrobat Reader. When invoking the Large Data
Editor for such content, you will initially be taken to the Text or Hex tab page. After that, you can
switch to the External tab page:

2 Large Data Editor - contracts.scan ] - |EI il

Tedt |RTF |xML | HTML | mage | Hex

Eile extension

Execute with I EI

Execute

l_ Execute automatically next time
(keep Ctl pressed if wou want to open this dialog nexttime)

Show registered file types |

(0], Cancel
— — 1.142.422 Bytes
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Here you can define which program should be executed. First you will need to define the file extension.
Before executing the external program, a temporary file with the editor contents will be saved with that
extension. Next you will need to define which program should be executed. After that you can press the
Execute button to view the content in the external program. If you change the file in the external
program and save it, the Large Data Editor will notice this change and will allow you to import these
changes back into the editor.

When viewing column data, the association between the table/column and the external program will be
remembered for the next time you want to view it. If you additionally enable the Execute automatically
next time option, then the Large Data Editor will immediately invoke the external program. To override
this automatic behavior, hold down the Ctrl key when invoking the editor.

Most programs will have registered their file types, and instead of manually defining the extension and
program you can simply select it from a list. First you will need to press the Show registered file types
button. After that you can search for the correct file type and double-click on it. For a PDF file this
would be the Adobe Acrobat File:

rge Data Editor - contracts.scan oy || EI
=

Text |RTF | %ML | HTML | image | Hex  Extemal

File: extension |.pdf

Execute with I”C Y Program Files\Adobe\Acrobat 5.04Acrobat\Acrobatexe" "2%1" EI

Execute

[¥ Execute automatically next time
(keep Chrl pressed ifvou want to open this dialog next time)

Actohat Catalog Index (pox) i’
Acrobat Rights Management Document (rmf)

Active Directony-guery (.gds)

Address Book File (waly
Adnbe Acrabat Document {pelf
Adobe Acrobat Forms Document (fdf)
Adobe Acrobat Forms Docurment (xfdf)

Advanced Streaming Format File (lsf)

Advanced Streaming Redirector File (lsx)

AIFF Audio (,aif) =|

Ok Cancel
1.142.422 Bytes

If you right-click on the file type list, you can sort it by extension or description (default).
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24. The Query Builder

The Query Builder allows you to create and modify select statements in your PL/SQL and SQL source
files. It provides a simple point and click interface to build the field list, the table list, where clause and
order by clause of the select statement.

24.1 Creating a new select statement

For this example we will assume that we want to create a join statement between the dept and emp
table, and show some columns from both tables:

select e.empno, e.ename, d.deptno, d.dname

from emp e, dept d

order by e.empno
To create a new select statement, place the editor cursor at the text position where you want it to be
inserted, and press the Query Builder button on the toolbar (or select the Query Builder item from the
Tools menu). This will bring up an empty Query Builder Form:

DeptErmp
= 3 Tablos
w BB BOnUS
T DEPT
+ EEE
w BB PRODUCT
[T SALGRADE
- Views

Where
I Distinet 7 lnto

On the left side you see an Object Browser with just the tables and views. On the right you see the
work area, which is empty right now. At the bottom you see 3 panels with the field list (and optionally
the into item list), the where clause and the order by clause. The bottom section contains a tab page that
allows you to switch to the actual SQL text that would be created from the current query definition.

At the top of the window you see a toolbar with a New button to create a new query, an Open button to
open a previously saved query definition from a file, a Save button to save the current query definition
to a file, a Parse button to parse the current query definition, and a Preferences button. The OK button
returns you to the PL/SQL or SQL Editor and inserts the SQL text you have built.
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To include tables or views in the select statement, drag them from the Object Browser into the work
area. Each time you add a new table, the Table Properties dialog appears:

(5] e

Here you can enter an alias for the table. For our example we wanted to use ‘e’ for the emp table:

DigtErnp

= 3 Tables
w BB BONUE
= DEFT

= 88 PRODUCT
w BB BalGRADE
@ £ views

Pat: |saL |

Whare Ordar By
I™ Distingt F Jinto.
| =

After adding the Dept table in the same way, you are asked if you want to join the 2 tables using the
columns of the foreign key named EMP_FOREIGN_KEY:

2 Foreign key joins for d

d.deptno = e deptno

After checking this option, you will see the new join condition in the bottom half of the form.
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Now the Dept table is added, and the join condition is visualized in the work area:

DigtErnp

= 3 Tables
w BB BONUE
= A DEPT
T EMP
= 8 PRODUCT
w BB BalGRADE
5 E Views

Pat: |saL |

™ Distinct

F Into

[ E DEFTHD

cdepLoo = e.deptag

What we need to do now is include the columns in the field list of the select statement. Just click on the
checkbox next to the column names. The columns will be displayed in the Fields panel:

DigtErnp

= 3 Tables
w BB BONUE
= A DEPT
T EMP
= 8 PRODUCT
w BB BalGRADE
5 E Views

Pat: |saL |

™ Distinct

I It

a.ampno
a.anams
tf deepiines
d.dname

i [ DEPTHO

cdepLoo = e.deptag

If you want to create a PL/SQL select .. into statement, you would also need to specify the items for the
Into list next to the fields. The selection list will display the PL/SQL variables that are defined in the
PL/SQL code where you insert the statement. In this case we do not want to create an Into list, so we
can leave these items empty.
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To create the order by clause, drag the empno column to the Order By panel:

= QuaryDuilder H[=1E3
Oy £ ok || gancsl
DegtEemp =l
= & Teoles empe |

w BB BONUS [ EMEND

= il DEFT [ E] DEFTHO

T EMP 5 (2 DNAME

= B PRODUCT rELWe

w BB BalGRADE
@ £ views : e

51 rowid

Pats |saL |

™ Distinct I It cdEpLOD = e.deptoo mpnn
a.8mpng
a.anams
d deping

B0 nome

kel

Now you can press the OK button to insert the SQL statement into the editor.

24.2 Modifying an existing select statement

To modify an existing select statement in your PL/SQL or SQL source code, simply right-click on the
select statement and select the Query Builder item from the popup menu. The complete select statement
will be marked in the editor, and the Query Builder will be displayed. Now you can change the query
definition as described in the previous chapter.

24.3 Manipulating the query definition

The following paragraphs describe how you can manipulate the query definition.

Changing the field list

To add a field from a table in the work area to the query, you can click on the checkbox next to the
column, or you can drag the column to the field list. You can alternatively double-click on the column if
the field list has the focus.

You can also drag a column or column folder directly from the Object Browser to the field list. Column
folders are located under the table, its constraints and its indexes.

You can type column names and other expressions directly in the field list.

To delete a field from the field list, right click on it and select Delete selected items from the popup
menu. If you select multiple fields, you can remove them all at once.

You can move fields to a different position by selecting them, and dragging them to their new position.
If you want a distinct result set, check the corresponding option above the field list.

Using field aliases

To use an alias for a field, simply type the alias after the expression, just like you would do if you were
typing the select statement by hand.
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Changing the where clause

The where clause is a normal text editor, where you can enter the conditions. To include a column, you
can drag it from the table in the work area, or you can double-click on the column if the where clause
has the focus.

To add a join condition based on a foreign key constraint definition, right-click on the table in the work
area and select the Foreign keys item from the popup menu. You cannot use this function to remove an
existing join condition, but need to remove the text in the editor instead.

Changing the order by clause

The order by clause can be manipulated in the same way as the field list, except that you cannot use the
checkboxes next to the column names. To change an item between ascending and descending order, you
can click on the button next to the item, which will display a corresponding arrow.

Using a synonym for a table or view

To use a table or view through a synonym, right-click on the work area and select the Add Table item
from the popup menu. Type the synonym name in the Name property, provide an alias if necessary, and
press the OK button.

24.4  Query Builder Preferences

By pressing the Preferences button on the toolbar, you can change the behavior of the Query Builder.
The following form will appear:

" Keyword case et el ™ Always prefix table with owner
& Lowercase & Left f
© Pight ™ Keywords on separate line
 Uppercase . . .
[ Single item pet line
 Init Caps rComma separatar | . . l—
1~ Before item Right margin_[40 ﬂ
emcase——————— | & Afteritem

& Lowercase
—AND' separator———————

& Before item ¥ Always show table property editor
© Init Caps  After ltem

Ok | Cancel

Most of these preferences affect the layout of the generated select statement:

 Uppercase

¥ Display S0L parts on a single page

. Keyword case

Determines how the SQL keywords (select, from, into, where, order by) are inserted into the
generated SQL statement.

. Item case

Determines how the items (table names, column names) are inserted into the generated SQL
statement.

. Keyword alignment
Determines whether the SQL keywords are right or left aligned.
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. Comma separator

Determines whether commas are placed before the next item, or after the current item. This is
primarily of interest if the Single item per line option is enabled.

. ‘AND’ separator

Determines whether the ‘AND’ operator is placed before the next condition, or after the current
condition in the where clause.

e Always prefix table with owner

When enabled, table names are prefixed with the owner (e.g. scott.emp instead of emp). When
disabled, tables are only prefixed with the owner if they are not owned by the current user.

. Keywords on separate line

When enabled, a SQL keyword is placed on a separate line and all items are placed on subsequent
lines with a 2 character indent. If this option is disabled, the items will immediately follow the
keyword on the same line.

. Single item per line

When enabled, each item will be placed on a new line. When disabled, items will be placed on a
single line, until the Right margin is reached.

. Right margin
Determines the maximum length of each line when the Single item per line preference is disabled.
e Always show table property editor

When this option is enabled, the table property editor will always be displayed after adding a new
table to the query definition. When this option is disabled, the property will only be displayed if
the newly added table is already used in the query, and therefore needs to have an alias.

. Display SQL parts on a single page

Determines if the 3 SQL parts (Field list, Where clause, Order By clause) are displayed on a single
page. If this option is disabled, each part is displayed on a separate tab page, next to the tab page
of the SQL text.

24.5 Query Builder Plug-Ins

If a Query Builder Plug-In is installed, then the standard Query Builder function will invoke the Plug-
In. Right-clicking on the Query Builder button allows you to select a query builder from a list of all
installed query builders. The most recently used query builder will be invoked by default when you
subsequently use the Query Builder function again.
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25. The PL/SQL Beautifier

If you develop, maintain, and support PL/SQL code in project teams with several developers, it is useful
that all project members use the same coding style. This will be beneficial for both quality and
productivity. To enforce this, PL/SQL Developer includes a PL/SQL Beautifier.

All you need to do is setup the PL/SQL Beautifier options, and optionally define the coding style
through the PL/SQL Beautifier rules (you can also simply adopt the default rules). After that, your
PL/SQL code will automatically be beautified as you work, or will be explicitly beautified by activating
the beautifier function.

25.1 Defining the options

To define the PL/SQL Beautifier options, select the corresponding item from the Edit menu. The
following preference dialog will appear:

2 Preferences ) il

I;ﬂ' Default ﬂ_l =
Connection
Options
Debugger Bules file
Output IC \Program Files\PLSOL Developeridefault br =
Trace
Prafiler

Edit

Lagon History

User I"‘Edﬂ_lce [~ Automatically Beautify
Qptions w

Toolbar v After Creating
Browser

Editor [~ After Loading
Fonts [ Betore Campiling

Code Agsistant [~ Before Saving
Key Confiquration LI
oK I Cancel | Apply |

The Rules file determines the rules that will be followed when beautifying your code. You can leave it
empty to adopt the default rules, which can be defined through a default.br file in the PL/SQL
Developer installation directory. See the next chapter for more information about these rules.

Furthermore you can define when your PL/SQL code will be automatically beautified:

e After Creating — Whenever a new program file is created through a template, or a DML
statement is dragged and dropped from the Object Browser into a Program Window.

e After Loading — After a program file is loaded from the file system. This does not affect code that
is opened from the Oracle database.

. Before Compiling — When you compile a program in the Program Window. This ensures that all
PL/SQL code in the Oracle database conforms to the rules.

. Before Saving — Before a program file is saved to the file system.
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25.2 Defining the rules

If you press the Edit button in the Options dialog, you can view or edit the rules of the selected file:

2 PL/SQL Beautifier Rules - C:\Program Files\PLSQL Developer\de _|o il
General | Control Structures | DL I Parameter Declaration | Record Type Declaratinnl
rltem List; ~Syntax Case
Indent |2 % e
Format Keywords IUnchanged A
Fight ] Z ®0 I
gt nensine Identifiers IUnchanged -
B Use i disiessn " Onane ling if possible
 Oneit | [¥ Use Special Case:
Tah character size |4 Z’ e
" Fit =l
|7 Align declarations
[v Align assignments ¥ align
Ernpty Line ¥ Comma sfter item
 Remove
@ Merge into one
" Preserse LI
Preview
fonction mgrname (p_empno in emp.empnoitype) return emp.enameitype is -
result emp.enamedtype; —
i integer;
begin
result := null; b
i =1
if p _empno is nmll then
—- If empne is nuoll, return an empty name
result := null;
olea |
Save Save as Open Default. Close Help

After making changes to these rules, you can press the Save or Save as button to save these changes.
You can also open another rules file for viewing or editing, and you can revert to the default rules by
pressing the corresponding button. If you save a file under a new name, or open a different file, you
need to select that rules file on the Options dialog to make these rules effective.

On the General tab page you can change the rules that apply to general aspects of your PL/SQL code.
All changes you make are immediately visible in the Preview pane at the bottom of the dialog, and most
options are self-explanatory. The following options need some explanations though:

. Indent — The number of spaces that will be indented for nested structures such as begin/end,
if/then/else, loops, and so on.

. Right margin — Whenever code needs to wrap to a following line, the right margin will be used as
a guideline. There may be situations where the right margin is exceeded though, for example when
long strings have been used.

. Use tab character — When enabled, the resulting code will contain hard tabs (character 9) to
indent the code. When disabled, spaces will be used.

. Tab character size — The number of characters that a hard tab represents. This is not only useful
when the Use tab character option is enabled, but can also be useful to correctly align comments
that contain hard tabs.

. Empty Lines — You can define that empty lines should be removed, and that the beautifier will
insert empty lines by its own rules, or that groups of subsequent empty lines should be merged
into one empty line, or that all empty lines are preserved.
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. Item Lists — These rules apply to all item lists that do not fall into the categories of the other tab
pages.

. Syntax Case — Determines how PL/SQL keywords and identifiers are capitalized. The Use
Special Case option allows you to define a number of words that will be included with the
capitalization as specified. If, for example, you include DBMS_Output.Put_Line in this list, this
will be the exact capitalization of that word in your PL/SQL code. You can also use the % or *
wildcards here, so that for example DBA_% will convert the first 3 characters to uppercase for any
word that starts with DBA_.

The other tab pages contain rules that apply to specific aspects of your PL/SQL code. These rules are
again self-explanatory, and are demonstrated in the preview pane.

25.3 Using the beautifier

If you have not selected any of the beautify events on the Options dialog, you can explicitly beautify
your code by selecting the PL/SQL Beautifier item of the Edit menu, by pressing the corresponding
button on the toolbar, or by using a function key that is assigned to it. By default all code in the current
PL/SQL editor will be beautified. If a critical syntax error is present in the code, it will not be
beautified, and you will receive an error message.

You can alternatively select a complete piece of PL/SQL code (e.g. a local function or procedure, or a
DML statement), and activate the beautifier.

25.4 Suppressing formatting

If you have a piece of PL/SQL code that you want to manually format, and therefore suppress
formatting by the PL/SQL Beautifier, you can use the NoFormat Start and NoFormat End directives.
For example:

TimeOut := 1000;

-- NoFormat Start

DBMS_Alert._WaitOne("SHUTDOWN™,
Message, Status,
TimeOut);

-- NoFormat End

if Status = 0 then
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26. Templates

Whenever you create a new program unit, its initial contents are based upon a template which contains
pre-defined text and variables. When selecting a template, you will be prompted for the values of these
variables, which are then replaced in the template text.

Templates can also be used to insert pieces of SQL or PL/SQL code into existing source. You could for
example create a template for a cursor-for-loop, and use it whenever you need to program such a control
structure.

Templates are plain text files located in the Template directory and have a .tpl extension. Templates for
all program unit types are pre-defined, as well as templates for common SQL and PL/SQL constructs.
You can modify and create templates for your own specific requirements.

26.1 The Template Window

The Template Window displays the hierarchical structure of the template directory. This makes it easy
to organize your templates. When you start PL/SQL Developer for the first time, the Template Window
will be docked under the Object Browser. This way it is always available and never obstructs the view
of other document windows:

7] Constants

o0 Default

71 DML statements
+-[1 Error handling
IZ—][:I Loops

3
[
[
£

Insert Into Editor
Create MNew Window

Irnplicit cursar
Integerforloor paw Ealder.

MNew Template...
v Package elemen —

[*
&6 PLsaL Types Bename...
-2 Program units -
w3 SOL Functions Delete
-0 Type elements Reftesh List
@0 Variables
Eloat
Close

There are a number of templates that are pre-defined, and they are organized in the following template
folders:

. Constants — Templates for PL/SQL constant declarations.

. Default — Templates with the default contents of a SQL Window, Test Window, Command
Window or Explain Plan Window. It also contains the template for a new view object. You
probably won’t use these templates directly, but you can maintain them here.

. DML Statements — Templates for DML statements that you can use in PL/SQL.

. Loops — Templates for various kinds of PL/SQL loops.

. Package elements — Templates for elements that can be used in package specifications or bodies.
. PLSQL Types — Templates for all types that can be declared in PL/SQL.
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. Program Units — This is a special folder that contains templates for new program units. Whenever
you create a new program unit, the template from this folder with the same name as the program
unit type will be used.

e SQL Functions — Templates with all SQL functions, like add_months, substr, and so on. These
templates can be useful if you don’t know the exact name or parameter meanings of a specific
function.

e  Type elements — Templates for elements that can be used in type specifications or bodies.
e  Variables — Templates for PL/SQL variable declarations.

By default the Template Window is docked under the Object Browser, but you can turn it into a floating
window by right clicking on it and selecting the Float item from the popup menu. To dock the window
again, follow the same procedure.

You can close the Template Window by selecting the Close item in the popup menu. To make the
Template Window visible again, select the Templates item in the Tools menu.

You can save this layout for the next time you start PL/SQL Developer by using the Save Layout item in
the Window menu, which will save the current situation. This function is described in more detail in
chapter 32.2.

26.2 Using a template

To insert a template into an existing source, you can simply double-click on it. If the template contains
variables that must be specified by the user, an entry form will appear before the text is inserted. If, for
example, you double-click on the Function implementation template, the following entry form will
appear:

Function Implementation

Furpose IREturn the name of the manager of the employee

MName Imgmame

Parameters Ip_empno in emp.empno*type

Return type Iemp.ename%type LI

QK | Cancel
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After filling the form and pressing the OK button, the template text will be inserted into the source, at
the current cursor position:

Program Editor - doc_employee.pck !EIE
@ employes & employes |

& » v Al x end lockrecord: d

O variables —— Author : JSCOTT
l:lTypes —- Created : 17-12-188% 16:11:28
@ deptname —— Purpose ! Return the name of the manager of the emploves
@ tetchrecord function myrname (b ewpno in emp.ewpnostype) return emp.enamestype is
@ inserrecord Fesult emp.ename:type;
@& updaterscord begin
@& deleterecord
@ lockrecord return (Result);

end myrname ;

end;
p—

= ﬁ

You can also drag-and-drop a template from the Template Window to a specific position in an editor.
This position will also determine the indentation of the template text. Similarly you can right-click at a
location in the editor, and select a template item from the Templates submenu from the popup menu.

- mgmame

26.3 Creating and modifying templates

To modify an existing template, right-click on it and select the Modify item from the popup menu. This
will bring up a text editor with the text of the template. This text contains the complete specification of
the template, including variables, queries, and so on. The format of the template text is described in the
following chapter.

To create a new template, right-click on the folder in which you want to create it, and select the New
Template item from the popup menu. You will first be prompted for the name of the template, after
which the template text editor will appear. You can also create a new folder by selecting the New Folder
item from the popup menu.

Template text

The template specification contains literal text and variables. The literal text will simply be copied into
the source file without any modification. Consider a template called Commit that only contains the
literal text commit;. When this template is double-clicked, the text commit; is inserted into the source at
the cursor position. Square brackets indicate a variable in a template (see below), so if you want to use a
square bracket as literal text, use 2 brackets instead, For example: [[option]]

User variables

Template variables are codes in the template text that will be replaced with a substitution text. This
substitution text can be an implicit value, like the current date or the username, or can be user-specified.
These user variables will appear in the entry form when the template is invoked. The following example
defines the variables Name and Type for a function template:

create or replace function [Name] return [Type] is
begin

return(result);
end [Name];



228

PL/SQL Developer 9.0 User’s Guide

When this template is invoked, the user can specify the values for the Name and Type variables. As you
can see, the Name variable is used twice. The user will be prompted for it only once though, and both
occurrences will be replaced with the same value.

The following functionality is available for user variables:

Default value.

A default value for a variable can simply be placed after the variable name. To define varchar2 as
the default function type, you can use the following declaration:

[Type = varchar2]

Restricted list.

To restrict the possible values for a variable, you can define it as a list of values. To limit the
function types to varchar2, number and date, you can use the following declaration:

[Type = varchar2, *number, date]

The value preceded with an asterisk will be used as default.

Suggestion list.

To provide a user with a list of suggested values, allowing other values for the variable as well,
use ... as the last value in the list:

[Type = varchar2, number, date, ...]

Descriptive list

Instead of using the same text for the list items and the substitution text, you can also use a
description for each item. Just follow the description with a colon and the value:

[Level = Write No Database State:WNPS, Read No Database State:RNDS, ...]

Check box.

For variables that are actually options, you can use a check box. Place a slash between the values
for an unchecked (left) and checked (right) check box. The following variable will insert the text

for each row when the check box is unchecked, and will insert for each statement when the check
box is checked:

[Statement level? = for each row / for each statement]

If you want to use special characters (like comma’s, brackets, and so on) in a substitution text, you can
place the text between double quotes.

The following is an example of a template for a trigger, using just user variables:

create or replace trigger [Name]
[Fires = before, after, instead of] [Event = insert, update, delete, ...]
on [Table or view]
[Statement level? = for each row/for each statement]
declare
-- local variables here
begin

ena [Name];

Note that you can create multiple program units in one template by separating them with a line with just
a slash (/) character. This way you can create a templates for a package specification and body in a
single program file.
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When this template is used, the user will be prompted for the variable values in the following way:

Trigger

Mame Iemp,brijngger

Fires Ibefore ﬂ

Ewent Ilnsen ;I

Tahle orwview Iemp

Statament level?

0] % Cancel

Implicit variables

Besides the user variables you can additionally use implicit variables. The substitution text for these
variables are not specified by the user, but are defined by the system (date, username), or the template
developer (queries, text).

System variables
The following 4 system variables are defined:

e  $OSUSER - The name of the Operating System user.
e  $DBUSER - The name of the database user that is currently logged on.
e  $DATE - The current date.

e  $TIME - The current time.

The first 2 lines of the following example template inserts the Windows user and the current date/time
into a source file:

-- Author : $OSUSER

-- Created : $DATE $TIME
-- Purpose : [Purpose]
procedure [Name] is
begin

ena [Name];
Note that system variables do not use square brackets in the template text, but are preceded by a $ sign.
If you want to use the original name of a system variable to appear in the resulting text instead of the

substitution value, you can escape this by placing a second $ sign before the name. For example:

-- $$Date$ $Revision$

The resulting text would be $Date$ $Revision$.
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Cursor position

The cursor position variable determines where the text cursor will be located in the editor after the
template text is inserted into an editor. Just place [#] at the desired location:

loop
[#]

end loop;

Query variables

You can use queries to populate selection lists in a template. The following example defines the query
seq_query, which is subsequently used as a suggestion list for the Sequence variable:

[$QUERY seq_query =
select lower(object_name) from user_objects
where object_type = "SEQUENCE"
order by object_name]
select [Sequence=$seq_query,...]-nextval into [Variable name] from dual;

The Sequence variable is a suggestion list, because the query is followed by “,...”, implying that other
values can be entered manually by the user. Query results can simply be viewed as comma separated
lists of values.

Included and excluded text

You can include or exclude text from a template, depending on the value of another variable. In the
following example, the word where is added if the Search condition is entered by the user:

select [Item list]
into [Variable list]
from [Table list]
[+Search condition=where] [Search condition];

As a result, the user doesn’t have to type ‘where’ in the search condition. To exclude a piece of text, use
the —Variable name syntax instead of the +Variable name syntax.

Text variables

You can define text variables in a template and refer to these variables in other parts of the template.
This is particularly useful if you want to conditionally include large pieces of text. The following
example includes an exception block if the user indicates so:

[$TEXT exception_block=
exception
when no_data_found then ...
when too_many_rows then ...
when others then ...
end;]
select [Item list]
from [Table list]
into [Variable list]
where [Search condition];
[Exception block =/$exception_block]
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Template icons

The tree view in the Template Window displays an icon for each template. The Template Window first
looks for a bitmap with the same filename as the template. For template Cursor.tpl, it will display a
Cursor.bmp from the same directory, if present. If this bitmap is not present, it will look for a
Cursor.bmp in directories below the current directory. If this bitmap is not found either, it will look for a
default.omp file in the current directory and the directories below.

The bitmaps for the template icons should have a size of 16x16 pixels with 16 colors.
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27. Window List

The Window List allows direct and easy navigation between multiple document windows. This feature
is especially useful if you like to work with maximized document windows, but if you have a lot of
windows open, such a list will always make navigation easier.

By default the Window List is docked under the Object Browser and File Browser, in the same docking
area as the Template List. It is only visible if one or more windows are open, and displays the title,
status and connection indicator of these windows:

| Window list of x|
Objects |Files Window Iist|

Sessions

SOLWindow - select™fram emp

LTI

Program WWindow - employee.pck
= Edittablz EMP |

If you click on one of these items the corresponding window will be activated. If you right click on an
item in the Window List, the following popup will be displayed:

Activate

Close Window

Minimize

Change Connection *
Rename...

Short Text

New 4

Execute

From this popup menu you can activate, close, and resize the window to a normal or minimized state.
You can also close a window by shift-clicking on an item in the list.

You can change the connection of a window by selecting it from the Connection submenu.

Furthermore you can rename a window. This can be useful if you just created a new window and want
to provide a meaningful name instead of, for example, SQL Window — New.

The Short Text item will switch to shorter descriptions. For example, the description “Program Window
- employee.pck™ will be shortened to “P - employee.pck™.

The New menu item allows you to create a new Program Window, SQL Window, Test Window,
Command Window, Explain Plan Window, Diagram Window, or a new database object.

To execute a certain window, you can select the Execute menu item.

To close the Window List, use the close button of the docking tool. To make the Window List visible
again select the Winodow List item in the Tools menu. You can save this layout for the next time you
start PL/SQL Developer by using the Save Layout item in the Window menu, which will save the
current situation. This function is described in more detail in chapter 32.2.
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28. Dockable and Floating Tools

The following tools can be docked or can be presented in a floating window:
e Object Browser

. File Browser

e  Connection List

e  Window List

e  Template List

. Bookmark List

e  Search Bar

e  Search Results

. To-Do Items

. Project Items

Tools can be docked at the left, right, upper, and lower side if the work area:

& PL{SOL Divelopres - scoll@cicagy =il
e Pued B Debug Tios Macrs Docimests Reperts \irdew Hel

L mm AS B Brerad ¥ v mBE

| Program Windaw - Emplyeespc =lnixf
|

FEFEFFECPRCRECERE

Tatiws
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« B CEPT
L

s Bsucaurs

i
- —— TR P

To dock a tool, simply drag it to the corresponding side of the work area. As soon as you come close to
the edge of the work area, a frame will be displayed, indicating the docking position.

If another tool is already docked at this location, you can drag the new tool above, below, to the left, to
the right, or within the other tool. If you drag one tool within the other, they will become available at the
same position on different tab pages (see the Window List and Template List on the lower left in the
screenshot above). Note that you can only dock a tool to the left or right of another tool if the docking
pane is not vertically split.
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To make a tool float, simply drag it from its docking position to a floating position.
At the upper right of each docking area you see the following 3 buttons from left to right:

E This button maximizes or restores the size of the docking area.

E This button pins or unpins the docking area. When pinned, the docking area will always be
visible, and tools can always be accessed directly. When unpinned, the docking area will slide off
screen to a vertical tab page when the mouse cursor is not over the area. When you hold the
mouse over a vertical tool tab, the docking area will appear again.

This button closes the current tool of the docking area.
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29. Authorization

After installing PL/SQL Developer all users can use all PL/SQL Developer functionality, within the
limits of the system privileges and object privileges that are granted to the Oracle user that is connected
to the database. For example, if the Oracle user does not have the create user system privilege, the
PL/SQL Developer user can start the New user function in PL/SQL Developer, but will eventually get
an “ORA-01031, insufficient privileges™ error message from Oracle.

You can explicitly authorize all relevant PL/SQL Developer functionality to specific Oracle users and
roles. In a development database you will allow all developers all functionality, whereas in a production
database you would typically disable all functions for most users that could alter the database or take up
too much resources and would affect performance.

By granting PL/SQL Developer privileges to roles you can customize authorization for specific groups
of people. You can make use of existing roles that implicitly map to a user group (such as DBA and
RESOURCE) or you can create roles specifically for PL/SQL Developer user groups.

29.1 Enabling authorization

The authorization information is stored in the plsqldev_authorization table in the sys schema. As long as
this table does not exist in a database, all users are authorized to use all PL/SQL Developer
functionality. If you are connected to a database where authorization is not yet enabled and select the
Authorization item from the File menu, you will get the following question:

[~ Don't show this message again

If you select Yes, an empty authorization table is created. Note that you must be connected as a DBA to
create this table. As soon as you create one or more privileges in this table the authorization is enabled,
and only privileged users can use PL/SQL Developer in this database.

By default only the owner of the table (sys) or another DBA can alter the table or update its contents.
All users have select privileges on the table.
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29.2 Defining authorization

To define the authorization you must be connected as a DBA and start the Authorization function from
the File menu. The following dialog will appear:

% Authorization — o] x|
Grantees
|DEA o
RESOURCE 2
Frivileges
Menus All e

Ohjects.Describe All
Objects.Properies All
Ohjects.QuenyData All
Ohjects. View All

Ohjects ViewSpecAndBody All
Systemn.Logon

OK | Cancel Drop table |

At the top you will see all users and roles for which one or more PL/SQL Developer privileges have
been granted. At the bottom you see the actual privileges for the currently selected grantee.

To add a grantee, press the New grantee button to the right of the grantee list. This will bring up a list of
all potential grantees (users and roles). You can select one or more (Ctrl-click or Shift-click) grantees
and press OK to add them. At this point, these new grantees do not have any privileges yet.

To remove a grantee and its privileges, press the Remove grantee button. This will not affect the actual
user or role in the database, but will merely remove its privileges from the authorization table.

To grant privileges, select the grantee from the list and press the Grant privileges button to the right of
the privileges list. A list of all PL/SQL Developer privileges is displayed, where you can select one or
more privileges. There are 3 categories of privileges:

e  System privileges — PL/SQL Developer system functions (e.g. Logon).
e  Object privileges — Database object type specific privileges (e.g. Drop Table).
. Menu privileges — Privileges to use PL/SQL Developer menu functions (e.g. Tools > Sessions).

Note: If a user does not have the System.Logon or All privilege, he or she cannot use PL/SQL Developer
on the current database instance.

You can select individual privileges or select from a hierarchical set of privileges. For example:
e  All-Grantall PL/SQL Developer privileges.
. Objects.All — Grant all PL/SQL Developer privileges related to database objects.

. Objects.Rename All — Grant all PL/SQL Developer privileges related to renaming database
objects (rename table, view, sequence and synonym).
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. Objects.Rename Table — Grant the PL/SQL Developer privilege to rename a table.

Note that for database objects, the Oracle user or role must still have the necessary system privilege to
perform the operation. Granting Objects.Drop User still requires the drop user system privilege.

Also note that if a user has the Drop User system privilege, he can still execute the drop user command
froma SQL or PL/SQL script.

29.3 Disabling authorization

To permanently disable authorization, you can drop the sys.plsqldev_authorization table or delete all
records. To temporarily disable authorization, you can either revoke the privileges on the table or
rename it (making it invisible to the PL/SQL Developer users). To enable it again later, you can grant
select privileges again.
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30. Oracle File System (OFS)

The OFS allows you to store all your files (sources, scripts, reports, and so on) in the Oracle database.
This has the benefit that both the database objects as the files that operate on these objects can be stored
in the same database, and can be accessed by all users that have access to this database. Furthermore, it
is guaranteed that the database objects and files are consistent, and are backed up and recovered in a
consistent way.

Files can be saved and opened in the usual way, with a standard file open/save dialog with some
extensions.

30.1 OFS Manager

Before anybody can use the OFS from within PL/SQL Developer, you have to use the OFS Manager to
define an OFS Location Directory with one or more OFS Locations. For each location you need to
install the OFS database objects.

Creating an OFS Location Directory

To start the OFS Manager, go to PL/SQL Developer’s Preferences and select the Directories page. At
the bottom of this page you can find the OFS Manager button. After starting it you get the following
screen:

W, OFS Manager - [] E =Io| x|
U2 W[+ =[TX
Marme | Databaze I Schema | User hame: | Pazsword I
Namel User namel
Dalabasel Passwnrdl
Schema

This isan empty OFS Location Directory, for which you can add locations, and which you can save in
an OFS Location Directory file (.1df). This file is used from within PL/SQL Developer to browse the
directory and to connect to locations and browse the files.
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Adding OFS Locations

To add an OFS Location, press the Add location (+) button. Now you can enter the following
information:

=T
U2 W+ =]7X
Marme | Databaze I Schema | User hame: | Pazsword I
Chicaga chicago OFs OFS_USER
NamelCh\cago— User namelDFS_T
e e O o
SchemalElFS—

. Name — Will be displayed in the location list in the file selector.
. Database — The database where the OFS files will be stored.

. Schema — The schema that holds the OFS database objects (tables, packages, and so on). This user
requires the resource role privilege and the query rewrite system privilege to create its objects.

. User name — The name of the Oracle user that will be used to access the OFS. If you do not
specify an OFS user name, then the user that accesses the OFS will need to specify a user name
and password, or the OFS will be accessed as the current PL/SQL Developer Oracle user.

. Password — The password of the Oracle user that will be used to access the OFS. Only useful if the
User name field is entered.

After creating one or more locations, you can save the OFS Location Directory by pressing the Save
button. If you save the file in the PL/SQL Developer directory under the name OFS.Idf, then PL/SQL
Developer will automatically pick-up this directory. Otherwise the PL/SQL Developer user will need to
point to the correct OFS Location Directory file in the preferences.

Installing the OFS database objects

After adding a location to the directory, you need to install its database objects. If the OFS schema and
(optional) OFS user do not yet exist in the database, you will first need to create them:

create user OFS identified by <password>;

grant connect, resource, query rewrite to OFS;

create user OFS_USER identified by <password>;

grant connect to OFS_USER;

Next you can install the OFS database objects by pressing the Install database objects button. After
supplying the password of the schema user, the database objects will be created, and the location is
ready for use.
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30.2 OFS Usage

After creating an OFS Location Directory, installing the locations, and making the directory file
available to PL/SQL Developer, you can use the OFS Save As item from the File menu to save a file
into the OFS. The following dialog will appear:

or -

Chicago
Dallas

File name | ;I Save I
Filez of type ISQL seript [* zql] ;I Cancel

I FKeeplocked after save

You first need to open a location, after which you can save the file or create a directory:

Look_lnl Programs ;I Q2 ™ -

@ Departrent. bdy
@ Departrent. zpc
[gﬂ Emplapee. zpc

File name |Emp\0yee.bdﬂ ;I Save I
Files of type IAII pragram units (% frc;® prc;".trg;".pck;“.t_l,lp;".spc;".bdy,".tps;*.t;I Cancel

[~ Keeplocked after save

To open a file from the OFS, you can use the OFS Open item from the File menu, or use the Reopen
menu. OFS files have the path name OFS:\Location\Path (e.g. OFS:\Chicago\Programs\Employee.bdy).
A previously opened OFS file can be saved by using the standard Save function. You can use the Save
As function to save an OFS file to the standard file system. The OFS Save As function can be used to
save it in the OFS under a different name or in a different directory.

When saving or opening a file, you can select the Keep locked option to lock it. Other users cannot lock
or overwrite a file that is locked by you.
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Right-clicking on a file in the file selector gives you the option to Cut, Copy, Paste, Delete or Rename
the file. You can also view and change object properties from this popup menu. Properties you can
change include the Read-only status, the Locked status, and the Compressed status. Files can only be
compressed on Oracle10g and later, since it uses the utl_compress package which is only available
since 10g.
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31. Help systems

You can configure PL/SQL Developer to integrate with the help files and manuals that are provided
with the Oracle Server software. This chapter describes how to setup and use these help systems.

31.1 MS Help files

Up to Oracle 7.2 the online manuals were provided in MS Help format. These help files can be used to
provide context sensitive help in the editor, either by right clicking on a word, by selecting the SQL help
or PL/SQL help items in the Help menu, or by pressing a function key that you have associated with
these two menu items.

PL/SQL Developer searches the help files in the following two directories:

1. Inthe directory where PL/SQL Developer is located.

2. Inthe directory where SQL*Plus is located.

The SQL help file name is assumed to be sqlhelp.hlp, the PL/SQL help file is plshelp.hlp. If these help
files are not available, but you have some other help files you wish to use for SQL or PL/SQL help, you
can place these files in the PL/SQL Developer directory and rename them as mentioned above.

31.2 HTML Manuals

Since Oracle 7.3 the online manuals have been provided in Acrobat Reader and HTML format. You can
configure PL/SQL Developer to make use of the HTML manuals, either by right clicking on a word in
an editor, by selecting the HTML Manuals item in the Help menu, or by pressing F1. Furthermore you
can press the Help button on an error message in case of an Oracle exception, which will automatically
take you to the appropriate paragraph in the Oracle Error Messages manual. Double-clicking on a
compilation error in a Program Window will also display this information.

Note: the online documentation of some Oracle Server versions contains HTML files that are over LMB
in size. Loading these files can take a very long time, in which case you are advised to use the online
documentation of an Oracle Server version where the chapters are divided into smaller files. Oracle has
reduced file sizes again for the 8.1.5 documentation.

Configuring the HTML Manuals

The first time you invoke the HTML manuals in one of the ways described above, you need to indicate
to PL/SQL Developer where your HTML files are located:

HTHL Dacument directon:

IS:\Orac\eDoc\HJ = Download...
Build! I Cancel | Helgp |

“'ou need to indicate to PL/SOL Dewveloper where the Oracle HTML documentation is located. Just point to the root directory and
press the Build button to create indexes for the keywords in these manuals, which will be stored in the Books subdirectary of the
PL/SOL Developer directary.

This process mey take a few minutes.

f wou dio not hewe the Oracle HTML docurnentation available, press the Download button to download a zip file with the
documentation from OTN (Oracle Technology Network - registration required)

[Searching far A4
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Just point to the root directory and press the Build button to create indexes for the keywords in these
manuals, which will be stored in the Books subdirectory of the PL/SQL Developer directory. This
process may take a few minutes.

If you do not have the Oracle HTML documentation available, you can press the Download button. This
will take you to a local html page where you can select the appropriate Oracle Server version and
download a zip file with the HTML documentation. This download requires an Oracle Technology
Network account. If you do not have an OTN account, you can first create one for free.

After this index build is finished, you will be presented with a list of manuals that have been found. You
can now select the books you want to use for context sensitive help. By default this selection will
include the Error Messages, SQL Reference and PL/SQL Reference manuals, which all contain relevant
information during PL/SQL development. The Error Messages manual is required if you want to
automatically have the cause and action available in case of an Oracle exception or compilation error.
The current Oracle7 manual is not properly indexed to allow this feature, the Oracle8 version works
without a problem though.

@ Books |

|| Oracle Database Perdormance Tuning Guide :I

["] Oradle Database Flatform Guide Setup...

[¥] Oracle Database PLSOL Language Reference

[¥] Oracle Datahase PLSOL Packages and Types Reference SelectAll |
[| Oracle Database Programmer's Guide to the Oracle Precompilers

['] Oracle Datahase Feal Application Testing Addendum Select Mone |
[] Oracle Database Feal Application Tasting User's Guide

; Oracle Database Reference Apply |
| Cracle Database Rules Manager and Exprassion Filter Developer's Guide

[ ] Oracle Database Sample Schemas

] Oracle Database SecureFiles and Large Ohjects Developer's Guide Help |
; Oracle Database Security Guide J

[ | Cracle Database Semantic Technologies Developer's Guide

[[] Oracle Datahase S0L Developer User's Guide

[] Oracle Database S0OL Language Quick Reference

[¥] Oracle Database S0L Language Reference

[] Oracle Database SOLJ Developer's Guide and Reference

[[] Oracle Datahase Storage Administrator's Guide

|Searching for ™*... A

Press the Apply button to make the selection effective. After this you are taken to the search page, which
is discussed in the following chapter. By pressing the Setup button you can scan a different directory for
HTML manuals.
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Using the HTML manuals

After invoking the HTML manuals you can type the keyword you want to search for on the Search
page. The two lists display the keywords that match this search and the topics in the manuals in which

this keyword appears:

# HTML Manuals

& Books (@) Search |

Search far I\Dck LI

a _ ol x|
Clear results

LOCK TABLE Dept_tab IN SHARE MODE

LOCK TABLE Emp_tab IN EXCLUSIVE MODE

LOCK TABLE Emp_tab IN ROW EXCLUSNE MODE

LOCK TABLE Emp_tab IN ROW SHARE MODE

LOCK TABLE Emp_tab IN SHARE MODE

LOCK TABLE Emp_tab IN SHARE ROWY EXCLUSNE MODE
LOCK TABLE Emp_tab. Dept_tab

LOCK TABLE Statement

LOCK_MAP Procedure

LOCK_MNAME_SPACE

Search options

® Starting with
" Containing

[~ Case sensitive

ALTER_CHAMNGE_SET Procedure, Usage Naotes
CREATE_CHANGE_SET Procedure, Usage MNotes

Locking Data Explicitly

In the Search options pane to the right of the keyword list you can refine the search criterion. Next you
can double click on an item in the topic list at the bottom of the search page to display the
corresponding paragraph in the HTML manual:

2 HTML Manuals A _|o|x]
@ EDDI-(SI @ Search ':ﬂl Lock |
e 2 @ 0 x
LOCK TABLE =l
[
Purpose

only one lock for a table.

entirely or to a savepoint before you locked the table.

Use the LocK TABLE statement to lock one or more tables, table partitions, or table
subpartitions in a specified mode. This lock manually overrides automatic locking and
permits or denies access to a table or view by other users for the duration of your operation.

Some forms of locks can be placed on the same table at the same time. Other locks allow

A locked table remains locked until you either commit your transaction or roll it back, either

A 1nnls snsrne censrnote athae nnes fenn sosaeian dha tnlda A nssnecr aasrae alonne o laals Ao o LI

The search result page displays an HTML page in which you can navigate through hyperlinks as usual.
The buttons at the top of the page can be used to navigate to the previous or next location that you
visited before, to cancel the page buildup, or to go to the original page after navigating.
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You can go back to the Search page to search for different keywords or go to the Books page to select
different books. Each search creates a new result tab page, so that you can keep different search results
available. To close a result page, press the close button at the upper right of the tab page. To close all
pages, press the Clear results button on the search page.

By default the HTML window will stay on top of other windows in the PL/SQL Developer IDE, so that
the information stays visible. To temporarily hide the window, you can use the green rollup button at
the upper right of the window.
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32. Customization

Some aspects of PL/SQL Developer can be customized to meet your personal needs. These aspects are
described in the following paragraphs.

32.1 Preferences

In the Tools menu, there is a Preferences item that allows you to set various preferences for PL/SQL
Developer. These preferences are described in detail in chapter 20.

32.2 Window layout

There are various window layout settings that can be tailored to your needs. Selecting the Save Layout
item in the Window menu saves these settings. The Layout Settings include:

Size and position of the application window.

Presence and size of the Object Browser.

Presence and size of the Code Contents in the Program Window.

Presence, status (floating or docked) and position of the Window List and Template Window.
Size of the Program Window, Test Window, SQL Window, Explain Plan Window, Command
Window, Report Window, Compile Invalid Objects Window, Find Database Objects Window,
Export User Objects Window, and Compare User Objects Window.

When you save the layout, the size of the last opened window is saved. If a window of a certain type is
not present, the size setting of that window type is left unchanged.

32.3 On-line documentation

Most of Oracle's documentation is provided as on-line documents. Through time, these documents have
had several formats. So far there have been MS Help files, Oracle Book files, Adobe PDF files and
HTML files. In the future, Oracle may choose to use yet another format.

Moreover, you may have some corporate standards and project documents in a word-processor format
that you need to access from time to time.

All of these on-line documents can be integrated into PL/SQL Developer's IDE by including them in the
Documents menu. This way they are available to you by a simple mouse click.
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To configure on-line documents, select the Configure Documents item in the Tools menu. The
following dialog allows you to define a description of each document, and how to view it:

* configure Documents

ELPL/SLL Heference Manual
Server BApplication Developer's Guide

Server tMessages
Server Concepts

x|
E50L Reference Manual |
&
4@
4

v Diocuments a3 main meru ikem

 Definition

Deszcription I&F'L.-"SQL Fieference Manual

Executable |P:\09D0CNAR556_01.pdf &

Parameters I gl
¥ Toolbar button

Description IDpEn the PLASGL Reference Manual

Image El PDFFile.bmp
Ok I Lancel | Help

At the right side you see four buttons, to create a new document, to delete a document, and to move a

document up or down in the menu. When you create or modify a document you must supply the
following information:

The Description shows up in the menu. To create a shortcut key for the menu item of a document, prefix
the letter in the description with an ampersand. If you want an ampersand in the description, use two
ampersands instead. If you enter justa '-' into the description, it will become a separator in the menu.
This way you can divide the documents into logical groups.

The Executable should be the full path to the program that you want to use to view the document. If the
document is a registered file type (like an MS Help file or HTML file), you can enter the path to the
document here.

The Parameters can be used to pass information to the executable if it is a program. It should at least
include the path to the document, but can also be used to pass options to the program.

When the Documents as main menu item option is checked, the Documents menu is located in the main
menu. Ifitis not checked, it will be located under the Tools menu.

In the above example the PL/SQL Reference Manuel is a PDF file (P:\O9DOC\A89856_01.pdf), which
is a registered file type, so that can just enter the file name in the Executable field. The letter 'P" is used
as a shortcut in the menu. The Documents menu would look like this:

S0L Reference hManual
ELSCL Reference hManual

Server Application Developer's Guide

Server Messages

Server Concepts

When the Toolbar button option is enabled, the document can additionally be included on the toolbar.
The corresponding Description will be displayed as a hint when you hold the mouse cursor over the
toolbar button. If you leave this description empty, the main description of the document (as displayed
in the menu) will be used. Press the Image button to select a Windows bitmap file (*.bmp) for the
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toolbar button. The size of this image should preferably be 20 x 20 pixels. Note that PL/SQL Developer
will always load the bitmap file from the original location, so you should not remove or rename this file
without also changing the corresponding document. PL/SQL Developer comes with a number of
standard bitmap files that you can choose from. These files are located in the Icons subdirectory in the
PL/SQL Developer installation directory. This is the default directory of the image selector.

32.4 Command-line parameters

The following parameters can be used on the PL/SQL Developer command-line. The default shortcut
does not include any parameters, but merely starts plsqldev.exe from the PL/SQL Developer installation
directory.

A default set of parameters can be defined through the params.ini file in the PL/SQL Developer
installation directory. You can edit the file in a text editor like notepad. The file contains an explanation
for each parameter. If a parameter is defined in params.ini and on the command-line, then the
command-line takes precedence.

userid

Every time you start PL/SQL Developer, it will prompt you for at least the password. To avoid this, you
can supply a userid parameter with the familiar username/password@database format:

plsgldev.exe userid=scott/tiger@chicago

Note that you can also use the following registry key to supply a default logon:
HKEY_CURRENT_USER\Software\Allround Automations\PL/SQL Developer\Logon

Here you can add a Username, Password and Database.

The last method has the advantage that it enables you to be automatically logged on after double

clicking a PL/SQL Developer registered file.

nologon

The nologon parameter suppresses the logon dialog that is displayed when PL/SQL Developer is

started. This parameter does not require any arguments:

plsgldev.exe nologon

oraclehome

You can specify the name of the Oracle Home on the command line, thereby overriding the Primary
Oracle Home (which is used by default) and the Oracle Home preference:

plsgldev.exe oraclehome=ora817
Note that this is the name of the Oracle Home, as specified in the ORACLE_HOME_NAME key in the
registry. This name is also used by the Oracle Home Selector. It is not a registry section name or a

directory name.

dontadjustpath
PL/SQL Developer will not temporarily modify the PATH for Oracle Net initialization:

plsgldev.exe dontadjustpath
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nosplash

The nosplash parameter suppresses the splash screen that is displayed when PL/SQL Developer is
started. This parameter does not require any arguments:

plsgldev.exe nosplash

noplugins
Specifying the noplugins parameter will prevent that any Plug-Ins are loaded:

plsgldev.exe noplugins

library
Specify the location of the style library for reports:

plsgldev.exe library=p:\standard.lib

prefpath
Specify the path for the personal preference sets. For example:

plsgldev.exe prefpath=u:\userdata
See chapter 20.34 for details.

defaultprefpath
Specify the path for the default preference sets. For example:

plsgldev.exe defaultprefpath=p:\common\plspref

commandfile
Run the specified command file in the Command Window. For example:

plsgldev.exe userid=scott/tiger commandfile="u:\sql scripts\demo_build.sql”
This command will first connect to the database and subsequently run demo_build.sqgl.

viewobject
View the specified database object. It requires that you also specify the userid parameter. For example:

plsgldev.exe userid=scott/tiger@chicago viewobject=emp

This command will first connect to the database, and subsequently show the table definition of table
EMP. Note that the object specification can also include the owner (e.g. SCOTT.EMP).

editobject
Edit the specified database object. It requires that you also specify the userid parameter. For example:

plsgldev.exe userid=scott/tiger@chicago editobject=emp

This command will first connect to the database, and subsequently show the table definition of table
EMP. Note that the object specification can also include the owner (e.g. SCOTT.EMP).
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registry
To use different sets of IDE settings you can use the registry parameter. For example:

plsgldev.exe registry=home

This command will cause all IDE settings (window sizes & positions, file history, logon history, and so
on) to be loaded from and stored under a home name.

sessionmode

Allows you to define the session mode: single session, dual session, or multi session. Valid values are
SINGLE, DUAL, MULTI or 1, 2, 3. For example:

plsgldev.exe sessionmode=dual

noscwarning
When this parameter is provided, you will not receive a warning when your service contract is about to
expire:

plsgldev.exe noscwarning

hexedit
This parameter will invoke the hex editor of the large data editor for the file specified. For example:

plsgldev.exe hexedit=c:\temp\blob.dat

project
Opens the specified project. For example:

plsgldev.exe project=u:\userdata\projects\deptemp.prj

noconnectionlist
Suppresses the connection list at startup and displays the old style logon dialog instead. For example:

plsgldev.exe noconnectionlist

32.5 SQL, PL/SQL and Command keywords

The keywords that are highlighted in SQL, PL/SQL and Command editors can be defined in a keyword
file. The file is named default.kwf and is located in the directory where PL/SQL Developer is installed.
It contains a [PLSQL] section for PL/SQL keywords, a [SQL] section for SQL keywords and a
[COMMAND] section for Command file keywords. You can simply change, add or remove keywords
in the appropriate sections with a text editor like notepad.

32.6 Plug-Ins

You can program your own Plug-Ins to extend the functionality of PL/SQL Developer. Functions in a
Plug-In can be added to the PL/SQL Developer menu, and can perform any kind of action: access the
database, the Object Browser, the current window and editor and so on.

A Plug-Inisa DLL that exposes a specific interface to PL/SQL Developer. To create a Plug-In, you can
use any programming language that can create DLL’s. When a Plug-In DLL is placed in PL/SQL
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Developer’s Plug-In directory, it will automatically be picked up. This makes it very easy to distribute
your Plug-Ins.

You can build Plug-Ins for your own or public use. Some standard Plug-Ins are available on the
Allround Automations web site (http://www.allroundautomations.com/plsqldev.html). Third party Plug-
Ins are available here as well.

Plug-In documentation and examples are available in the PluginDoc subdirectory in the PL/SQL
Developer root directory.
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